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Загальні вказівки 
 

Практикум з дисципліни "Комп’ютерні технології в матеріалознавстві" 
складається з п’ятнадцяти занять. Основна увага приділяється програмному 
забезпеченню з комп’ютерного обробітку фотографій, підготовці цифрових варіантів 
зображень мікроструктури, створенню текстових та графічних документів, 
написанню програм моделювання процесів матеріалознавства. При підготовці до 
виконання кожного заняття студент повинен: 

- вивчити відповідний теоретичний матеріал, поданий в лекційному курсі, а 
також самостійно ознайомитися з літературою, вказаною у робочій програмі з 
дисципліни; 

- ознайомитися з описом практичного заняття; 
- скласти таблиці для запису результатів; 
- засвоїти правила техніки безпеки при роботі з приладами і обладнанням 

комп’ютерного класу. 
З кожного практичного заняття  студент складає індивідуальний звіт, який 

повинен містити опис послідовності дій на комп’ютері, що призводять до одержання 
необхідного результату, принципові схеми і результати досліджень у вигляді таблиць, 
графіків. Звіт оформляється на стандартних листах паперу формату А4 або в 
окремому зошиті. В кінці звіту приводяться висновки, сформульовані студентом 
самостійно. Звіти з усіх занять повинні бути підшиті під однією обкладинкою і 
пред'явлені викладачу. При виконанні певних завдань на комп’ютері, одержані дані 
повинні бути записані у визначені викладачем місця в необхідному форматі. Студент 
повинен мати достатні знання з відповідних розділів дисципліни, вміти 
використовувати методи комп’ютерного дослідження і розрахунку. В протилежному 
випадку робота вважається не зарахованою. До повторного заліку студент 
допускається не раніше, як через 7-10 днів. Якщо і при цьому студент виявив 
незадовільні знання, то він повинен індивідуально знову виконати весь об'єм 
лабораторних занять. 

Перед початком занять кожен студент повинен пройти спеціальний інструктаж з 
техніки безпеки у викладача чи лаборанта, про що необхідно зробити відмітку в 
журналі з техніки безпеки. 
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Практичне заняття № 1 

 

Тема: Створення текстового документу з таблицею; форматування, запис документу 
Мета роботи: навчитись створювати звітну документацію в програмі Microsoft Word 
2000. Набути практичних навиків форматування текстової інформації, зміни 
параметрів сторінки, створення таблиць, їх редагування. Навчитись записувати 
документи, створювати їх копії. 
 

1.  Основні положення і  зміст роботи 
Програма Microsoft Word призначена для створення текстових документів, що 

можуть містити таблиці, рисунки (векторні та точкові), графіки, діаграми, формули; 
крім того програма дозволяє вставляти об’єкти, виконані за допомогою 
встановленого на комп’ютері програмного забезпечення, та редагувати їх в разі 
потреби. 

Запуск програми: 
Меню Пуск – Програми – Microsoft Word. 

 

1.1.  Вікно програми (Рис. 1.1). 

Рис. 1.1. Вікно програми Word 2000 
Вікно програми Word 2000 має типовий вигляд для Windows програм. 
У верхній частині програми розташована стрічка імені вікна 1 з кнопками 

керування виглядом: 2 – згорнути (згортає тимчасово непотрібне вікно до панелі 

4 5 1 6 7 8 9 2 3 

10 14 12 13 15 11 



 6 
задач); 3 – розгорнути / відновити (відображає вікно в повноекранному або віконному 
режимах); 4 – закрити (закриває документ; якщо документ не був збережений – 
з’явиться вікно з відповідним запитом). Стрічка імені також містить ім’я файлу, 
відкритого в робочій області 13. 

Під стрічкою імені розташована стрічка меню 5, в закладках якої можна знайти 
всі команди, що можна застосовувати до текстових чи графічних об’єктів даного 
документу. Команди з вкладок меню згруповані в панелі інструментів, ті з них, що 
найчастіше використовуються відкриті у вікні програми (стандартна 6, форматування 
7, таблиці та межі 8, малювання 14). Якщо необхідно добавити інші панелі 
інструментів, необхідно навести стрілку “миші” на будь-яку панель інструментів, 
натиснути праву кнопку “миші” (п.к.м.) і проставити галочку навпроти потрібної 
панелі інструментів. 

Над робочим полем програми 13 і зліва від нього розташовані лінійки 9 і 10, які 
дають уяву про дійсні розміри об’єктів. Справа і знизу розташовані смужки 
прокручування 11 і 12, які дозволяють переглянути фрагменти аркуша у випадку, 
якщо застосований масштаб не дозволяє переглянути всю сторінку. 

В нижній частині програми розташована стрічка стану програми 15, яка дає 
інформацію про розташування курсору, мову тексту, стан документу. 

 
1.2. Стрічки меню 
1.2.1. Меню “Файл”  

Команди: 
“Створити” або “Новий” (Ctrl+N. Створює новий текстовий документ. 
“Відкрити” (Ctrl+O). Дає можливість відкрити попередньо збережений файл. 
Необхідно за допомогою адресної стрічки вказати розташування файла.  
“Закрити” (Alt+F4).  Закриває відкритий документ  
“Зберегти” (Ctrl+S). Зберігає документ, який має ім’я. Якщо файл зберігається вперше 
– з’явиться вікно збереження файла. 
“Зберегти як” (F12). Дозволяє зберегти відкритий документ під новим іменем. 
“Параметри сторінки” (двічі клацнути л.к.м. по вертикальній лінійці). Дозволяє 
виставити поля документу та розмір і орієнтування паперу. 
“Друк” (Ctrl+Р). Виводить вікно “Друк”, в якому можна вибрати локальний або 
мережевий принтер, його налаштувати та вказати кількість копій, їх якість для 
одержання тексту файла на папері. 

В нижній частині меню “Файл” знаходяться шляхи до останніх (від 4 до 9) 
збережених документів. 

1.2.2. Меню “Правка”  
Команди: 
“Відмінити” (Ctrl+Z). Відміняє останню дію (можна відмінити послідовний ряд дій 
до моменту збереження). 
“Вирізати” (Ctrl+Х). Вирізає виділений фрагмент до буферу обміну. 
“Копіювати” (Ctrl+С). Копіює виділений фрагмент до буферу обміну. 
“Вставити” (Ctrl+V). Вставляє інформацію, що знаходиться в буфері обміну. 
“Знайти” (Ctrl+F). Дозволяє знайти слово або словосполучення в тексті. 
“Замінити” (Ctrl+H). Замінює один фрагмент тексту іншим. 
“Перейти” (Ctrl+G). Перехід в тексті документа по закладках, сторінках. 
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1.2.3. Меню “Вигляд”  
Команди: 
1. Звичайний 
2. Електронний документ 
3. Розмітка сторінки – найпоширеніший вигляд сторінки документа, оскільки ми 

своїми очима бачимо межі сторінки, її початок і кінець.  
4. Структура 
Панелі інструментів – дозволяє додати або прибрати панелі інструментів.  
*Найчастіше використовуються: Стандартна, Форматування, Малювання і Таблиці та 
межі. 
*Щоб додати нову панель інструментів необхідно: ввійти в меню “Вигляд”Панель 
інструментіввибирати панель інструментів, з якою ми хочемо працювати. 
*Щоб додати нову кнопку на панель інструментів необхідно: ввійти в меню 
“Вигляд”Панель інструментівНастройка: у вікні, що з'явилося, переходимо на 
вкладку «Команди» і із списку команд лівою кнопкою миші вибираємо і перетягуємо 
потрібну команду на панель інструментів. 
 
Лінійка: встановлюємо або прибираємо лінійку у вікні нашого документа (рис.1.2.). 
 

 
Де 1 – Відступ першого рядка (відступ абзацу); 

2 – Поля не друку тексту; 
3 – Виступ (зворотний абзац); 
4 – Відступ зліва; 
5 – Поле друку тексту; 
6 – Відступ справа. 

“Колонтитули” створює титульний рядок в який можна розмістити номер сторінки, 
ім'я автора, назву документа, час і дату. 
“На весь екран” показує сторінку документа без панелей інструментів і меню Пуск. 
Ще цей вигляд називають режимом фахівця. 
“Масштаб” призначений для вибору у відсотках масштабу відображення однієї або 
декількох сторінок документа. 
 

1.2.4. Меню “Вставка”  
1. “Розрив “- встановлює програмний розрив між сторінками документа. 
*Дія: Встановити курсор тексту на початку фрагмента (або в новому рядку), після 
якого текст повинен починатися з нової сторінкиМеню ВставкаРозривОК. 
2. “Номери сторінок” - проводить автоматичну нумерацію сторінок. 
*Після вибору цієї команди з'являється вікно, в якому ми вибираємо положення 
номера на сторінці, і встановити прапорець – номер на першій сторінці. 
3. “Дата і Час” - дозволяє вставити в текст документа після курсору поточну дату і 

час. 
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*Якщо встановити прапорець обновляти автоматично, то при наступному відкритті 
цього документа, час і дата зміняться і будуть завжди поточними. 
4. “Автотекст“ - вставляє в текст слово і словосполучення заданої теми. 
*Щоб створити автозамінюваний текст, необхідно: Меню “Вставка”  Автотекст  
Автотекст  Вкладка Автозаміна  Ввести абревіатуру  Ввести повне значення  
Додати  ОК 
5. “Символ” - дозволяє вставити в текст документа символи і значки, які неможливо 

ввести з клавіатури. 
6. “Примітка” – додає до виділеного фрагмента тексту пояснення, тлумачення, яке 

існує тільки в електронному вигляді. 
*Дія. Виділити фрагмент  Меню Вставка  Примітка  В нижній області, що 
з'явилася,  ввести текст примітки  Натиснути кнопку  “Закрити”. 
*Щоб змінити або видалити примітку необхідно на тексті з приміткою натиснути 
п.к.м. і вибрати потрібну команду: Змінити або Видалити примітку. 
7. “Виноска” 

1. Виділити фрагмента тексту, до якого ми хочемо створити виноску. 
2. Меню Вставка Виноска ОК. 
3. Ввести текст виноски. 

8. “Рисунок” – дозволяє вставити в документ рисунок з “картинок”, з файлу, зі 
сканера, вставити діаграму. 

9. “Закладка” – дозволяє вставити закладку в текст для полегшення знаходження 
певного фрагменту тексту. 

 

1.2.5. Меню “Формат”  
1. Шрифт 

1.1. Вкладка “Шрифт “– дозволяє до виділеного фрагмента тексту застосувати 
інший шрифт, зображення, розмір, встановити підкреслення, змінити колір 
шрифту і змінити спеціальні ефекти верхній/нижній індекс … 

1.2. Вкладка “Інтервал” дозволяє до виділеного фрагмента тексту встановити 
розріджений, звичайний або ущільнений міжсимвольний інтервал, масштаб 
шрифту. 

1.3. Вкладка “Анімація” - дозволяє до виділеного фрагмента тексту встановити 
анімаційні ефекти для привертання уваги, які існують виключно в електронній 
формі. 

2. Абзац – дозволяє до виділеного фрагмента тексту встановити горизонтальне 
вирівнювання, встановити міжрядковий інтервал, відступи зліва, справа і для 
першого рядка. 

3. Список - дозволяє створити маркіровані, нумеровані, багаторівневі списки. 
Застосовується до виділеного фрагмента тексту або створюється окремо. 

*Створення багаторівневого списку: виділити текст/список і застосувати 
багаторівневий списокпри створенні підрівня необхідно встановити курсор на 
початку пункту і натиснути клавішу Tabі у випадку якщо необхідно повернути на 
попередній рівень, необхідно встановити курсор в початок рядка і натиснути клавішу 
 BackSpaсe. 
4.  Межі і заливка 

4.1. Вкладка “Межі“ - призначена для створення меж для виділеного тексту. 
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4.2. Вкладка “Сторінка” - призначена для створення меж (рамки титульного листа) 

цілої сторінки. 
4.3. Вкладка “Заливка” - призначена для установки заливки кольором виділеного 

фрагмента тексту або всього тексту в рамці. 
5. “Колонки” - дозволяє розділити лист або виділений фрагмент тексту нашого 

документа на декілька колонок. 
6. “Фон” (на друк не виводиться). 

6.1.  “Палітра кольорів” - призначена для вибору фонового кольору сторінок 
документа. 

6.2.  “Додаткові кольори” – призначені для вибору кольору, якого немає на палітрі. 
6.3.  Способи заливки 

6.3.1. Вкладка “Градієнтна” - призначена для установки як фону градієнта 
(заливка з двох кольорів) або заготовки. 

6.3.2. Вкладка “Текстура” - призначена для установки фону з натуральних 
матеріалів.  

6.3.3. Вкладка “Узор” - призначений для вибору узору як фону. 
6.3.4. Вкладка “Малюнок” - призначена для установки як фону малюнка з 

жорсткого диска (емблеми фірми, логотипа, герба і т.п.). 
 

1.2.6. Меню “Сервіс”  
1. “Правопис” (F7). Дозволяє перевірити правопис тексту. 
2. “Мова”. Дозволяє вибрати мову, викликати тезаурус, розставити переноси. 
3. “Статистика”. Виводить статистику файла: кількість сторінок, слів, знаків (без 

пробілів), знаків (з пробілами), абзаців, стрічок. 
4. “Автозаміна”. Дозволяє автоматично виправляти граматичні помилки 

(застосовувати не бажано), замінювати певний набір символів на інші (зручно 
для набору довгих назв організацій чи введення з клавіатури символів. що 
відсутні на клавіатурі) та інші заміни. 

5. “Встановити захист”. Накладає заборону на зміну тексту. Корисно при 
розташуванні текстового документу на Web сайті. Крім того, даний режим 
може ввімкнутись при перекладі текстового документу програмою “РУТА 4.0”, 
для редагування потрібно зняти захист. 

6. “Налагодження”. Дозволяє відобразити панелі інструментів або витягнути з 
вкладки “Команди” ярликів команд, натиснувши л.к.м. і відпустивши на 
відкритій панелі інструментів. 

7. “Параметри” (рис.1.3.). Містить вкладки “Вигляд”, “Загальні”, “Правка”, 
“Збереження”, “Правопис”, “Виправлення”, “Користувач”, “Сумісність”, 
“Розташування”. 
7.1. Вкладка “Вигляд” дозволяє показувати стрічку стану, анімацію, смуги 

прокручування.; знаки форматування; параметри Web-документу та ін. 
7.2. Вкладка “Загальні” дозволяє змінювати кількість останніх файлів, що 

висвітлюються в меню “Файл”, одиниці вимірювання на лінійках, 
налагодити параметри Web-документу та електронної пошти. 
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Рис.1.3. Вкладка “Параметри” меню “Сервіс” 
 
7.3. Вкладка “Правка” дозволяє встановити правила виділення та пересування 

тексту мишкою, використання клавіші Ins (вставка), вибрати редактор 
рисунків та сталь абзацу за умовчанням. 

7.4. Вкладка “Друк” дозволяє вибрати режим друку документу, додаткові 
параметри друку, подачу паперу.  

7.5. Вкладка “Збереження” дозволяє встановити параметри збереження 
(створювати резервну копію, дозволити швидке збереження, виставити 
час автозбереження, формат збереження файлу і ін.) та задати пароль на 
відкриття файлу і на право його зміни. 

7.6. Вкладка “Правопис” встановлює параметри орфографії (автоматичну 
перевірку правопису, виділення слів з помилками, пропонування заміни, 
ігнорування слів з цифрами, адресів Інтернету), дає можливість вибрати 
допоміжний словник перевірки орфографії, підключити правила 
граматики. 

7.7. Вкладка “Виправлення” налаштовує параметри вигляду виправлень 
документу. 
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7.8. Вкладка “Користувач” містить відомості про користувача програми. його 

ініціали (для передачі повідомлень) та електронний адрес. 
7.9. Вкладка “Сумісність” дає можливість додатково включити сумісність з 

програмами Word нижчих версій, у випадку встановлення матричного 
принтера проставити сумісність з ним та ряд інших. 

7.10. Вкладка “Розташування” дає можливість змінити розташування 
документів за замовчуванням, шаблону користувача, адресу 
автозбереження, додаткових словників. 

 
1.2.7. Меню “Таблиця”  
1. Вкладка “Добавити” дає можливість добавити таблицю, вказавши кількість 

стовпців та стрічок; добавити стрічку вище або нижче курсору, добавити 
стовпчик зліва чи справа від курсору. 

2. Вкладка “Видалити” дає можливість знищити таблицю цілком або стрічки, 
стовпці чи комірки. 

3. Вкладка “Виділити” виділяє певну область таблиці. 
4. Вкладка “Об’єднати комірки” здійснює зазначену дію. 
5. Вкладка “Розбити комірки” розбиває комірку на зазначене число стовпців та 

стрічок. 
6. Вкладка “Перетворити” дає можливість одержати з таблиці текст і з тексту – 

таблицю. 
7. Вкладка “Заховати сітку” прибирає з екрану сітку таблиці. 
8. Вкладка “Властивості таблиці” дає можливість налагодити розташування 

таблиці, параметри стрічки, стовпця чи комірки. 
 

1.2.7. Меню “Довідка” 
Вкладка довідка (F1) дає можливість викликати довідку і отримати вичерпну 

відповідь на питання, що цікавить. 
 
1.3. Панелі інструментів  
1.3.1. Панель інструментів “Стандартна” 
Панель містить ряд команд меню “Файл”, “Правка”, “Вигляд” та ін., що 

найчастіше використовуються (рис. 1.4), крім того вона містить ярлики для відкриття 
панелей інструментів “Таблиці і межі” та “Малювання”. 

 

 
 

Рис. 1.4. Панель інструментів “Стандартна”. 
На панелі інструментів розташовані насту пні ярлики: 

 - новий (Ctrl+N). Відкриває новий документ; 

 - відкрити (Ctrl+О). Відкриває збережений документ; 

 - зберегти (Ctrl+S). Зберігає документ; 

 - друк . Кидає на друк весь документ без можливості налагодження принтера, яка 
з’являється при натисканні (Ctrl+Р); 



 12 

 - попередній перегляд; 

 - правопис (F7). Розпочинає перевірку правопису; 

  - вирізати (Ctrl+Х). Вирізає (переміщує в буфер обміну) виділену інформацію; 

 - копіювати (Ctrl+С). Копіює в буфер обміну виділену інформацію зі збереженням 
її на початковому місці; 

 - вставити (Ctrl+V). Вставляє в позицію курсору інформацію, що знаходиться в 
буфері обміну. Очистки буферу обміну при цьому не відбувається. 

 - формат за абзацом (Ctrl+Shift+C). Виділивши абзац, формат якого ми хочемо 
застосувати до іншого абзацу клацаємо л.к.м. по даному ярлику, після чого виділяємо 
другий абзац. Внаслідок такої дії формат першого абзацу буде скопійований другому. 
Якщо цю дію передбачається проводити для значного числа об’єктів, то по ярлику 
необхідно клацнути двічі (в цьому випадку дана команда буде залишатись активною 
до її вимкнення подвійним клацанням л.к.м.); 

 - відмінити (Ctrl+Z). Відміняє останню дію; 

 - повернути (Alt+Shift+Backspac). Повертає зміни до використання відміни дії; 

 - таблиці і межі. Відкриває однойменну панель інструментів; 

 - добавити таблицю. Для вставки в текст документу таблиці необхідно клацнути 
л.к.м. по даному ярлику, після чого у відкритому вікні протягнути л.к.м. на необхідну 
кількість стрічок та стовпчиків; 

 - добавити таблицю Exel. Для вставки в текст документу таблиці Exel необхідно 
клацнути л.к.м. по даному ярлику, після чого у відкритому вікні протягнути л.к.м. на 
необхідну кількість стрічок та стовпчиків; 

 - малювання. Відкриває однойменну панель інструментів; 

 - знаки, що не друкуються. Відображає в тексті документу всі знаки що не 
друкуються (пробіли, знаки абзаців, розриви сторінок і ін.). Всі ці знаки 
відображаються лише в електронному варіанті; 

 - масштаб. Дозволяє вибрати масштаб відображення сторінки зі списку або 
безпосередньо ввести в поле число від 10 до 500%. Знак % можна опускати; 

 - довідка (F1). Викликає довідку програми Microsoft Word 2000, яка дає вичерпну 
відповідь на питання, що виникають при наборі тексту. 

1.3.2. Панель інструментів “Форматування” 
Панель містить ряд команд меню “Формат”, що найчастіше використовуються 

(рис. 1.5). 
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Рис. 1.5. Панель інструментів “Форматування”. 
На панелі інструментів розташовані насту пні ярлики: 

 - стиль. Застосовує формат вибраного стилю до абзацу; 

 - гарнітура шрифту. Дає можливість зміни гарнітури шрифту. 
Найчастіше використовують Times New Roman та Arial; 

 - розмір шрифту (Ctrl+Shift+P) в пунктах; 

 - напівжирний шрифт (Ctrl+В); 

 - курсивний шрифт (Ctrl+І); 

 - підкреслений шрифт (Ctrl+U). Є можливість комбінування напівжирного, 
курсивного та підкресленого виглядів шрифту. 

 - вирівнювання тексту абзацу по лівому краю (Ctrl+L); 

 - вирівнювання тексту абзацу по центру (Ctrl+E); 

 - вирівнювання тексту абзацу по правому краю (Ctrl+R); 
 - вирівнювання тексту абзацу по ширині (Ctrl+J); Використовується для 

звичайного абзацу; 

 - нумерований список. Включає/виключає нумерований список; 

 - маркований список. Включає/виключає маркований список; 

 - зменшити відступ. Зменшує відступ абзацу від лівого поля; 

- збільшити відступ. Збільшує відступ абзацу від лівого поля; 

 - виділення кольором. Дає можливість виділити  кольором частину тексту з 
метою привертання уваги; 

 - колір шрифту. Дає можливість змінити колір шрифту. 
 
1.3.3. Панель інструментів “Таблиці і межі” 

Панель містить ряд команд меню “Таблиця”, що найчастіше використовуються 
(рис. 1.6). 

 

 
 

Рис. 1.6. Панель інструментів “Таблиці і межі”. 
На панелі інструментів розташовані насту пні ярлики: 

 - олівець: малює зовнішні і внутрішні межі таблиці;  

 - гумка: видаляє межі таблиці; 

 - тип лінії: дозволяє вибрати тип ліній меж таблиці; 
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 - товщина лінії: дозволяє змінити товщину мальованих меж таблиці; 

 - колір лінії: дозволяє встановити інший колір меж таблиці; 

 - межі … : дозволяє показати або приховати певні чи всі межі таблиці; 

 - колір залиття: заливає виділені елементи таблиці вибраним кольором; 

 /  - об’єднати / розбити комірки: дозволяє виділені елементи таблиці об'єднати 
в одну або розбити на декілька; 

 - вирівняти ...: дозволяє вміст елементів таблиці вирівняти по верхньому, 
нижньому краю або по вертикалі, одночасно вирівнюючи по правому, лівому краю чи 
по центру; 

 /  - вирівняти висоту рядків / ширину стовпців: дозволяє вирівняти висоту 
виділених рядків / ширину виділених стовпців; 

 - автоформат: застосовує автоматичне форматування таблиці в програмі Microsoft 
Word, включаючи рамки та штрихування. розмір таблиці також може змінюватись 
автоматично для рівномірного заповнення всіх комірок; 

 - зміна напряму тексту в комірці: дозволяє змінити напрям тексту у  виділених 
комірках; 

 / - сортування: вміст виділених рядків таблиці сортується в алфавітному 
порядку за збільшенням / зменшенням; 

 - автосума: підраховує суму елементів комірок таблиці Exel. 
 

2. Порядок виконання роботи 
1. Ознайомитися з теоретичними відомостями. 
2. Створити документ з параметрами сторінки: 

поля: 
верхнє – 2 см; нижнє – 2 см; ліве – 2,5 см; праве 1,5 см, 

Розмір паперу – А4; орієнтація аркуша – книжна. 
3. Шрифтом .Times New Roman 14 пт. з дотриманням форматування набрати 

наступний текст: 
 

Фазою називають відокремлену частину системи, яка має свою, тільки їй 
притаманну, структуру, і свої властивості. Фаза відмежована від решти системи. 
Розрізняють такі фази в системі 3Fe Fe C− . 

1. L – ліква, розчин вуглецю в розплавленому Fе. 
2. А – аустеніт ( )( )A Fe C= , що є твердим розчином проникнення С в Fe з 

структурою ГЦК і розчинністю від 0% до 2,14%. 
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3. Ф - ферит ( )( )Ф Fe C=  - твердий розчин С в Fe  з структурою ОЦК і 

розчинністю від 0% до 0,025%. 
4. Ц – цементит ( )3Ц Fe C=  - карбід заліза, містить 6,67% С . 

Існують різновиди Ц: 
➢ ЦІ - виділяється з лікви; 
➢ ЦІІ - виділяється з аустеніту А внаслідок зменшення розчинності С в ( )Fe C  

при зниженні температурі від 1147°С до 727°С;  
➢ ЦІІІ- виділяється з фериту Ф внаслідок зменшення розчинності С в ( )Fe C  при 

зниженні температури від 727°С до кімнатної; 
 Структурні складові складаються з кількох (2-х і більше) фаз. В системі 

3Fe Fe C−  розрізняють такі структурні складові. 
П - перліт (П=Ф+Ц), евтектоїд, може мати пластинчасту або зернисту структуру, 

містить 0,8% С. 
Л - ледебурит, евтектика. При температурі вище 727°С і нижче 1147°С ледебурит 
називають високотемпературним, він складається з аустеніту і цементиту ЦІ і 
позначається як Лв=A+ЦІ. При температурі нижчій 727°С ледебурит називають 
низькотемпературним, він складається з перліту і цементиту і позначається як 
Лн=П+ЦІ.  
 
4. Під даним текстом з нової сторінки набрати наступну таблицю та підпис до неї: 
 
 

Таблиця 1.1–Координати точок на діаграмі стану  залізо – Fe3C (цементит). 

Точка 
Координати 

t,ºC %C 
A 1539 0 
B 1449 0,51 
H 1449 0,1 
J 1449 0,16 
E 1147 2,14 
C 1147 4,3 
F 1147 6,67 
P 727 0,025 
S 727 0,8 
Q 20 0,006 

 
5. Скопіювати визначення фериту та аустеніту і вставити під таблицею. 
6. Змінити шрифт в таблиці на Arial 12 пт., колір шрифту – темно-зелений. 
7. Шапку таблиці залити світло-сірим кольором. 
8. Назву таблиці зробити напівжирною та курсивною розміром 16 пт. 
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9. Одержаний результат повинен бути записаний в файл за шляхом: 

H\(прізвище)\Word\Форматування_таблиці.doc 
 

3.Контрольні запитання 
1. Для чого призначена і які можливості програми Microsoft Word 2000 (9.0)? 
2. Як запустити програму? 
3. Для чого призначена стрічка меню? 
4. Для чого призначені панелі інструментів?  
5. Які знаєте команди панелі інструментів “Стандартна”? 
6. Які знаєте команди панелі інструментів “Форматування”? 
7. Які знаєте команди панелі інструментів “Таблиці і межі”? 
8. Чому варто використовувати “гарячі” клавіші”? 
9. Які знаєте гарячі клавіші панелі інструментів “Стандартна”? 
10. Які знаєте гарячі клавіші панелі інструментів “Форматування”? 
11. Які знаєте гарячі клавіші панелі інструментів “Таблиці і межі”? 
12. Назвіть основні області виду екрану програми  Microsoft Word 2000? 
13. Меню “Файл”. 
14.  Меню “Правка”. 
15.  Меню “Вигляд”. 
16.  Меню “Вставка”.  
17.  Меню “Формат”. 
18.  Меню “Сервіс”. 
19.  Меню “Таблиця”. 
20.  Меню “Довідка”. 
21.  Яким чином можна створити таблицю? 
22. Як можна добавити стрічку чи стовпець до таблиці? 
23. Яким чином можна перенести текст з одного  місця документу в інший? 
24. Яким чином можна скопіювати текст з одного  місця документу в інший? 
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Практичне заняття № 2 

 
Тема: одержання зображення мікроструктури та робота з його підготовки до 
використання програмою photo 1.21 
Мета роботи: оволодіти технікою одержання та редагування піксельних об’єктів 
за допомогою програми photoshop 7.0. Підготувати скановані зображення 
мікроструктур різних марок сталей до використання програмою photo 1.21. 
 
1. Основні положення 

Програма PhotoShop призначена для створення растрових (точкових) зображень і 
роботи з фотографіями. 

 
Запуск програми: 

Меню Пуск – Програми – Adobe PhotoShop 7.0 [ – PhotoShop 7.0] 
Опис робочого столу. 

1.1. Панель інструментів – призначена для вибору інструментів, з якими надалі 
хочемо працювати. Щоб чи показати забрати панель 
інструментів можна скористатися кнопкою Tab.  

Для того щоб активізувати інструмент, піктограма 
якого в даний момент видно на екрані, клацніть по ній. 
Поряд із деякими піктограмами розташована маленька 
стрілка. Якщо по ній клацнути, розкриється спливаюча 
палітра, де можна вибрати інструмент, що входить до 
тієї ж групи.  

Ще зручніше викликати інструменти за допомогою 
клавіатури (запам'ятайте букви, вказані на наступних 
сторінках для кожного інструменту). Якщо ви забули 
клавішну комбінацію, наведіть курсор на піктограму 
інструменту, затримайте на декілька секунд, і 
спливаюча підказка нагадає її вам (Рис. 2.1). Щоб 
поперемінно викликати вхідні в яку-небудь групу 
інструменти, піктограми яких заховані, натискуйте 
клавішу Shift і відповідну «гарячу» клавішу. Також 
можна, натиснувши клавішу Alt, клацнути по піктограмі 
видимого інструменту.  

Для кожного інструменту задаються свої власні 
параметри (наприклад, режим змішування, значення 
непрозорості) на панелі опцій, розташованій вгорі 
екрану (докладніше про панель опцій розказано в розділі 
«Панель опцій») - див. Рис. 2.2. Склад параметрів на 
панелі опцій змінюється залежно від того, який 
інструмент вибраний.  

 
Рис. 2.2. Спливаюча підказка на панелі опцій 

  

Рис. 2.1. Спливаюча 
підказка на панелі 
інструментів  
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На панелі опцій з правої сторони розташована піктограма активного 

інструменту. Якщо клацнути по стрілці поряд із піктограмою, розкриється випадаюче 
меню, де ви можете вибрати інший інструмент. Цей список можна редагувати, 
видаляти рідко використовувані і додавати часто вживані інструменти. Установки на 
панелі опцій зберігаються для кожного інструменту, якщо їх не змінити або не 
відновити приймаються за умовчанням. Завантажити, додати і зберегти різні 
комбінації кнопок, а також відновити характеристики інструменту, що приймаються 
за умовчанням можна за допомогою команд меню випадаючої панелі (Рис. 2.3). Для 
того щоб відновити значення опцій, що приймаються за умовчанням для всіх 
інструментів, там же виберіть команду Reset All Tools (Відновити всі інструменти) 
або клацніть по кнопці Reset All Tools у вікні Edit > Preferences > General (Правка > 
Установки > Загальні).  

Примітка  
У вікні Edit > Preferences > Display& Cursors (Правка > Установки > 

Відображення&курсори) виберіть, як буде виглядати курсор: так само, як і піктограма 
інструменту на панелі інструментів, або у вигляді перехрестя.  

Якщо спробувати неправильно використовувати інструмент, з'явиться 
піктограма заборони 0. Клацніть мишею у вікні, що містить зображення, над яким ви 
працюєте, щоб дізнатися, чому не можна використовувати інструмент у цій ситуації.  

На 

Рис. 2.4 показана панель інструментів 
програми Photoshop 7. Поряд із назвою 
груп інструментів вказана «гаряча 
клавіша» для виклику інструментів, що 
входять до складу групи.  

Натискуйте клавішу Shift і 
відповідну «гарячу» клавішу, щоб по черзі викликати інструменти, розташовані на 
одній спливаючій палітрі (див. Рис. 2.5 —1.21) і зв'язані між собою.  

Рис. 2.3. Панель вибору інструменту  
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Рис. 2.4. Панель інструментів  Рис. 2.5. Палітра інструментів для виділення 
області геометричної форми  

Рис. 2.6. Палітра інструментів 
для виділення області 
довільної форми  

Рис. 2.7. Палітра інструментів 
для усунення дефектів 
зображень  
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Рис. 2.8. Палітра інструментів клонування  Рис. 2.9. Палітра інструментів стирання  

Рис. 2.10. Палітра інструменів, 
контролюючих чіт-
ість меж зображення  

Рис. 2.11. Палітра інструментів 
прямого виділення  
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Рис. 2.12. Палітра інструментів для 
роботи з контурами  

Рис. 2.13. Палітра інструментів 
для створення примі-
ток  

Рис. 2.14. Палітра інструментів 
для роботи зі ски-
бочками (частинка-
ми) 

Рис. 2.15. Палітра інструментів 
малювання  
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Рис.2.16. Палітра інструментів 
для роботи з історією 
створення зображен-
ня  

Рис. 2.17. Палітра інструмен-
тів заливки  

Рис. 2.18. Панель інструментів для 
освітлення і 
затемнення зображень  

Рис. 2.19. Панель інструментів 
для роботи з текстом  
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Рис. 2.22. Панель опцій для інструменту Brush  
 

 
 
Рис. 2.23. Панель опцій для інструменту Rectangular Marquee  
 
1.2. Панель опцій  
Панель опцій використовується для вибору значень параметрів кожного 

інструменту (наприклад, рівня непрозорості, точки початку загасання, режиму 
змішування) - див. Рис. 2.22. Справа на панелі опцій є особлива область, призначена 
для зберігання палітр. Набір параметрів, що виводяться на панель, змінюється 
залежно від того, який саме інструмент вибрано (Рис. 2.22-1.27). Введені або вибрані 
вами значення будуть збережені до тих пір, поки ви знову не зміните їх. Так само, як 
і палітру, панель опцій можна перемістити в будь-яку частину екрану.  

 
Рис. 2.24. Панель опцій для інструменту Gradient  

Рис. 2.20. Панель векторних 
інструментів малю-
вання  

Рис. 2.21. Панель 
інструментів для 
роботи з кольором, 
кутами і відстанями  
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Рис. 2.25. Панель опцій для інструменту Рen  

 
Рис. 2.26. Панель опцій для інструменту Rectangle  

 
Рис. 2.27. Панель опцій для інструменту Турe  
 
1.3. Спливаючі підказки  
Наведіть курсор на піктограму інструменту, не клацаючи і не натискуючи 

кнопки миші, і ви взнаєте назву інструменту, а також «гарячі» клавіші для його 
активізації (див. Рис. 2.1). Аналогічно можна отримати відомості про функцію 
палітри або про значення опцій, доступ до яких забезпечує панель опцій інструменту 
(див. Рис. 2.2). Для того, щоб включити режим підказок, встановіть прапорець Show 
Tool Tips (Показувати спливаючі підказки) у вікні Edit > Preferences > General (Правка 
> Установки > Загальні).  

1.4. «Гарячі» клавіші для інструментів  
В табл. 1.1наведені операції, що найбільш часто виконуються, і відповідні їм 

«гарячі» клавіші.  
Таблиця 1.1  

Основні «гарячі» клавіші для інструментів  

Операція «Гарячі» клавіші 
Показати/сховати панель інструментів і всі 
відкриті палітри  

Tab  

По черзі викликати зв'язані між собою 
інструменти з одного спливаючого меню  

Shift + клавіша активізації 
інструменту або клацання по 
видимій піктограмі інструменту 
при натиснутій клавіші Alt  

Перемикати режими змішування для 
поточного інструменту або шару 

Shift+«плюс» або Shift+«мінyc»  

 

1.5. Вид екрану при роботі з програмою Photoshop 7.0  
На Рис. 2.28 показано вид екрану при роботі з програмою Photoshop 7.0.  
Клацанням по кнопці (1) викликається меню управління додатком. Воно містить 

наступні команди: Restore (Відновити), Move (Перемістити), Size (Розмір), Minimize 
(Звернути), Maximize (Розвернути) і Close (Закрити). За допомогою кнопки (7) 
викликається меню управління документом. В основному меню документа містяться 
такі команди, як Restore (Відновити), Move (Перемістити), Size (Розмір), Minimize 
(Звернути), Maximize (Розвернути), Close (Закрити) і Next (Наступний).  

Клацніть мишею по будь-якому елементу панелі меню (2), щоб отримати доступ 
до різних діалогових вікон, підміню і командам.  

Для визначення параметрів вибраного інструменту призначена панель опцій (3).  
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Клацніть по кнопці Minimize (4), щоб звернути вікно програми; в результаті його 

піктограма буде розташована на панелі задач. Для того щоб відновити колишній 
розмір вікна, просто клацніть по цьому значку.  

Кнопка Maximize (Розвернути) додатку (5) або документа (10) дозволяє 
збільшити розмір вікна, наскільки це можливо. Якщо ж хочете відновити колишній 
розмір вікна, клацніть по кнопці Restore. Після того, як розмір вікна відновиться, 
кнопка Restore перетвориться на кнопку Maximize.  

Рис. 2.28. Вид екрану програми Photoshop 7.0 
 

Кнопка закриття програми (6) закриває вікно програми.  
Заголовок (8) містить найменування і масштаб зображення, ім'я поточного шару 

або ідентифікатор Background (Фон) та інформацію про режим зображення.  
Звернути документ можна, клацнувши по кнопці Minimize (9) документа, при 

цьому піктограма документа буде розташована в лівому нижньому кутку вікна 
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додатку. Клацніть по кнопці Restore (Відновити) (аналогічна зображенню кнопки 5), 
і буде відновлений колишній розмір вікна документа.  

Якщо хочете закрити зображення (для палітри аналогічно), клацніть по 
піктограмі (11).  

Щоб відобразити на екрані лінійки (12), скористайтеся командою View > Show 
Rulers (Вигляд > Показати лінійки). Положення курсору вказується відповідним 
маркером на кожній з лінійок. Виберіть одиниці вимірювання для лінійки в 
діалоговому вікні Edit > Preferences > Units&Rulers (Правка > Установки > Одиниці 
вимірювання&лінійки).  

У програмі є 13 палітр (13), які можна переміщати по екрану і міняти їх 
угрупування, що приймається за умовчанням. Клацніть по вкладці (імені палітри) в 
групі палітр, і вона стане самою верхньою в даному стеку.  

Для того щоб показати/сховати панель інструментів (14) і всі відкриті палітри, 
натисніть клавішу Tab.  

У рядку стану (15) відображаються значення наступних параметрів: Document 
Size (Розмір документа), Document Profile (Профіль документа), Scratch Sizes (Об'єм 
пам'яті) - об'єм оперативної пам'яті, в даний момент доступний для програми 
Photoshop, Efficiency (Ефективність) - частка використовуваної оперативної пам'яті, 
Timing (Час) і Current Tool (Поточний інструмент) -имя інструменту. Вказавши 
курсором на рядок стану, натисніть і утримуйте кнопку миші, щоб побачити, як буде 
розташовано зображення на сторінці. Якщо, вказавши курсором на рядок стану, 
натиснути кнопку миші при натиснутій клавіші Alt, то на екран буде виведена 
інформація про розміри зображення, число каналів, режим і дозвіл. Щоб почати відлік 
часу з нуля, виберіть елемент меню Timing (Час). Всі дії над зображенням 
виконуються на робочому полі (16). 

 

1.6. Меню  
Меню File (Файл) 
Команди з меню File (Файл) застосовуються в тих випадках, коли необхідно 

створити, відкрити, розмістити, закрити, зберегти, відсканувати, імпортувати або 
експортувати, надрукувати зображення, передати файл по мережі, автоматизувати 
деякі операції і, нарешті, вийти з програми Photoshop (Рис. 2.29). Скористайтеся 
підміню File > Jump to (Файл > Перейти в), щоб перейти в допоміжні додатки, такі 
як ImageReady або GoLive. 

Для того, щоб відсканувати зображення необхідно вибрати Меню Файл > Імпорт 
> Mustek 1200 CU (встановлений сканер). Після чого відкривається діалогове вікно 
сканера, яке дає можливість певної обробки зображення під час сканування. 

Меню Edit (Редактування). 
В меню Edit (Редактування), показаному на Рис. 2.30, містяться команди 

редагування зображення: копіювання, трансформації, вставки і перевизначення квітів 
зображення, а також команди створення грона певного розміру і форми, різних узорів 
і фігур. Команди підміню Fade (Ослабити) дозволяють ослабити ефект від багатьох 
операцій (наприклад, останнього застосованого фільтра, команд коректування або 
малювання яким-небудь інструментом). Команди підміню Purge (Очистити) 
звільняють пам'ять. Також за допомогою меню Edit можна відкрити діалогові вікна 
Color Settings (Характеристики кольору), Preset Manager (Менеджер настройок) і 
Preferences (Установки).  
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Меню Image (Образ). 
За допомогою підміню Mode (Режим) меню Image (Зображення), зображення 

може перетворено в будь-яке з восьми станів. Команди підміню Adjustments 
(Коректування) змінюють тон, насиченість, яскравість кольору або контрастність 
зображення. За допомогою команди Image Size (Розмір зображення) можна змінити 
розмір файла, розміри зображення або дозвіл. Діалогове вікно Canvas Size (Розмір 
полотна) використовується у тому випадку, коли потрібно змінити розмір робочого 
простору, в якому розташовано зображення.  

Меню Layer (Шар).  
Команди, розташовані в меню Layer (Шар), дозволяють додавати, копіювати, 

видаляти, змінювати, групувати, міняти порядок проходження шарів в стеку, 
управляти взаємним розташуванням зв'язаних шарів, об'єднувати шари, додавати до 
них маски і перетворювати зображення на один єдиний шар (Рис. 2.31). Доступ до 
деяких команд можна отримати швидше, скориставшись меню палітри Layers 
(Шари).  

Меню Select (Вибір) 
Команда All (Все) з меню Select (Виділити) - виділяє весь шар цілком. Команда 

ж Deselect (Зняти виділення), навпаки, знімає виділення зі всіх раніше виділених 
областей. Команда Reselect (Відновити виділення) знову виділяє ту область, до якої 
була застосована остання команда Deselect. Команда Color Range (Діапазон квітів) 
створює виділення з урахуванням кольору. Інші команди цього меню розширюють, 
стискають, згладжують або розмивають межі виділеної області, а також зберігають 
виділені області в каналах або завантажують області з каналів.  

Рис. 2.29. Меню File (Файл) Рис. 2.30. Меню Edit (Редактування) 
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Меню Filter (Фільтр)  
Меню Filter (Фільтр) містить фільтри, що виконують широкий діапазон операцій 

по редагуванню зображення і згруповані при допомозі підміню (Рис. 2.32). Фільтр 
Digimarc (Діджімак) вставляє в зображення невидимий для людського ока знак 
авторського права.  

 
Порівняно з попередньою версією програми в це меню з меню Image переміщено 

дві команди. Команда Extract (Витягнути) дозволяє створювати виділені області 
складної форми. Команда Liquify (Спотворити) зсовує точки зображення в якому-
небудь напрямі.  

Меню View (Вигляд)  
Команди меню View (Вигляд) контролюють, що відображається і що не 

відображається на екрані. Команда Gamut Warning (Попередження про гамму) 
виділяє ті кольори, які не будуть виведені при чотириколірному друці. Команди 
підміню Proof Setup (Установки пробного відбитка) дозволяють побачити, як буде 
виглядати зображення при друці в різних режимах. Інші команди з меню View 
управляють масштабом зображення, а також виводять на екран лінійки, координатну 
сітку, допоміжні лінії і області, на які поділено зображення.  

Меню Window (Вікна) 

Рис. 2.31. Меню Layer (Шари) 

Рис. 2.31. Меню Filter (Фільтр) 
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Команди з меню Window (Вікна), яке уявлене на Рис. 2.38, управляють показом 

або утаєнням різних палітр. В цьому меню також розташований список відкритих 
зображень, і будь-яке з них можна зробити активним.  

При роботі в середовищі операційної системи Windows дане меню дозволяє 
управляти взаємним розташуванням вікон зображень і “показать/спрятать” рядок 
стану.   

Меню Help (Допомога або інформація) 
Команди з меню Help (Допомога) допомагають отримати доступ до керівництва 

програми Photoshop в інтерактивному режимі, взнати останні новини від компанії 
Adobe, підключитися до сайту Adobe Online або виконати які-небудь інші дії за 
допомогою підказок, що з'являються на екрані.  

 
2. Порядок виконання роботи 
1. Одержати і відсканувати декілька фотографій мікроструктури. 
2. Записати одержані дані у файли. 
3. Створити копії файлів для подальшої роботи (з оригіналів можна відновити 
зображення у випадку втрати корисної інформації при обробці фотографій). 
4. Відредагувати розмір зображення у відповідності з вимогами програми Photo 1.21: 

−  розмір зображення 800 × 600 пікселів; 
−  ім’я файлу – за схемою 8.3; 
−  розширення файлу *.jpg; 
−  режим зображення – grayscale (відтінки сірого); 
−  остаточний  результат повинен бути записаний за шляхом: 

H\(прізвище)\Photo\… 
5. Оформити письмовий звіт. 

 
3. Контрольні запитання 
1. Для чого призначена і які можливості програми Adobe Photoshop 7.0? 
2. Як запустити програму? 
3. Для чого призначена панель інструментів, які інструменти Ви знаєте?  
4.  Для чого призначена панель опцій? 
5. Яке призначення спливаючих підказок? 
6. Чому варто використовувати “гарячі” клавіші? 
7. Назвіть основні області виду екрану програми  Photoshop 7.0.? 
8. Що розташовано на вкладці Меню? 
9. Меню File (Файл). 
10. Меню Edit (Редактування). 
11. Меню Image (Образ). 
12. Меню Layer (Шар).  
13. Меню Select (Вибір). 
14. Меню Filter (Фільтр). 
15. Меню View (Вигляд). 
16. Меню Window (Вікна). 
17. Які параметри повинно задовольняти зображення мікроструктури, підготоване до 
обробки програмою Photo 1.21? 
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Практичне заняття № 3 

 
Тема: Створення текстового документу з графіком та об’єктом, виконаним в іншій 
програмі. Запис та роздрук файла 
Мета роботи: навчитись створювати в текстовому документі графіки, схеми 
діаграми; вставляти об’єкти виконані за допомогою інших програм. Закріплення 
навиків збереження документів, роздруковування. 
 

1.  Основні положення і  зміст роботи 
Найпростіше діаграми, графіки, схеми виконувати в Word за допомогою панелі 

інструментів “Малювання” (рис.3.1.) 

 
Рис.3.1. Панель інструментів “Малювання”. 
Дана панель крім основних ярликів містить і ряд додатково вставлених для 

пришвидшення виконання графічних елементів в програмі Word. 
Основні вкладки та команди даної панелі. 

 - вкладка дія (рис.3.2). Дає можливість 
виконати ряд дій над графічними об’єктами: 
▪ згрупувати вибрані об’єкти , розгрупувати 

попередньо згрупований об’єкт ;  
▪ змінити порядок розташування об’єктів на листі – 

перемістити зображення на передній план ,  
задній план  та ряд інших; 

▪ зсунути об’єкт вверх, вниз, вправо чи вліво; 
▪ вирівняти / розподілити вибрані об’єкти по 

вертикалі чи горизонталі і т.п.; 
▪ повернути (на певний кут) / відобразити (відносно 

лінії) об’єкти; 
▪ змінити обтікання об’єкту текстом ; 
▪ призначити зміну вузлів одного графічного об’єкту ; 
▪ встановити параметри даного об’єкту як замовчувані для нових об’єктів. 

 - вмикає / вимикає режим вибору об’єкта. Призначена для виділення великої 
кількості об’єктів шляхом затягування рамкою при натиснутій л.к.м. (невелику 
кількість об’єктів можна виділити клацаючи л.к.м. по об’єктах при натиснутій клавіші 
Shift). 

 - вільне обертання. Обертає об’єкти навколо центру. Для обертання декількох 
об’єктів навколо спільного центру їх потрібно спочатку згрупувати. 

 - обтікання тексту зверху та знизу (застосовано до рис.2.1). 
 - вкладка автофігури (Рис. 12.3). Призначена для малювання ліній (прямої 

, стрілки , кривої , полілінії  та ін.); вставки основних фігур (прямокутника 
, ромба, трапеції, трикутників, овалу  та ін.); вставки фігурних стрілок (різного 

Рис.3.2. Вкладка “Дія” 
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вигляду та напрямків); вставки елементів блок-схем до 
комп’ютерних програм (використовуватимуться в 
лабораторному занятті №6); вставки зірочок та стрічок; 
вставки різноманітних виносок. 

 - надпис. Дає можливість створити надпис в графічному 
об’єкті з подальшим групуванням всіх об’єктів. 

 -  вставка тексту WordArt.  -  добавити картинку; 

 - колір заливання об’єкту; 

 - колір ліній. Дозволяє вибрати колір ліній 
об’єкту; 

 - колір шрифту. Дозволяє змінити колір шрифту; 

 -    тип лінії. Змінює тип та товщину ліній; 
 -  тип штриха. Дозволяє вибрати суцільну, штрихову, штрихпунктирну та інші 

лінії. 
 - вигляд стрілки. Дозволяє вибрати вигляд та напрямок стрілки. 

2. Порядок виконання роботи 
1. Відкрити файл за шляхом: H\(прізвище)\Word\ Форматування_таблиці.doc. 
2. Зберегти файл під назвою Схеми.doc в ту ж папку, з якої він завантажувався. 
3. У верхньому колонтитулі набрати власне прізвище та ініціали. 
4. З нової сторінки створити спрощену діаграму стану залізо – цементит у 

відповідності з рис.3.4. 

Товщина ліній сітки графіка – 0,75пт; товщина ліній графіка – 1,5 пт; розмір 
шрифту 12 пт. 

Рисунок повинен бути підписаний і згрупований. 
 

Рис.3.3. Вкладка “Автофігури” 

Рис.3.4. 
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5. Під рисунком через 2 інтервали написати: 

Схематичне зображення структурних складових. 
 

6. Відкрити в меню “Вставки” закладку “Об’єкт” і вибрати “Adobe Photoshop 
Image”, після чого в програмі Word запуститься програма Photoshop. 

7. В даній програмі створити наступні схеми структурних складових (підписи 
можна робити згодом у Word): 

 

 
8. Зберегти документ (Ctrl+S). 
9. Показати одержаний результат викладачу, після чого роздрукувати документ. 
10.  Роздрук прикріпити до звіту. 

 

3.Контрольні запитання 
1. Які команди містяться на панелі інструментів “Малювання”? 
2. Які можливості має вкладка “Дія”? 
3. Які об’єкти дозволяє створити вкладка “Автофігури”? 
4. Яким чином можна повернути навколо спільної осі декілька розрізнених 

об’єктів? 
5. Яким чином можна змінити вигляд стрілки на графіку? 
6. Яким чином можна змінити товщину лінії об’єкта? 
7. Що необхідно зробити для того, щоб роздрукувати документ? Як роздрукувати 

лише першу сторінку? 
 

  перліт    ледебурит 

Рис.3.5.  Схеми структурних складових ДС Fe-Fe3C 
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Практичне заняття № 4 

 
Тема: Робота з програмою photo 1.21. Відкриття зображення. Робота з інтерфейсом 
користувача. Проведення калібрування 
Мета роботи: ознайомитися з інтерфейсом програми Photo 1.21 та навчитись  

проводити калібрування. 
 

1.  Основні положення і  зміст роботи 
1.1. Короткий опис програми 

Програма Photo 1.21 призначена для цитофотометрії. 
Програма здійснює розрахунок оптичної густини фотографій. Можливе завантаження 
чорно-білих зображень у форматі BMP і JPG і зміна масштабу перегляду. Оптична 
густина може розраховуватися з урахуванням тла як по середньому (по виділеній 
області), так і по окремій фотографії. Крім того, можливе віднімання темневого поля 
відеокамери. 

Крім розрахунку оптичної густини, передбачене інвертування, збільшення 
контрасту і згладжування зображення, генерація бінарного зображення, визначення 
відстані між об'єктами і площі області на фотографії. Передбачено режим 
калібрування для перерахування всіх координат у метричні одиниці. 
Мінімальні системні вимоги: 
- процесор Pentіum 100; 
- 16 Мб оперативної пам'яті; 
- 2 Мб вільно на твердому диску; 
- відеокарта 2 Мб (800x600, HіghColor); 
- операційна система Mіcrosoft Wіndows 95/98. 

 
1.2. Інтерфейс користувача 
У верхній частині вікна програми розташована панель керування. Кнопки на 

панелі керування забезпечують доступ до усіх функцій програми. Під панеллю 
керування знаходяться закладки вибору фотографії. Усього в програмі чотири 
сторінки, тобто одночасно можуть бути завантажені чотири фотографії:  

- темне поле; 
- тло; 
- об'єкт; 
- бінарний об'єкт. 

Обрана фотографія відображається в області перегляду, що займає центральну 
частину вікна. У статусному рядку в нижній частині вікна відображається короткий 
опис кнопок панелі керування, а також поточні координати курсору. 

1.2.1. Перегляд фотографій. 
Область перегляду фотографії займає центральну частину вікна програми. У 

верхній частині області перегляду відображається ім'я файлу, розміри (ширина і 
висота) і поточний масштаб перегляду. Масштаб перегляду вибирається кнопками на 
панелі керування. 

При переміщенні миші на області перегляду в статусному рядку відображаються 
координати точки, на яку вказує курсор, причому точка (0, 0) відповідає лівому 
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верхньому куту фотографії. Там же виводиться яскравість точки, що приймає 
значення від 0 (чорний колір) до 255 (білий). 

 При переміщенні миші з натиснутою лівою кнопкою відбувається виділення 
області на фотографії. Кожна виділена область має свій номер. Виділені області 
можна видаляти і позначати штрихуванням за допомогою кнопок панелі керування. 
Штриховані області вважаються "тлом" при розрахунку оптичної густини. 

При переміщенні миші з натиснутою правою кнопкою курсор набирає форми 
"руки", і відбувається зсув фрагмента фотографії. Крім того, вибирати фрагмент 
фотографії можна за допомогою смуг прокручування біля правого і нижнього країв 
області перегляду. 

У режимі виміру відстаней (див. нижче) курсор набирає форми "хреста". При 
натисканні лівої кнопки миші в якійсь точці фотографії в цю точку встановлюється 
хрестоподібний маркер. Якщо після цього перемістити мишу в іншу точку і клацнути 
ще раз, буде виміряна відстань між двома маркерами. 

1.2.2. Панель керування. 
Розглянемо кнопки панелі керування зліва направо (рис. 4.1). 
 

 
Рис. 4.1. Структура панелі керування програми Photo 1.21. 
 

  – "Завантажити фотографію".  Відображається діалог вибору файлу. 
Зазначений файл завантажується на ту сторінку, що у даний момент обрана. Тобто, 
для завантаження темного поля необхідно клацнути по закладці "Темне поле", після 
чого натиснути кнопку "Завантажити фотографію". При цьому поточний зміст 
сторінки губиться. Бінарний об'єкт не може бути завантажений, тому що він 
генерується на основі вже наявного зображення. УВАГА! Програма розроблена для 
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обробки чорно-білих (grayscale) зображень у форматі BMP і JPG. З кольоровими 
фотографіями програма буде працювати некоректно.  
Функції масштабування: 

 – "Збільшити масштаб". Збільшує масштаб перегляду поточної сторінки з кроком 

25%. Максимальний масштаб - 200%.  – "Зменшити масштаб". Зменшує масштаб 
перегляду. Мінімальний масштаб - 25%."Вихідний масштаб". Відновлює вихідний 
масштаб перегляду (100%). 
Функції виділення: 

 – "Видалити виділення". При натисканні цієї кнопки з’являється список, що 
містить номери усіх виділених областей. При виборі якого-небудь рядка виділення з 
даним номером віддаляється. Вибір рядка "Усі" видаляє всі виділені області. 

 – "Вважати виділення тлом". Випадає список виділених областей. При виборі 
рядка в списку область з даним номером позначається як тло і відображається 
штрихуванням.  
Функції обробки: 

 – "Негатив". Зображення інвертується. 

 – "Контраст". Збільшує контрастність зображення. Визначаються найтемніша і 
найсвітліша точки зображення, після чого яскравість кожної точки перераховується 
так, щоб найтемніша точка відображалася чорним кольором (а не темно-сірим), а 
найсвітліша - білим. 

 – "Згладжування". Видаляє "сміття". Після вибору матриці згладжування в 
списку, що випадає - 3х3 чи 5х5 - відбувається зниження різкості зображення. Ефект 
від застосування матриці 5х5 більше, ніж від матриці 3х3. При згладжуванні дрібні 
деталі зображення можуть бути загублені; якщо це відбулося, варто ще раз 
завантажити фотографію. 

 – "Бінаризація". Відображається вікно бінаризації зображення (перетворення 
зображення в двоколірне, з виділенням областей із заданим діапазоном яскравості). 
Бінарне зображення вставляється на сторінку 4 ("Бінарний об'єкт"). Подробиці див. у 
главі 4.1. 
Функції виміру: 

 – "Відстань". Переключає режими виділення і виміру відстаней - див. главу 2.1. 

 – "Площа". Виводиться вікно виміру площі - див. главу 4.2. Можливі чотири 
режими виміру площі - площа виділених областей, площа всіх об'єктів (областей, 
зафарбованих жовтим на бінарному зображенні), об'єктів у виділених областях і 
об'єктів, що не потрапили у виділені області, причому останні три режими доступні 
тільки при перегляді бінарного зображення. 

 – "Оптична густина". Виводиться діалог виміру оптичної густини - див. главу 4.3. 
Оптична густина може розраховуватися з урахуванням тла як по середньому (по 
виділеній області), так і по окремій фотографії. Крім того, можливе вирахування 
темного поля відеокамери. 
Інші функції: 
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 – "Калібрування". Виводиться список каліброваних записів. Після вибору рядка 
в списку відбувається перерахування координат, відстаней (у режимі виміру 
відстаней) і площ (у режимі виміру площі) у мікрони відповідно до обраного запису. 
При виборі верхнього рядка списку ("Ні") калібрування відключається (усі відстані 
виміряються в пікселях). При виборі нижнього рядка ("Змінити...") відображається 
вікно калібрування - див. п.8.1.3. 

 – "Керівництво користувача". Відкривається даний документ. 

 – "Про програму". Виводиться інформація про програму і її розробника. 
 
1.3. Калібрування 
Для перерахування координат на фотографії в метричні одиниці (мікрони) 

необхідно знати калібрувальний коефіцієнт, що залежить від об'єктива фотометра, 
параметрів відеокамери і настроювання оптичної системи. У зв'язку з цим для 
калібрування системи необхідно отримати фотографії об’єкт-мікрометра на усіх 
використовуваних об'єктивах і з тією ж розрізнювальною здатністю (розмірами 
зображення), з яким буде здійснюватись подальша робота. 

Після отримання фотографій необхідно натиснути кнопку "Калібрування" на 
панелі керування, і в списку, що з'явився, вибрати самий нижній рядок ("Змінити..."). 
На екран буде виведене вікно калібрування. 

1.3.1. Вікно калібрування. 
У нижній частині вікна розташована панель керування. Перші чотири кнопки панелі 
призначені для завантаження фотографії об’єкт-мікрометра і зміни масштабу 
перегляду, аналогічно відповідним кнопкам головного вікна (див. 2.1). Наступні 
чотири кнопки призначені для керування списком калібрувань: 
- "Нове калібрування". Додає в список новий калібрований запис.  
- "Вибрати калібрування". З'являється список наявних калібрувань, у якому можна 
вибрати запис для редагування. 
- "Зберегти калібрування". Після внесення змін у калібрований запис її необхідно 
зберегти. Якщо потрібно скасувати зміни, варто натиснути кнопку "Скасування". 
- "Видалити калібрування". Видалення однієї з існуючих записів. 
У верхній частині вікна відображаються параметри обраного каліброваного запису: її 
назва, довжина лінійки об’єкт-мікрометра в мікронах і довжина в пікселях (точках 
зображення). Центральну частину вікна займає область перегляду фотографії. 
При щиглику лівою кнопкою миші на області перегляду у відповідній точці 
фотографії встановлюється маркер. Якщо після цього пересунути миша в іншу точку 
і клацнути ще раз, відстань між цими точками буде обмірюване і записано в графу 
"Довжина, пкс". Назва калібрування і довжину лінійки в мікронах необхідно вводити 
вручну. 

1.3.2. Методика калібрування. 
- Отримати фотографію об’єкт-мікрометра. 
- Відкрити вікно калібрування і завантажити отриману фотографію. 
- Додати новий запис у список, після чого ввести ім'я калібрування в графі "Назва".  
  Звичайне ім'я містить тип об'єктива і розрізнювальну здатність відеокамери, 
наприклад, х25 732х572. 
  Назва калібрування повинна бути унікальною. 
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- За допомогою маркера (див. п. 8.1.3.1) виміряйте відстань між крайніми рисками 
об’єкт-мікрометра, видимими на фотографії. Лінія, що з'єднує маркери, повинна бути 
перпендикулярна рискам об’єкт-мікрометра. Відстань між маркерами буде 
автоматично записано в графу "Довжина, пкс". 
- Запишіть відстань між цими ризиками (ціна розподілу, помножена на кількість 
рисок) у графу "Довжина, мкм". 
- Натисніть кнопку "Зберегти калібрування".  
Новий калібрований запис доданий у список. Можна натиснути кнопку 
"Калібрування" на панелі керування головного вікна (див. главу 2.1) і вибрати в 
списку цей запис. 
 
 
УВАГА! При порівнянні декількох фотографій неприпустимо застосовувати функції 
"Контраст" і "Негатив" ні до однієї з порівнюваних фотографій! Це може привести до 
істотного перекручування результатів. Крім того, фотографії об'єкта, темного поля і 
тла повинні мати однакові розміри (ширину і висоту). 
 
 

2. Порядок виконання роботи 
1. Ознайомитися з роботою програми Photo 1.21. 
2. Отримати підготовлені до аналізу відносного вмісту фаз фотографії.  
3. Провести калібрування. 
4. Визначити розміри трьох найбільших зерен. 
5. Визначити площу трьох найбільших зерен. 
6. Скласти звіт у програмі Word. 
7. Записати файл за адресою: H\(прізвище)\Photo\Калібрування.doc 

 

3.Контрольні запитання 
1. Для чого призначена програма Photo 1.21? 
2. Які чотири сторінки містить програма Photo 1.21 та їх призначення?. 
3. Які кнопки містить панель керування і для чого кожна з них призначена?. 
4. Яким чином можна змінити масштаб перегляду фотографії? 
5. Як можна збільшити чіткість зображення в програмі Photo 1.21? 
6. Як здійснити згладжування частин фотографії, що належать одній фазі? 
7. Визначення відстані між об’єктами на фотографії. 
8. Вимірювання площі виділеної області. 
9. Як здійснюється калібрування? 
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Практичне заняття № 5 

Тема: Бінаризація зображення мікроструктури, розрахунок площі виділених 
довільним чином областей. Визначення марки сталі за фотографією мікроструктури 

 

Мета роботи: навчитись проводити кількісний аналіз дво- та трифазних структур. 
Визначити за мікроструктурою марку сталі 

 
1.  Основні положення і  зміст роботи 
1.4. Аналіз зображення 
Для аналізу зображення в програмі передбачені наступні функції: 
- виділення областей із заданим діапазоном яскравості (бінаризація); 
- обчислення площі виділеної області; 
- розрахунок оптичної густини. 
1.4.1. Бінаризація. 
Генерується бінарне (двоколірне) зображення, що вставляється на сторінку 4 

("Бінарний об'єкт"). Якщо на цій сторінці вже була якась фотографія, то вона 
пропадає.  

Для генерації бінарного зображення виводиться гістограма розподілу точок 
фотографії по яскравості. На гістограмі відображаються дві трикутні оцінки - верхня 
і нижня межі. При натисканні лівої кнопки миші на оцінці межі її можна переміщати; 
чисельні значення порогів відображаються під гістограмою. 

Усі точки вихідної фотографії, яскравість яких лежить між нижнім і верхнім 
порогами, вважаються "об'єктом" і відображаються жовтим кольором; точки з 
яскравістю поза заданим діапазоном вважаються "тлом" і відображаються синім. При 
натисканні кнопки "Ок" отримане бінарне зображення записується на сторінку 4. 

Для виділення найтемніших областей (наприклад, включень графіту) нижня 
межа зсувається до упору вліво (на оцінку 0), а верхня межа регулюється таким 
чином, щоб були видні тільки потрібні області. Для виділення найсвітліших областей 
верхня межа зміщається вправо до відмітки 255, а нижня межа регулюється.  

Перед бінаризацією зображення рекомендується збільшити контрастність 
(кнопка "Контраст" панелі керування) і, можливо, зробити згладжування. У деяких 
випадках зручніше бінаризувати інвертоване зображення (негатив).  

Бінаризацію рекомендується робити при збільшенні 100%, інакше швидкість 
роботи різко знижується. 

1.4.2. Розрахунок площі. 
На звичайній фотографії (не бінаризованій) можливо тільки вимірювання площі 

виділених областей. На бінарному зображенні можливо також вимірювання площі 
всіх об'єктів (областей, зафарбованих жовтим), об'єктів у виділених областях і 
об'єктів, що не потрапили у виділені області. 

Вікно виміру площі має чотири перемикачі режимів (на звичайній фотографії три 
з них недоступні), область висновку результатів і кнопку "Розрахунок". Після вибору 
режиму виміру і натискання кнопки "Розрахунок" в області висновку результатів 
з'являються загальні дані про оброблюване зображення (ім'я файлу і розміри), а також 
список усіх вмірюваних площ.  

Якщо включене калібрування (див. главу 3), площі виміряються в квадратних 
мікронах, якщо ні, то в пікселях. Крім того, відображається відношення вимірюваної 
площі до загальної площі фотографії. 
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В області висновку результатів можна виділити текст (переміщаючи мишу з 

натиснутою лівою кнопкою) і скопіювати його в буфер обміну (натиснувши праву 
кнопку миші). З буфера обміну текст можна вставити в будь-який інший документ.  

Крім того, є можливість автоматичного складання звіту. Для цього необхідно 
включити перемикач "Звіт: Записувати автоматично", після чого натиснути 
кнопку"..." і у вікні вибору, що з'явилося, файлу ввести ім'я текстового файлу (.TXT), 
до якого будуть додаватися результати розрахунків. Якщо файл не існує, він буде 
створений. При кожному натисканні кнопки "Розрахунок" результати розрахунку 
додаються в кінець файлу. 

УВАГА! Необхідно стежити за тим, щоб файл, у який записується звіт, не був 
відкритий якою-небудь іншою програмою. Якщо під час додавання запису у файл він 
відкритий, наприклад, редактором Mіcrosoft Word, буде видане повідомлення про 
помилку. 

1.4.3. Розрахунок оптичної густини. 
Оптична густина розраховується як середній десятковий логарифм відношення 

яскравості тла до яскравості точки об'єкта. При обліку темного поля відеокамери 
(фотографії, отриманої з перекритим об'єктивом камери) яскравість темного поля 
віднімається як з яскравості тла, так і з яскравості об'єкта. 

Вікно розрахунку оптичної густини містить перемикачі режиму темного поля (не 
враховувати, враховувати по точках за середнім значенням), перемикачі режиму 
обліку тла (по окремій фотографії, за середнім значенням у деякій області окремої 
фотографії, за середнім значенням у деякій області об'єкта), вибір області розрахунку 
(по всьому об'єкті чи по якійсь його частині). Після вибору всіх необхідних режимів 
і натискання кнопки "Розрахунок" в області висновку результатів з'являються 
загальні дані про всі задіяні фотографії (імена і розміри файлів) і список отриманих 
значень. Також є можливість автоматичного складання звіту (див. у главі 3.1). 

Для обліку темного поля фотографія темного поля повинна бути завантажена на 
першу сторінку. Перемикач "Середнє по фотографії" варто використовувати, якщо 
темне поле відносно рівномірне; перемикач "По точках" необхідний при 
нерівномірному темневому полі фотографії з високим рівнем шумів. 

Можливі три способи обліку тла. Якщо необхідно порівняти між собою кілька 
фотографій об'єктів, отриманих на одному зрізі, то тло враховується по окремій 
фотографії. Ця фотографія завантажується на сторінку номер 2 ("Тло").  

Якщо фотографія тла порівняно однорідна (не містить різких перепадів 
яскравості), то при розрахунку оптичної густини використовується режим "Тло з 
фотографії". При цьому у формулу розрахунку підставляються попарно точки тла й 
об'єкта з однаковими координатами. Якщо ж фотографія тла неоднорідна, то на ній 
варто виділити однорідну область і позначити її штрихуванням (див. функцію 
"Вважати виділення тлом" у п. 8.1.2.2. “Панель керування”). У цьому випадку 
використовується режим “Тло зі штрихування на фотографії”, при якому за яскравість 
тла приймається середнє значення по виділеній області. 

При порівнянні фотографій, отриманих на різних зрізах, оптична густина тла на 
кожній фотографії різна. При цьому на кожному з об'єктів виділяється тло, і 
використовується режим "Тло зі штрихування на об'єкті". У цьому випадку на кожній 
фотографії виділяється своя область тла і маркується штрихуванням. 
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Якщо фотографія об'єкта містить тільки досліджувану тканину, можна 

установити перемикач "область розрахунку" у положення "по всьому об'єкті". Якщо 
ж об'єкт містить щось іще (наприклад, порожні області), необхідно виділити ділянка 
досліджуваної тканини (не маркіруючи його штрихуванням) і використовувати 
режим "область розрахунку". 

У режимі "Тло зі штрихування на об'єкті" завжди використовується розрахунок 
"по виділених областях об'єкта".  

УВАГА! При порівнянні декількох фотографій неприпустимо застосовувати 
функції "Контраст" і "Негатив" ні до однієї з порівнюваних фотографій! Це може 
привести до істотного перекручування результатів. Крім того, фотографії об'єкта, 
темного поля і тла повинні мати однакові розміри (ширину і висоту). 
 
 

2. Порядок виконання роботи 
1. Ознайомитися з роботою програми Photo 1.21. 
2. Отримати підготовлені до аналізу відносного вмісту фаз фотографії.  
3. Провести бінаризацію фотографії. 
4. Визначити відносний вміст фаз та марку вуглецевої сталісталі. 
5. Скласти звіт у програмі Word. 
6. Записати файл за адресою: H\(прізвище)\Photo\Бінаризація.doc 
 
 
3.Контрольні запитання 
1. Яким вимогам повинен відповідати файл зображення мікроструктури для 

бінаризації? 
2. Які чотири сторінки містить програма Photo 1.21 та їх призначення? 
3. Які кнопки містить панель керування і для чого кожна з них призначена? 
4. Яким чином можна змінити масштаб перегляду фотографії? 
5. Як можна збільшити чіткість зображення в програмі Photo 1.21? 
6. Як здійснити згладжування частин фотографії, що належать одній фазі? 
7. Визначення відстані між об’єктами на фотографії. 
8. Вимірювання площі виділеної області. 
9. Як здійснюється калібрування? 

 Як здійснити бінаризацію? 
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Практичне заняття № 6 

 
Тема: Написання програми для визначення відносного вмісту фаз  

двокомпонентної діаграми стану з повною розчинністю 

Мета роботи: навчитись математично моделювати діаграми стану двоком-
понентних систем з повною розчинністю 
 

1.  Основні положення і  зміст роботи 
Діаграма стану двокомпонентної системи для випадку повної взаємної 

розчинності компонентів А і В в рідкому і твердому станах подана на рис.6.1. 
При температурі, вищій A Bt at , яка називається лінією ліквідус (з латинської - 

рідкий), існує лише рідка фаза P . В області, нижчій лінії A Bt bt ,яка називається лінією 
солідус (з латинської - твердий), існує лише тверда фаза –  -твердий розчин. 

В області, розташованій між лініями A Bt at  і A Bt bt  одночасно існують дві фази: 
рідкий сплав компонентів А і В та  -твердий розчин. 

У процесі кристалізації змінюється не лише склад фаз, але й кількісне 
співвідношення між ними. Для визначення кількісного співвідношення фаз, що 
знаходяться у рівновазі при даній температурі, користуються правилом відрізків 
(важеля). Згідно з даним правилом, наприклад, для визначення вагового вмісту 
твердої фази необхідно визначити відношення довжини відрізка, що прилягає до 
складу рідкої фази, до довжини всієї коноди (горизонтального відрізка, що проходить 
через точку n  і сполучає криві солідус та ліквідус – відрізок ab ). Отже, відносна маса 

твердої фази рівна: 100%anW
ab =  , а маса рідкої фази - 100%P

nbW
ab

=  . 

Для описання ліній солідусу та ліквідусу використовуємо відому 
апроксимаційну формулу другого порядку (для апроксимації за трьома точками): 

Рис.6.1.  Діаграма стану двофазної системи з повною розчинністю в рідкому 
і твердому станах 

A В, % Cn Ca Cb 

a b n 

ta 

tb 
 

 

 

20 40 60 80 
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( ) ( ) ( )
( ) ( )

( ) ( )
( ) ( )

( ) ( )
( ) ( )

2 3 1 3 1 2
1 2 3

1 2 1 3 2 1 2 3 3 1 3 2

x x x x x x x x x x x x
f x y y y

x x x x x x x x x x x x
−  − −  − −  −

=  +  + 
−  − −  − −  −

.   (1) 

Найкращі результати апроксимації відповідають рівним відрізкам між точками, 
тому на ДС знаходимо координати точок 1(0% В, Т1); 2(50% В, Т2); 3(100% В, Т3).  

Підставляючи дані координати у формулу (1), одержимо формулу для опису 
кривих ліквідус та солідус: 

 

 
 
 

(2) 
 
Підставляючи конкретні температури, одержуємо дві залежності: ( )s sT f x=  та 

( )L LT f x= . Знаючи концентрацію елементу В для заданої точки визначаємо 
температури початку та завершення кристалізації і порівнюємо з температурою 
заданої точки. звідки робимо висновок про стан системи в заданій точці. 

Якщо в даній точці ( ),n nn C T  існує дві фази, то необхідно ще визначити 
відносний вміст фаз . Для цього необхідно знайти координати точок перетину прямої 

ny T=  з кривими ( )S ST f x=  та ( )L LT f x= , для чого почергово прирівнюємо праві 
частини рівнянь: ( ) ( ) 0S n S nf x T f x T=  − = ; ( ) ( ) 0L n L nf x T f x T=  − = .  

Узагальнено можна написати: 

( ) ( )
2

1 2 2 3 20 2 15 1 5 3 1 0
5000 500 n

x xT T T T T T T T− + + − − + − = , або 2 0ax bx c+ + = , 

де 
1 2 2 3

5000
T T Ta − +

= , 
20 2 15 1 5 3

500
T T Tb − −

= , 1 nc T T= − . 

Розв’язками даного рівняння будуть значення: 
2

1,2
4

2
b b acx

a
−  −

= . В нашому випадку нас цікавлять лише корені, що 

задовольняють умову 0 100x   (якщо 0x =  або 100x = , то на дисплей повинно 
виводитись повідомлення про перебіг процесу кристалізації чистих елементів А 
чи В). 

Таким чином одержуємо абсциси точок a  і b  - Lx  і Sx . 

Відносний вміст рідкої фази 100%L S

n S

x x
WL

x x
−

= 
−

. 

Відносний вміст твердої фази 100%L S

L n

x x
WS

x x
−

= 
−

. 

 
 
 

( ) ( ) ( )
( ) ( )

( ) ( )
( ) ( )

( ) ( )
( ) ( )

( ) ( ) ( )
2

50 100 0 100 0 50
1 2 3 ;

0 50 0 100 50 0 50 100 100 0 100 50

1 2 2 3 20 2 15 1 5 3 1.
5000 500

x x x x x x
f x T T T

x xf x T T T T T T T

−  − −  − −  −
= + +

−  − −  − −  −

= − + + − − +
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2. Хід роботи 
 

1. Одержати одну з двох діаграм стану (рис.6.2, рис.6.3) та проаналізувати її. 
 

 

 
2. Визначити на математичному ріні за яких умов сплав перебуватиме в рідкому 

стані, за яких умов в твердому і в якому випадку існуватимуть дві фази 
3. Програму написати таким чином, щоб при вводі координати точки 

(температури та концентрації одного з елементів) програма видавала відповідь 
про якісний та кількісний склад (кількість фаз та їх вміст у відсотках). 

Рис.6.2.  Діаграма стану системи Ag – Au 
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Рис.6.3.  Діаграма стану системи Si-Ge 
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4. У звіті відобразити математичні умови існування певних фаз, блок-схему 

програми та саму програму, виконану на будь-якій з мов програмування. 
5. Провести розрахунки по п’яти точках, заданих викладачем. Результати 

відобразити у звіті. 
6. Програму зберегти за адресою: H\(прізвище)\Programs\ ім’я за схемою [8.3]. 

 
 

3.Контрольні запитання 
1. Охарактеризуйте ДС двокомпонентної системи з необмеженою розчинністю в 

твердому та рідкому станах. 
2. Сформулюйте правило відрізків для визначення відносного вмісту фаз 
3. За якою формулою можна здійснити апроксимацію трьох точок? 
4. Як знайти точку перетину криволінійної функції з горизонтальною прямою? 
5. Що необхідно писати в першу чергу програму чи блок-схему? 
6. Яким чином в розробленій програмі здійснюється визначення відносного 

вмісту фаз? 
7. Яка частина програми відповідає за визначення відносного вмісту фаз? 
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Практичне заняття № 7 

Тема: Побудова рамки та основного напису в AutoCAD 

Мета роботи: Побудувати рамку та основний напис на форматі A3 (Рис. 7.1). 

 

 
Рис. 7.1 

 

Хід роботи: 

• Запускаємо AutoCAD та розпочинаємо нове креслення. 

У вікні Startup, що відкривається після запуску, натискаємо кнопку Start from 

Scratch (Розпочати з нуля). Далі вибираємо метричні одиниці вимірювання; при 

цьому розмір робочої області за умовчанням встановлюється рівним розміру формату 

A3 (420x297). 

Після задання вказаних установок відкривається вікно графічного редактора. 

• Створюємо два шари креслення за допомогою команди LAYER (шар). 

Панель Layers:  

Кожному шару присвоюємо свої властивості та назву: 

- перший шар – RAMKA1; вага (товщина) лінії дорівнює значенню за 

умовчанням, тобто Default; 

- другий шар – RAMKA2; вага лінії – 0,7 мм. 

• Встановивши поточним шар RAMKA1, виконуємо зовнішню рамку креслення 

за допомогою команди RECTANG. 

Панель Draw:  

Діалог із системою в процесі побудови буде наступним: 
Command: _rectang 
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Specify first corner point or [Chamfer/ Elevation/ Fillet/ 

Thickness/ Width]: 0,0 
Specify other corner point or [Dimensions]: 420,297 

• Встановивши поточним шар RAMKA2, виконуємо внутрішню рамку за 

допомогою команди LINE. 

Панель Draw:  

Подальший діалог із системою:  
Command: _line Specify first point: 20,5 

Specify next point or [Undo]: 415,5 

Specify next point or [Undo]: 415,292 

Specify next point or [Undo]: 20,292 

Specify next point or [Undo]: c 

• Будуємо основний напис. 

Граничні прямі основного напису виконаємо командою OFFSET (Рис. 7.2). 

Треба пам’ятати, що при застосуванні цієї команди новий об’єкт матиме ті самі 

властивості, що і попередній. 
 

 
Рис. 7.2 

Панель Modify:  
Command: _offset 
Specify offset distance or [Through] <1.0000>: 185 
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Select object to offset or <exit>: – вказуємо курсором праву 

вертикальну лінію (1) внутрішньої рамки. 

Specify point on side to offset: – вказуємо курсором довільну точку 

зліва. 
Select object to offset or <exit>: Enter 
Command: _offset 
Specify offset distance or [Through] <185.0000>: 55 

 

Select object to offset or <exit>: – вказуємо курсором нижню 

горизонтальну лінію (2) внутрішньої рамки. 

Specify point on side to offset: – вказуємо курсором довільну точку 

зверху. 
Select object to offset or <exit>: Enter 

Прибираємо зайві відрізки за допомогою команди CHAMFER. 

Панель Modify:  

Command: _chamfer 

(TRIM mode) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000 

Select first line or [Polyline/Distance/Angle/Trim/Method/ 

multiple]: – вказуємо першу лінію. 

Select second line: – вказуємо другу лінію. 

Першу та другу лінії треба вказувати в тій частині, що залишається (див. Рис. 

7.2). 

Використовуємо команду ZOOM для збільшення частини зображення 

основного напису на екрані монітора. 

Вибираємо з меню View ► Zoom ► window або з панелі інструментів Zoom 

інструмент Zoom window. У цьому разі AutoCAD самостійно вибере опцію Window 

у відповідь на основний запит команди ZOOM, і нам залишиться тільки окреслити 

область, яку потрібно збільшити. 
Command: _zoom 

Specify corner of window, enter a scale factor (nX or nXP), or 

[All/Center/Dynamic/Extents/Previous/Scale/Window] <real time>: _w 

Specify first corner: вказуємо точку 
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Specify opposite corner : вказуємо діагонально протилежну точку. 

Першу та другу точки вказуємо так, щоб основний напис повністю був 

виведений на екран монітора. 

За допомогою команди OFFSET будуємо всі вертикальні лінії основного 

напису. При цьому змінюємо величину зміщення відносно вихідного об'єкта та 

вихідний об'єкт. 
Command: _offset 

Specify offset distance or [Through] <55.0000>: 7 (Потімзмі-нюємона 

10; 23; 15; 10) 

Select object to offset or <exit>: – вказується ліва вертикальна лінія 

основного напису. 

Specify point on side to offset: – вказується сторона правіше вихідного 

об'єкта. 

Select object to offset or <exit>: Enter Встановлюємо поточним шар 

RAMKA1. 

Горизонтальні лінії основного напису будемо виконувати за допомогою 

команди ARRAY. Попередньо створюємо за допомогою команди LINE нижню 

горизонтальну лінію на відстані 5 мм від рамки (див. Рис. 7.3). При вказуванні точок 

використовуємо об'єктну прив'язку. Пригадаймо, що прив'язка може здійснюватися 

одноразово (при введенні її імені з клавіатури або при виборі з контекстного меню чи 

з панелі інструментів Object Snap) або в постійному режимі (при активізації режиму 

OSNAP). В останньому випадку потрібно стежити за тим, щоб на закладці Object 

Snap діалогового вікна Drafting Settings були вибрані тільки необхідні для даних 

побудов типи прив'язок, оскільки зайві типи прив'язок можуть заважати роботі. 

 
Рис. 7.3 

Command: __line Specify first point: _from Base point: (ті) 
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<0ffset>: @0,5 

Specify next point or [Undo]: _per to: (вказуємо пряму 2, на яку опускаємо 

перпендикуляр) 

Specify next point or [Undo]: Enter 

Панель Modify:  

Command: _array 

Відкривається діалогове вікно Array. 

У вікні обираємо прямокутний масив (Rectangular Array), задаємо кількість 

рядків – 10 (включаючи об'єкт повторення), кількість стовпців – 1, відстань між: 

рядками – 5, а лінію, створену попередньо, обираємо як об'єкт копіювання. 

Встановлюємо поточним шар RAMKA2. 

Решту ліній основного напису (Рис. 7.4) будуємо за допомогою команд LINE та 

OFFSET, використовуючи при побудові прив'язки та перемикаючись між шарами. 

Тонкі лінії потрібно будувати на шарі RAMKA1, а товсті – на шарі RAMKA2. 
 

 
Рис. 7.4 

Як варіант, пропонуємо наступну послідовність дій у процесі виконання 

побудов: 

Встановлюємо поточним шар RAMKA2. 

Command: _line Specify first point: _int of – вказуємо т. 1 

Specify next point or [Undo]: _per to – вказуємо праву вертикальну 

лінію основного напису та одержуємо т. 2. 
Specify next point or [Undo]: Enter 
Command: _offset 

Specify offset distance or [Through]: 25 
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Select object to offset or <exit>: – вказуємо щойно одержану пряму. 

Specify point on side to offset: – вказуємо курсором точку нижче прямої. 
Select object to offset or <exit>: Enter 

Command: _line Specify first point: _from Base point: (т.2) 

<0ffset>:@-50,0 

Specify next point or [Undo]: _per to – вказуємо курсором нижню 

горизонтальну пряму основного напису та одержуємо т. 3. 
Specify next point or [Undo]: Enter 

Command: _line Specify first point: _from Base point: (т.4) 

<0ffset>: @0,5 

Specify next point or [Undo]: _per to – вказуємо праву вертикальну 

лінію основного напису та одержуємо т. 5 
Specify next point or [Undo]: Enter 
Command: _offset 

Specify offset distance or [Through] 15 

Select object to offset or <exit>: – вказуємо одержану пряму. 

Specify point on side to offset: – вказуємо курсором точку вище прямої. 
Select object to offset or <exit>: Enter 

Command: _line Specify first point: _from Base point: (т.6) 
<0ffset>: @15,0 

Specify next point or [Undo]: _per to – вказуємо нижню лінію 7. 

Specify next point or [Undo]: Enter 
Command: _offset 

Specify offset distance or [Through] 17 

Select object to offset or <exit>: – вказуємо одержану пряму. 

Specify point on side to offset: – вказуємо точку справа. 
Select object to offset or <exit>: Enter 

Command: _line Specify first point: from Base point: (т.4) 
<0ffset>: @20,0 

Specify next point or [Undo]: _per to – вказуємо лінію 7. 
Specify next point or [Undo]: Enter 

Встановлюємо поточним шар RAMKA1 . 
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Command: _line Specify first point: _from Base point: (т.8) 
<0ffset>: @5,0 

Specify next point or [Undo]: _per to – вказуємо нижню лінію. 
Specify next point or [Undo]: Enter 

Command: _offset 

Specify offset distance or [Through] <Through>: 5 

Select oPject to offset or <exit>: вказуємо одержану пряму. 

Specify point on side to offset: – вказуємо курсором точку справа. 
Select object to offset or <exit>: Enter 

Лінії 9 та 10, товщина яких 0,7 MM, потрібно перенести на шар RAMKA2. 

Командою TRIM обрізаємо зайві прямі (див. Рис. 7.4). 

Панель Modify; _/ – Trim 
Command: _trim * 

Current settings: Projection=UCS, Edge=None 

Select cutting edges... 

Select objects: – вказується ріжуча кромка 10. 

Select objects: Enter 
Select object to trim or shift-select to extend or [Project/ Edge/ 

Undo]: вказується об'єкт для обрізання 11. 
Select object to trim or shift-select to extend or [Project/ Edge/ 

Undo]: Enter 

• Для заповнення пойменованих зон основного напису використовуємо 

однорядковий текст (Рис. 7.5). Для створення однорядкового тексту призначена 

команда DTEXT. 

 
Рис. 7.5 

Панель Text:  

Меню: Draw ► Text ► Single Line Text 
Command: dtext 

Current text style: "style"!" Text height: 5.0000 
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Specify start point of text or [Justify/Style]: j 
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ 

ML/MC/MR/BL/BC/BR]: bl 

Specify bottom-left point of text: _from Base point: т. 1 (див. Рис. 

7.5, a) 
<0ffset>: @1,0 

Specify height <5.0000>: 3.5 
Specify rotation angle of text <0>: Enter 

Enter text: Розроб. 

Enter text: Enter 

Копіюємо напис (Рис. 7.5, б) у наступну комірку (базова точка копіювання – т. 

1, точка переносу – т. 2). 

Редагуємо текст «Розроб.» на «Перев.» (Рис. 7.5, в). 

Панель Text:  

Меню: Modify ► Object ► Text ► Edit 
Для збереження креслення використовуємо команду SAVEAS, вказавши ім'я 

та місце розміщення файлу. Завершуємо роботу AutoCAD командою EXIT. 
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Практичне заняття № 8 

 

Тема: Побудова плоского контуру 

Мета роботи: Виконати креслення контуру опори з використанням шарів 

(Рис. 8.1). 
 

 
Рис. 8.1 

Хід роботи: 

• Запустимо AutoCAD та розпочнемо нове креслення. 

• Для спрощення керуванням об'єктами та їх редагування створимо три шари 

(OSI, KONTUR, R0ZMIR), призначивши їм відповідні типи та товщини ліній. За 

допомогою списку Layer control, який знаходиться на панелі Layers, встановимо 

поточним шар OSI. 

• За допомогою команди XLINE креслимо осьові лінії 1 (Рис. 8.2). 

Панель Draw:  

Меню: Draw ► Construction Line Command: __xline Specify a point or 
[Hor/Ver/Ang/Bisect/ 

Offset]:h 

Specify through point: – вказується точка, через яку пройде горизонтальна 

лінія. 
Specify through point: Enter 
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Command: _xline Specify a point or [Hor/Ver/Ang/Bisect/Offset]:v 

Specify through point: – вказується точка, через яку пройде вертикальна 

лінія. 
Specify through point: Enter 

За допомогою команди OFFSET кресляться осьові лінії 2. 
Command : __of f set 

Specify offset distance or [Through] <Through>: 148 

Select object to offset or <exit>: – вказується вертикальна лінія. 

Specify point on side to offset: – вказується сторона переносу. 
Select object to offset or <exit>: Enter 
Command: _offset 

Specify offset distance or [Through] <148.0000>: 18 

Select object to offset or <exit>: – вказується горизонтальна лінія 

Specify point on side to offset: – вказується сторона переносу 

Select object to offset or <exit>: Enter 

 
Рис. 8.2 

• Накреслимо коло З за допомогою команди CIRCLE.  

Панель Draw:  

Меню: Draw ► Circle 

Command: ^circle Specify center point for circle or [3P/2P/Ttr (tan 

tan radius)]: _int of (т.4) 

Specify radius of circle or [Diameter] <40.0000>: 17 

• Встановлюємо поточним шар KONTUR. На цьому шарі будуватимемо контур 

деталі. 
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• За допомогою команди CIRCLE креслимо кола. При цьому вказуються центри 

кіл та їх радіуси. 

• Кола 1 (R8) та 2 (R26) кресляться відносно т. З, кола 4 (R23), 5 (R40) та б (R65) 

– відносно т. 7 (див. Рис. 8.3). 

 
Рис. 8.3 

• Будуємо пази в правій частині деталі. 

Спочатку будуємо паз, розміщений на осьовій лінії. 

Прямі 8 та 9 кресляться за допомогою команди XLINE, опція Offset. Відстань 

зміщення – 3 мм. Об'єкт зміщення – пряма 10. Сторони зміщення – по різні боки 

відносно об'єкта зміщення. 

Прямі 8 та 9 мають властивості шару, на якому розташовуються. 

Рекомендується перед продовженням роботи відрізати осьові лінії по межі кола 

командою TRIM (ріжучі кромки – коло; об'єкти, що обрізаються, – осьові лінії за 

межами кола). Командою ERASE стираються непотрібні лінії. 

Панель Modify:  

Меню: Modify ► Erase 

Збільшуємо праву частину креслення на екрані командою ZOOM (опція 

Window). Потрібно вказати на кресленні нижню ліву та праву верхню вершини 

обмежуючого прямокутника. Окреслена прямокутником область креслення 

збільшується до розмірів екрана. 

Виконаємо зображення паза. Оскільки межі паза обмежені колом та прямими, 

необхідно обрізати наявні графічні примітиви командою TRIM (Рис. 8.4). 
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Рис. 8.4 

Командою ERASE стираються непотрібні лінії. 

Для полегшення роботи пропонується об'єднати вихідний об'єкт у полі-лінію. 

Меню: Modify ► Object ► Polyline 

Об'єднується об'єкт за допомогою опції Join. Слід пам'ятати, що вказувати 

елементи треба послідовно. Кінці елементів повинні збігатися. 

Круговий масив створюється командою ARRAY. 

У вікні, що відкривається після запуску команди, вибирається перемикач Polar 

Array. Задається вихідний об'єкт (1) (Рис. 8.5), кут заповнення – 360°, кількість 

об'єктів – 7, вказується центр кола кругового масиву (т.2). 

 
Рис. 8.5 

Командою TRIM потрібно вирізати частини кола в пазах. Для цього вказуються 

ріжучі кромки (контур паза), а потім об'єкти, що обрізаються (частина кола в пазах). 

• Побудова пазів у лівій частині. 

Побудова здійснюється аналогічним чином (Рис. 8.6). Спочатку креслиться 

вихідний об'єкт – коло (1) (команда CIRCLE) та осьова лінія кола (2) (команда 

XLINE). Кожний об'єкт виконується у своєму шарі. 
Command: _circle 
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Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 

_from Base point: (т.З) 

<0f f set> : @17<45 (у відносних полярних координатах). 

Specify radius of circle or [Diameter] <13.4161>: 4 

Command: XLINE Specify a point or [Hor/Ver/Ang/Bisect/Offset]:a 

Enter angle of xline or [Reference]: 45 

Specify through point: (т.З) 

Specify through point: Enter 

Командою TRIM відрізаємо непотрібні відрізки лінії. 

 
Рис. 8.6 

Command: „trim 
Current settings: Projection=UCS, Edge=None 

Select cutting edges... (вказується коло 1). 

Select objects: 1 found 

Select objects: Enter 
Select object to trim or shift-select to extend or [Project/ 

Edge/Undo] : (вказуються відрізки xline за межами кола). 
Select object to trim or shift-select to extend or [Project/ 

Edge/Undo]: Enter 

Круговий масив створюється командою ARRAY. 

Вихідними об'єктами у даному випадку будуть коло (1) та його вісь (2), кут 

заповнення – 360°, кількість об'єктів – 4, центр кола кругового масиву – т. 3. 

• Побудова спряження. 

Лінія спряження кіл (Рис. 8.7) виконується командою CIRCLE, опція Ttr – 

дотична, дотична, радіус. 
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Рис. 8.7 

Command: „circle Specify center point for circle or [3P/2P/ Ttr 

(tan tan radius)]: t 

Specify point on object for first tangent of circle: точка 

приблизного дотику (1). 

Specify point on object for second tangent of circle: точка 

приблизного дотику (2). 

Specify radius Df circle <180.0000>: 180 

Непотрібні відрізки кола відрізаються командою TRIM. 

• Побудова прямих у нижній частині. 

Нижня частина деталі креслиться за допомогою команди LINE (див. Рис. 8.8). 

Для виконання побудов вмикаємо режими об'єктної прив'язки (OSNAP) та 

полярного відстеження (POLAR). На закладці Polar Tracking діалогового вікна 

Drafting Settings встановлюємо значення кроку кута рівним 30°. 

Викликаємо команду LINE. 
Command: „line 

Specify first point: (т.1). 

Specify next point or [Undo]: 78 (попередньо курсором вказується напрям 

прямої – т. 2). 

Specify next point or [Close/Undo]: (переміщуємо курсор, доки на екрані 

не з'явиться лінія вирівнювання, орієнтована під кутом 120° до горизонталі; фіксуємо 

на перетині лінії вирівнювання та осі симетрії – т. 3.) 

Specify next point or [Undo]: (переміщуємо курсор вліво та фіксуємо точку 

на перетині горизонтальної лінії вирівнювання з колом, завершуючи таким чином 

побудову ламаної лінії). 
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Specify next point or [Close/Undo]: Enter 

 
Рис. 8.8 

• Створення внутрішнього контуру. 

За допомогою команди OFFSET будуємо внутрішній контур (Рис. 8.9). 

 
Рис. 8.9 

Command: _offset 

Specify offset distance or [Through] <148.0000>: 20 

Select object to offset or <exit>: (вказується дуга 1). 

Specify point on side to offset: (вказується сторона переносу 2). 

Select object to offset or <exit>: (вказується пряма 3). 

Specify point on side to offset: (вказується сторона переносу 4). 

Select object to offset or <exit>: (вказується пряма 5). 

Specify point on side to offset: (вказується сторона переносу 4). 
Select object to offset or <exit>: Enter 
Command: offset 

Specify offset distance or [Through] <20.0000>: 18 

Select object to offset or <exit>: (вказується пряма 6). 

Select object to offset or <exit>: (вказується сторона переносу 7). 
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Select object to offset or <exit>: Enter 

• Редагування форми. 

Редагуємо форму за допомогою команд FILLET. 

Панель Modify:  

Меню: Modify ► Fillet 

Command: _fillet 

Current settings: Mode = TRIM, Radius = 0.0000 

Select first object or [Polyline/Radius/Trim/mUltiple]: r 

Specify fillet radius <0.0000>: 5 (вказується радіус спряження) 

Коли спряження одного радіусу повторюються, треба встановити опцію 
multiple. 

Select first object or [Polyline/Radius/Trim/mUltiple]: (вказується 

перша лінія для спряження). 

Select second object: (вказується друга лінія для спряження). 

Треба пам'ятати, що коли увімкнена опція Trim, кінці спряжуваних відрізків 

відрізаються (Рис. 8.10), або, коли кінці цих відрізків не перетинаються, вони 

продовжуються до спряження. 
 

 
Рис. 8.10 

• Нанесення розмірів. 

Встановлюємо поточним шар R0ZMIR. 
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Створюємо розмірні стилі (докладно пояснюється у розділі 8). Знадобиться два 

стилі, оскільки для нанесення розмірів між осьовими лініями потрібен розмірний 

стиль з подавленням виносних ліній. 

Наносимо необхідні розміри. 

Зберігаємо креслення командою SAVEAS, вказавши ім'я (kontur.dwg) та 

шлях до файлу. 

Виконуємо креслення з використанням шарів Рис. 8.11 – 16 

 
Рис. 8.11 

 
Рис. 8.12 
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Рис. 8.13 

 
Рис. 8.14 
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Рис. 8.15 

 
Рис. 8.16 
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Практичне заняття № 9 

 

Тема: Проекційне креслення 

Мета роботи: За двома виглядами деталі (Рис. 9.1) побудувати третій вигляд. 

Нанести розміри. 

 

 
Рис. 9.1 

 

Хід роботи 

Проекційне креслення вимагає виконання побудови зображень у проекційному 

зв'язку. Для того щоб забезпечити проекційний зв'язок, треба креслити всі три 

вигляди одночасно. AutoCAD дозволяє здійснювати проекційні побудови різними 

засобами. Розглянемо засіб полярного та об'єктного відстеження (трекінгу). Цей засіб 

складний, але дуже зручний при виконанні креслення у кількох проекціях. • 

Запустимо AutoCAD та розпочнемо креслення. У вікні Startup, що відкривається 

після запуску, натискаємо кнопку Use a Template (Використати шаблон). Зі списку 

шаблонів вибираємо шаблон My_template, який був створений нами у прикладі 3 і 

який містить необхідні початкові установки: поля креслення, одиниці вимірювання, 

шари, а також текстовий та два розмірні стилі. 

• Будуємо осі. 
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Встановлюємо поточним шар OSI. Виконуємо побудову осьових ліній за 

допомогою команди XLINE. 

Панель Draw:  

Меню: Draw ► Construction Line 

Command: _xline Specify a point or [Hor/Ver/Ang/Bisect/ Offset]: v 

Specify through point: – вказуємо положення вертикальної осьової лінії для 

головного вигляду та вигляду зверху. 

Specify through point: – вказуємо положення вертикальної осьової лінії для 

вигляду зліва. 
Specify through point: Enter 

Command: _xline Specify a point or [Hor/Ver/Ang/Bisect/ Offset]: h 

Specify through point: – вказуємо положення горизонтальної осьової лінії 

для вигляду зверху. 
Specify through point: Enter 

• Починаємо креслити вигляд зверху. 

Встановлюємо поточним шар K0NTUR. Креслимо кола діаметрами 78 та 46мм 

за допомогою команди CIRCLE. 

Панель Draw:  – Circle 

Меню: Draw ► Circle  
Command: „circle Specify center point for circle or [3P/2P/ Ttr 

(tan tan radius)]: – вказуємо точку перетину осей (за допомогою прив'язки). 
Specify radius of circle or [Diameter]: 39 

Command: _circle Specify center point for circle or [3P/2P/Ttr (tan 

tan radius)]: – вказуємо точку перетину осей. 
Specify radius of circle or [Diameter] <39.0000>: 23 

Виконуємо розмітку внутрішнього отвору за допомогою команди XLINE, опція 

Offset (Рис. 9.2). За допомогою цієї команди лінії виконуються у тому шарі, який 

встановлено поточним. 

Панель Draw:  

Меню: Draw ► Construction Line 

Command: _xline Specify a point or [Hor/Ver/Ang/Bisect/ Offset]: о 
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Рис. 9.2 

Specify offset distance or [Through] <Through>: 12 (потім змінюємо на 

15). 

Select a line object: – горизонтальна лінія (1). Specify side to offset: 

– вказуємо курсором довільну точку вище лінії. Select a line object: – 

горизонтальна лінія (1). Specify side to offset: – вказуємо курсором точку нижче 

лінії. Таким чином кресляться прямі 2 та 3. Command: _xline 

Specify a point or [Hor/Ver/Ang/Bisect/Offset]: о Specify offset 

distance or [Through] <Through>: 7 Select a line object: – вертикальна 

лінія (4). Specify side to offset: – вказуємо курсором вліво. Select a line 

object: – вертикальна лінія (4). Specify side to offset: – вказуємо курсором 

вправо. Таким чином кресляться прямі 5. Командою TRIM відрізаємо зайві частини 

прямих (Рис. 9.3). 

 
Рис. 9.3 

Панель Modify:  

Меню: Modify ► Trim 

Command: _trim 

Current settings: Projection=UCS, Edge=None 

Select cutting edges... 
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Select objects: – вказати ріжучі кромки. 

Select objects: Enter 

Select object to trim or shift-select to extend or [Project/ 

Edge/Undo]: – вказати об'єкти, що обрізаються. 
Select object to trim or shift-select to extend or [Project/ 

Edge/Undo]: Enter 

Командою ERASE стираємо непотрібні лінії. 

Панель Modify:  

Меню: Modify ► Erase 

Command: erase 

Select objects: вказати об'єкти, які потрібно видалити. 
Select objects : Enter 

• Починаємо креслити головний вид у проекційному зв'язку з виглядом зверху. 

Для спрощення виконання креслення вмикаємо допоміжні режими креслення 

(режими POLAR, OSNAP, OTRACK вмикаються/вимикаються кнопками, 

розміщеними у статусному рядку). Оскільки типів прив'язок багато, то слід вибрати 

тільки потрібні типи прив'язок (endpoint – кінцева точка, intersection – точка 

перетину двох об'єктів). Вмикання зайвих прив'язок тільки ускладнить відстеження. 

Змінити типи прив'язок можна, якщо вибрати кнопку 0SNAP та натиснути праву 

кнопку миші. Відкриється контекстне меню. У ньому потрібно вибрати пункт 

Settings, який відкриває діалогове вікно Drafting Settings (закладка Object Snap). Під 

час побудови прив'язки та режими іноді ускладнюють роботу, тоді їх слід вимикати, 

а потім знову вмикати за необхідністю або змінювати тип. 

За допомогою команди LINE креслиться контур основного вигляду. 

Панель Draw:  

Меню: Draw ► Line 

Command: _line Specify first point: – підводимо курсор до т. 1 й утримуємо до 

появи маркера прив'язки. Далі починаємо вести курсор вгору. З'являється тимчасова 

допоміжна нескінченна пряма – лінія вирівнювання, яка відстежує точку 1 об'єкта. 

Розміщуємо на цій прямій точку 2 (Рис. 9.4). 
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Рис. 9.4 

Specify next point or [Undo]: – відводимо від т. 2 курсор вправо і після 

появи лінії вирівнювання підводимо курсор до т. 3. Коли з'явиться маркер прив'язки, 

починаємо вести курсор вгору. Ведемо його до того часу, поки лінії вирівнювання від 

точок 2 та 3 не перетнуться в т. 4. 

Specify next point or [Undo]: ЗО (попередньо вказуємо курсором 

вертикальний напрям) – одержуємо т. 5. 

Specifv next point or [Undo]: _from Base point: ведемо курсор вліво і 

на перетині горизонтальної лінії вирівнювання та осі симетрії  

фіксуємо т. 6. 

<0ffset>: @11, 0 (отримуємо точку 7). 

Specify next point or [Close/Undo]: 10 (попередньо вказуємо напрям 

прямої до точки 8). 

Specify next point or [Close/Undo]: 22 (попередньо вказуємо напрям 

прямої до точки 9). 

Specify next point or [Close/Undo]: 10 (попередньо вказуємо напрям 

прямої до точки 10). 

Specify next point or [Close/Undo]: вказуємо напрям прямої до точки 11, 

відстежуємо т. 2 та знаходимо на перетині горизонтальної та вертикальної ліній 

вирівнювання т. 11. 

Specify next point or [Close/Undo]: c Знову запускаємо команду LINE. 

Command: _line Specify first point: відстежуємо т. 9 та  

знаходимо т. 12. 
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Specify next point or [Close/Undo]: знаходимо т. 13. 

Specify next point or [Close/Undo]: Enter 

Так само знаходимо решту прямих. 

• Виконуємо на головному вигляді розріз (Рис. 9.5). 

Command: _line Specify first point: відстежуємо т. 1 та знаходимо 

т. 2. 

Specify next point or [Undo] : опускаємо перпендикуляр на верхню 

горизонтальну пряму. 
Specify next point or [Close/Undo]: Enter 

Command: _line Specify first point: відстежуємо т. З та  

знаходимо т. 4. 

Specify next point or [Undo]: 12 (попередньо курсором показуємо напрям 

вертикально вверх). 

Specify next point or [Close/Undo]: опускаємо перпендикуляр  

на вісь. 
Specify next point or [Close/Undo]: Enter 

Command: _line Specify first point: відстежуємо т. 5 та  

знаходимо т. 6. 

Specify next point or [Close/Undo]: опускаємо перпендикуляр на пряму 

А. 
Specify next point or [Close/Undo]: Enter 

 
Рис. 9.5 
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• Переходимо до побудови вигляду зліва. Для побудови вигляду зліва треба 

побудувати сталу креслення (див. Рис. 9.6). Для розміщення сталої креслення 

рекомендується 

створити свій шар – STALA, який можна вимкнути, коли стала креслення буде 

заважати побудові креслення або буде непотрібна. 

 
Рис. 9.6 

Command: _line Specify first point: вказуємо будь-яку точку, де 

збираємося побудувати сталу креслення (т. 1). 
Specify next point or [Undo]: @150<-45 

Specify next point or [Undo]: Enter 

Переносимо пряму в точку перетину осьових. 

Панель Modify:  

Меню: Modify ► Move 

Command: _move 

Select objects: вказати пряму 

Specify base point or displacement: вказати за допомогою прив'язки 

середину прямої. 
Specify second point of displacement or <use first point as 

displacements відстежуємо т. 2, т. З та знаходимо перетин осьових в т. 4. 

Починаємо побудову вигляду зліва з побудови зовнішнього контуру (Рис. 9.7). 



 71 

 
Рис. 9.7 

Перед початком побудови треба перевірити прив'язки. У нашому випадку 

знадобляться прив'язки Endpoint, Quadrant та Intersection. Для побудови 

контуру використаємо команду POLYLINE. Доцільність такого рішення буде 

зрозуміла пізніше. 

Панель Draw:  

Меню: Draw ► Polyline 

Command: _pline Specify start point: відстежуємо праву нижню точку головного 

вигляду та фіксуємо на вертикальній осі т. 1. 
Current line-width is 0.0000 

Specify next point or [Arc/Close/Halfwidth/Length/Undo/ Width]: відстежуємо т. 2 

горизонтальною лінією вирівнювання у напрямі сталої креслення (див. Рис. 9.7, а). З 

клавіатури вводимо tt або іншим чином (з меню чи панелі інструментів) вказуємо 

прив'язку Temporary Tracking Point (тимчасова точка відстеження). Коли курсор 

досягне сталої креслення у тимчасовій точці 3 (стрілка 1) та з'явиться маркер у вигляді 

маленького хрестика, натискаємо ліву кнопку миші. Лінія вирівнювання змінює 

напрям на вертикальний. Повертаємося курсором у т. 1 і починаємо переміщувати 

його вправо. З'являється горизонтальна лінія вирівнювання від т. 1 (стрілка 2). На 

перетині цієї лінії та отриманої раніше вертикальної лінії від т. З фіксуємо т. 4. 

Specify next point or [Arc/Close/Halfwidth/Length/Undo/ Width] : відстежуємо т. 4 

(стрілка 3) та т. 6 (стрілка 4) і на перетині двох ліній вирівнювання знаходимо т. 5 

(див. Рис. 9.7, б). 
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Specify next point or [Arc/Close/Halfwidth/Length/Undo/ Width ]: відстежуємо т. 5 

та т. 8 (т.8 відстежуємо аналогічно до т. 2, ламану лінію вирівнювання показано 

стрілками 5) і знаходимо т. 7 (див. Рис. 9.7, в). 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/ Width ] : 

знаходимо т. 10 (для цього відстежуємо т. 7 та т. 9). 

Specify next point or [Arc/Close/Halfwidth/Length/Undo/ Width] : на перетині 

горизонтальної лінії вирівнювання від т. 10 та осі закінчуємо побудову. 

Побудувавши половину зображення зовнішнього контуру, віддзеркалимо його 

за допомогою команди MIRROR (Рис. 9.8). 

 
Рис.7.8 

Панель Modify:  

Меню: Modify ► Mirror 

Command: _mirror Select oPjects: Вибираємо побудований контур (оскільки 

контур будувався командою POLYLINE, то він сприймається як один об'єкт). Select 

objects : Enter Specify first point of mirror line: вказати т. 1. 

Specify second point of mirror line: вказати т. 2. 

Delete source objects? [Yes/No] <N>: N (треба об'єкт віддзеркалювання зберегти). 

Побудова ліній внутрішнього контуру в частині, де буде зображено розріз, 

здійснюється аналогічно до побудови зовнішнього контуру, тобто відсте-жуючи 

відповідні точки на головному вигляді та вигляді зверху. 

Вимикаємо шар STALA, на якому знаходиться допоміжна побудова. 

Створюємо та встановлюємо поточним шар SHTRYHOVKA. 

Виконуємо штриховку на зображенні розрізу (Рис. 9.9) за допомогою команди 

В HATCH. 
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Рис. 9.9 

Панель Draw:  

Меню: Draw ► Hatch 

Після виклику команди відкривається діалогове вікно Boundary Hatch and Rll. 

Вибираємо закладку Hatch. Зі списку Туре вибираємо пункт User defined. 

Встановлюємо наступні значення параметрів: Angle –45, Spacing – 3. Натискаємо 

кнопку Pick Points та вказуємо внутрішні точки 1 і 2. Будьте уважні, бо якщо контур 

незамкнений, штрихування не відбудеться. 

• Нанесення розмірів. 

Встановлюємо поточним шар R0ZMIR. 

Для нанесення розмірів відповідно до Рис. 9.10 знадобляться два стилі: 

- з двома виносними лініями; 

- з подавленими лівою виносною лінією та відповідною частиною розмірної 

лінії. 

У шаблоні, який використали, такі стилі вже створені (докладно створення 

розмірних стилів пояснюється у розділі 8). 

Наносимо розміри (Рис. 9.10). 
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Рис. 9.10 

• Оформлення креслення. 

Для оформлення креслення деталі відкриємо креслення основного напису 

ramka.dwg. 

Зробимо основний напис блоком з атрибутами. 

Для створення атрибутів використовується команда ATTDEF. 

Меню: Draw ► Block ► Define Attributs 

Командний рядок: attdef 

Відкривається діалогове вікно Attribute Definition, де задаються режим вставки 

та відображення атрибута, його ім'я, підказка та значення за умовчанням, а також 

точка вставки та параметри тексту (Рис. 9.11). 

 
Рис. 9.11 

Викликаємо команду ATTDEF необхідну кількість разів та створюємо атрибути 

з назвами: позначення; наз_креслення; матеріал; масштаб; розробник; затвердив (Рис. 

9.12). 

 
Рис. 9.12 
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Викликаємо команду BLOCK, яка відкриває діалогове вікно Block Definition 

(Рис. 9.13). 

 
Рис. 9.13 

Панель Draw:  

Меню: Draw ► Block ► Make 

Командний рядок: block 

Вибираємо об'єкти разом з іменами атрибутів. За базову точку беремо нижній 

правий кут. 

Даємо назву блоку – Основний напис. 

Перенесення блоку здійснимо за допомогою модуля AutoCAD Design Center. 

Для виклику модуля призначена команда ADCENTER. 

Панель Standard:  

Меню: Tools ► Design Center 

Командний рядок: adcenter 

Після виклику команди відкривається вікно модуля.У лівій частині вікна (Tree 

view) знаходимо креслення основного напису, розкриваємо його вміст та вибираємо 

елемент Blocks. У правій частині (Content area) вибираємо блок та викликаємо 
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контекстне меню. Пункт Insert Block цього меню відкриває діалогове вікно Insert 

(див. Рис. 9.14), яке надає засоби для керування вставкою блоку. Детально елементи 

вікна insert описані в розділі 9. 

 
Рис. 9.14 

Після задання параметрів вставки блоку і закриття вікна AutoCAD відобразить 

запити на значення атрибутів. Відповідні дані потрібно ввести в командний рядок. 

Зазначимо, що вставити блок можна також, перетягнувши його мишею з області 

Content area в область поточного креслення. У такому разі значення атрибутів 

вказуються у вікні Edit Attributes (Рис. 9.15), яке відображається відразу ж після 

перетягування блоку. 

 
Рис.7.15 

Якщо потрібно, відредагуйте креслення таким чином, щоб воно 

розташовувалось посередині аркуша (Рис. 9.16). 
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Рис. 9.16 

Для збереження креслення використовуємо команду SAVEAS, вказавши ім'я та 

шлях до файлу. 

Командою CLOSE закриваємо креслення або закриваємо креслення та 

одночасно завершуємо роботу AutoCAD (команди QUIT та EXIT). 
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За двома виглядами побудувати третій Рис. 9.17 – 22. При побудові 

застосовувати полярне та об'єктне відстеження. Нанести розміри. 

                 
Рис. 9.17        Рис. 9.18 

        
Рис. 9.19       Рис. 9.20 
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Рис. 9.21      Рис. 9.22 
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Практичне заняття №10 

 

Тема: створення документа нової деталі і моделі шайби 

Мета роботи: набути навиків у створенні нових документів у SolidWorks 2005 

та моделей деталей типу шайба. 

 

Хід роботи 

Створення документа нової деталі 

Для запуску програми натисніть кнопку Start (Пуск) панелі завдань Windows. 

Виберіть Programs», Solidworks2005», Solidworks2005. З'явиться головне вікно 

SolidWorks 2005. 

Іноді при запуску програми автоматично відбувається пересилання на адресу 

SolidWorks Corporation log-файлу виконуваних вами робіт. Щоб виключити цю 

подію, виберіть Tools, Options..., System Options, General (Інструменти, 

Параметри..., Системні налаштування, Загальні) і відключіть параметр Enable 

performance email (Надіслати інформацію про ефективність програми електронною 

поштою), установлений за замовчуванням.  

1. Створіть новий документ деталі, виконавши одну з таких дій: 

• натисніть кнопку New (Новий) панелі інструментів Standard (Стандартна); 

• виберіть команду File, New (Файл, Новий) з головного меню; 

• натисніть Ctrl+N. 

З'явиться діалогове вікно New SolidWorks Document (Новий документ 

SolidWorks). Можна вибрати один з варіантів діалогового вікна: для новачків (Novice) 

або для досвідчених користувачів (Advanced) (Рис. 2.1). Останнє вікно містить дві 

вкладки: Templates (Шаблони) і Tutorial (Навчальний посібник). На вкладці 

Templates (Шаблони), відкритої за замовчуванням, представлено три шаблони, Part 

(Деталь), Assembly (Збірка) і Drawing (Креслення). У вікні Preview: (Попередній 

перегляд:) відображається обраний шаблон (якщо він є). 

У вікно можна додавати вкладки із знову створеними шаблонами. 
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Ви можете вибрати форму подання шаблонів у діалоговому вікні. Можливі такі 

опції: 

Large Icons (Великі значки). Подання у вигляді великих значків;  

List (Список). Подання у вигляді дрібних значків; 

List Details (Властивості). Подання в текстовому виді, включаючи інформацію 

про розмір і дату створення. 

2. Виберіть значок Part (Деталь) вкладки Templates (Шаблони) діалогового 

вікна New SolidWorks Document (Новий документ SolidWorks) і натисніть OK. 

3. З'явиться вікно нової деталі (Рис. 2.2).  

Для збільшення робочої області згорніть вікно емулятора командного рядка 

шляхом скасування виділення параметра View, 2D Command Emulator (Вид, 

Емулятор командного рядка) з головного меню. 

Рис. 10.1 Діалогове вікно New SolidWorks 

Document (Новий документ SolidWorks) 
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Налаштування документа 

Перед початком роботи необхідно виконати налаштування робочого столу 

параметрів документа: панелей інструментів, масштабної сітки, шрифту розмірів, 

налаштування гарячих клавіш і так далі. 

Для налаштування виконайте такі дії: 

1. Виберіть View, Toolbars, Customize... (Вид, Панелі інструментів, 

Налаштування...) з головного меню або клацніть правою кнопкою миші по області 

головного меню або панелей інструментів і виберіть Customize... (Налаштування...) з 

контекстного меню. 

За допомогою діалогового вікна Customize... (Налаштування...) можна керувати 

видимістю панелей інструментів (вкладка Toolbars (Панелі інструментів)); змістом 

активних панелей інструментів (вкладка Commands (Команди)); налаштувати меню 

(вкладка Menus (Меню)); створювати гарячі клавіші, тобто присвоювати командам 

комбінації клавіш клавіатури (вкладка Keyboard (Клавіатура)) і редагувати 

налаштування меню й гарячих клавіш (вкладка Options (Параметри)) (Рис. 2.3).  

Рис. 10.2 Робоче вікно документа нової деталі 



 83 

 
2. У вкладці Toolbars (Панелі інструментів) діалогового вікна Customize 

(Налаштування) виберіть параметри Enable Command Manager (Ввімкнути 

диспетчер команд), Show tooltips (Відобразити спливаючі підказки) і Use large 

tooltips (Використовувати великі підказки), виберіть панелі інструментів (якщо вони 

ще не обрані): 

• Standard (Стандартна); 

• Standard Views (Стандартні види); 

• View (Вид) 

і натисніть OK. 

3. У вкладці Commands (Команди) діалогового вікна Customize 

(Налаштування) виберіть зі списку панелі інструментів Sketch (Ескіз) (Рис. 2.4) 

Рис. 10.3 Діалогове вікно Customize, Toolbars 

(Настроювання, Панелі інструментів) 
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4. Перетягніть значок Text (Текст) на панель інструментів Sketch (Ескіз). 

5. У вкладці Keyboard (Клавіатура) діалогового вікна Customize 

(Налаштування) виберіть Tools (Інструменти) зі списку Categories (Категорії) і 

Relations, Add... (Взаємозв'язки, Додати...) зі списку Commands (Команди) (Рис. 2.5).  

6. Перейдіть у поле Press new shortcut key (Натисніть нову гарячу клавішу). 

7. Натисніть клавіші Shift+R, а потім Assign (Приписати) і OK . Комбінація 

клавіш з'явилася у вікні Current keys (Поточні сполучення клавіш). Тепер під час 

роботи вам досить натиснути Shift+R, щоб вибрати інструмент Add Relations 

(Додати взаємозв'язки). 

8. Виберіть Tools, Options..., Document Properties, Detailing (Інструменти, 

Параметри..., Властивості документа, Оформлення) з головного меню. 

9. Виберіть стандарт проектування ISO (або GOST (ДЕРЖСТАНДАРТ)) зі 

списку, що розкривається, Dimensioning standard (Креслярський стандарт). 

Рис. 10.4 Діалогове вікно Customize, Commands 
(Налаштування, Команди) 
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10. Виберіть Tools, Options..., Document Properties, Units (Інструменти, 

Параметри..., Властивості документа, Одиниці вимірювань) з головного меню. 

11. Виберіть Millimeters (Міліметри) зі списку, що розкривається, 

 Length units (Одиниці довжини). 

12. Введіть цифру 2 у поле Decimal Places (Десяткові розряди). 

13. Натисніть кнопку Grid/Snap (Масштабна сітка/Прив'язка) панелі 

 інструментів Sketch (Ескіз) або виберіть Tools, Options..., Document properties, 

Grid/Snap (Інструменти, Параметри..., Властивості документа, Сітка/Прив'язка) з 

головного меню. 

14. Виберіть параметри Display grid (Відобразити сітку), Dash (Пунктиром), 

Automatic scaling (Автоматичне масштабування) у групі Grid (Сітка), задайте: 

• Major grid spacing: (Крок між основними лініями сітки:) – 10 мм;  

• Minor-lines per major: (Число допоміжних інтервалів між головними лініями:) 

– 10; 

• Snap points per minor: (Число точок прив'язки між лініями решітки:) – 1, 

і натисніть OK. 

Рис. 10.5 Діалогове вікно Customize, Keyboard 

(Налаштування, Клавіатура) 
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15. Виберіть Tools, Options..., System Options, Colors (Інструменти, 

Параметри..., Налаштування користувача, Кольори) з головного меню, задайте в групі 

System colors: (Системні кольори:): 

• Viewport Background (Тло графічного вікна) – білий, і натисніть OK. (Рис. 

2.6). 

 
Відображення сітки управляється параметром Display grid (Відобразити сітку). 

Щоб зняти сітку досить скасувати вибір цього параметра. 

16. Виберіть Tools, Options..., System Options, General (Інструменти, 

Параметри..., Налаштування користувача, Загальні) з головного меню. 

17. Скасуєте вибір параметрів Use English language menus (Використавши 

меню англійською мовою) і Use English language feature and file names 

(Використовувати англійські імена файлів і документів), якщо ви хочете відображати 

команди меню та інструментів альтернативною мовою, що вибрали під час 

встановлення програми. 

Виберіть Tools, Options..., System Options, Drawings, Display Style 

(Інструменти, Параметри..., Налаштування користувача, Креслення, Тип 

відображення за замовчуванням) з головного меню. 

Рис. 10.6 Графічне вікно програми SolidWorks2005. 
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18. Виберіть параметри Hidden lines removed (Видалити невидимі лінії) 

 у групі Display style for new views (За замовчуванням відобразити кромки 

 в нових креслярських видах) і High quality (Висока якість) у групі 

 Display quality for new views (Якість відображення для нових видів). 

19. Виберіть Tools, Options..., System Options, Sketch (Інструменти, 

Параметри..., Налаштування користувача, Ескіз) з головного меню. 

20. Виберіть параметр Display entity points in part/assemblies sketches 

(Відобразити точки елемента в ескізах деталей збірки) і натисніть OK. 

Виконавши мінімально необхідні налаштування, ми можемо перейти 

безпосередньо до моделювання деталей. 

 

Створення моделі шайби 

Процес моделювання в SolidWorks схожий на послідовність дій створення деталей 

з використанням різних інструментів і верстатів. Уявіть собі, як би ви створювали 

деталь у житті, і постарайтеся скласти послідовність виконуваних дій (наприклад, 

узяти пруток, відрізати, зняти фаску, просвердлити отвір, нарізати різьблення, 

вибрати фрезою паз, і так далі). Таким чином, ви одержите так зване дерево проекту 

(design tree), виконання якого і приведе до створення необхідної моделі. 

У цьому розділі ми створимо модель шайби під гвинт М4 з такими розмірами: 

■ діаметр шайби – 8.20 мм; 

■ товщина шайби – 0.80 мм; 

■ діаметр отвору – 4.20 мм. 

Для роботи нам знадобляться такі панелі інструментів: 

 Dimensions/Relations (Розміри/Взаємозв'язки); 

 Features (Елементи); 

 Sketch (Ескіз); 

 Standard View (Стандартні види); 

 View (Вид). 

У процесі роботи ми познайомимося з тим, як: 

■ Переходити в режим Sketch (Ескіз); 
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■ Використовувати об'єкт ескізу  Circle (Коло); 

■ Використовувати інструмент ескізу  Offset Entities (Зсув елементів); 

■ Використовувати конструктивний елемент  Extruded Boss/Base (Витягнутий 

виступ/основа) 

■ Наносити і редагувати розміри; 

■ Давати імена розмірам, ескізам і елементам. 

Спочатку ми намалюємо ескіз проекції шайби на горизонтальну площину, а потім 

витягнемо проекцію у тривимірну модель. 

 

Контурний ескіз шайби 

1. Виберіть площину Top Plane (Зверху) у дереві проекту Feature Manager 

(Диспетчера конструктивних елементів). 

2. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз) чи 

виберіть Insert, Sketch (Вставка, Ескіз) з головного меню, щоб перейти в режим 

малювання ескізу. Ескіз відкриється на обраній площини. 

Панель інструментів Sketch (Ескіз) має інструменти для вибору, створення і 

зміни ескізу, а також керування масштабною сіткою. Панель включає сорок 

один інструмент. 

3. Натисніть кнопку  Normal To (Перпендикулярно обраної площини) панелі 

інструментів Standard Views (Стандартні види) чи виберіть View, Orientation 

(Вид, Орієнтація) з головного меню і Normal То (Перпендикулярно обраній 

площини) з контекстного меню. 

Команда View, Orientation (Вид, Орієнтація) дублюється клавішею Spacebar 

(Пробіл). 

Панель інструментві  Standard Views (Стандартні види) пропонує  

інструменти для представлення ескізу, чи моделі збірки в будь-якому 

стандартному виді. Панель включає десять інструментів. 

Якщо площина не була обрана заздалегідь, то після натискання кнопки 

Sketch (Ескіз), з'являється діалогове вікно вибору площини. Таким чином, 
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операція вибору площини і команда Normal To (Перпендикулярно обраної 

площини) виконуються автоматично. 

4. Натисніть кнопку  Circle (Коло) панелі інструментів  Sketch (Ескіз) чи 

виберіть Tools, Sketch Entities, Circle (Інструменти, Об’єкти ескізу, Коло) з 

головного меню. Форма курсору зі стрілки зміниться на . 

5. Наведіть курсор на вихідну точку ( ) і, як тільки форма курсору зміниться на

, клацніть лівою кнопкою миші. Перемістіть курсор на деяку відстань від 

вихідної точки ( ) і клацніть ще раз. Зверніть увагу на напис, розташований 

вище і правіше курсору (рис.1.7). Він показує радіус кола в процесі малювання. 

 
У SolidWorks можливе використання двох стилів малювання: клацнути- 

потягнути чи клацнути-клацнути. Можна натиснути на ліву кнопку миші і, 

утримуючи її в натиснутому стані, переміщати курсор миші. Коло буде 

намальована при відпусканні кнопки. У противному випадку необхідно двічі 

клацнути лівою кнопкою миші в центрі кола і на точці кола. 

По завершенні малювання коло має зелений колір, що вказує на те, що воно 

знаходиться в режимі виділення. 

У SolidWorks за допомогою кольору відображається поточний стан 

відображення ескізу. За замовчуванням використовуються такі кольори: 

–  чорний колір – цілком визначений ескіз 

–  синій колір – не повністю визначений ескіз 

–  червоний колір – перевизначений ескіз 

–  зелений колір – ескіз у режимі редагування 

Рис. 10.7 Послідовність операцій при малюванні окружності 
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Завершенням роботи з ескізом вважається набуття ним чорного кольору. 

Тільки в цьому випадку можна переходити до наступного етапу. 

6. Натисніть Esc. Колір окружності зміниться з зеленого на синій. 

Для того щоб у наступному даний ескіз можна було використовувати для створення 

моделі, він повинен бути цілком визначений. Це значить, що повинні бути однозначно 

задані його розміри і положення в просторі щодо вихідної точки. Для визначення 

елементів ескізу використовуються Інструменти  Dimension (Розмір) і  Add 

Relation (Додати взаємозв'язок) панелі інструментів  Dimensions/Relations 

(Розміри/Взаємозв'язки). 

Панель інструментів  Dimensions/Relations (Розміри/Взаємозв'язку) 

призначена для нанесення розмірів і визначення об'єктів ескізу. Панель включає 

тринадцять інструментів. 

 

Задання зовнішнього розміру шайби 

7. Щоб задати розмір окружності, натисніть кнопку  Smart Dimension 

(Розмір) панелі інструментів  Dimensions/Relations 

(Розміри/взаємозв’язки) чи виберіть Tools, Dimensions, Smart (Інструменти, 

Розміри, Авто) з головного меню. Форма курсору зі стрілки  зміниться на . 

8. Наведіть його на коло і, як тільки коло забарвиться в червоний колір, клацніть 

лівою кнопкою миші. З'явиться попередній вид розташування розмірних 

ліній. Виберіть зручний вид представлення розміру (Рис. 2.8). 

 

Рис. 10.8 Варіанти нанесення розміру при виборі команди Tools, Dimensions, 

Smart (Інструменти, Розміри, Авто) 
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9. Клацніть лівою кнопкою миші ще раз. З'явиться діалогове вікно Modify 

(Змінити) (Рис. 2.9). 

 
У вікні можна ввести значення розміру чи вибрати його прокручуванням стрілок 

вгору/униз, розташованих праворуч від вікна введення. Під вікном введення 

розміщено чотири кнопки, що керують розміром: 

 Save the current value and exit the dialog (Зберегти поточне значення і вийти з 

діалогового вікна). 

 Restore the original value and exit the dialog (Відновити вихідне значення і 

вийти з діалогового вікна). 

 Regenerate the model with the current value (Регенерувати модель з 

урахуванням поточного значення). 

 Reset spin increment value (Визначити величину приросту розміру). 

 Mark dimension to be imported into a drawing (Позначити розмір для 

імпортування в креслення). 

10. Введіть із клавіатури значення 8.20 і натисніть кнопку . Розмір з’явиться в 

обраному вами місці. 

11. Натисніть клавішу F, кнопку Zoom to Fit (Змінити в розмір екрана) панелі 

інструментів View (Вид) чи виберіть View, Modify, Zoom to Fit (Вид, Змінити, 

Змінити в розмір екрана) з головного меню. 

Якщо розмір цифр занадто великий, виберіть Tools, Options..., Document 

Properties, Annotations Font, Dimension (Інструменти, Параметри..., Властивості 

документа, Шрифт приміток, Розмір) з головного меню. З'явиться діалогове вікно 

Choose Font (Вибрати шрифт), у якому вкажіть необхідні параметри шрифту. Цей 

шрифт буде використовуватися всіма розмірами поточного документа (Рис. 2.10). 

Рис. 10.9 Діалогове вікно Modify 

(Змінити) установки розміру 
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Ескіз отвору в шайбі 

12. Натисніть кнопку  Offset Entities (Зсув об'єктів) панелі інструментів  

Sketch (Ескіз) чи виберіть Tools, Sketch Tools, Offset Entities (Інструменти, 

Інструменти ескізу, Зсув об'єктів...) з головного меню. 

13. Наведіть курсор на коло і, як тільки коло пофарбується в червоний колір, 

клацніть лівою кнопкою миші (Рис. 2.11). 

14. У Диспетчері властивостей Offset Entities (Зсув об'єктів) виберіть параметри 

Reverse (Реверс) і Select chain (Вибрати ланцюжок), задайте: 

Offset Distance (Відстань зсуву) – 2.00 мм, і натисніть ОК.  

15. Натисніть Esc, щоб закрити Диспетчер властивостей Dimension (Розмір). 

 
 

Рис. 10.10 Діалогове вікно Choose Font (Вибрати шрифт) 

установки параметрів шрифту розміру 

Рис. 10.11 Послідовність операцій при використанні інструмента Offset Entities 

(Зсув об'єктів) 



 93 
Іменування розмірів 

Щоб у процесі роботи не виникало плутанини з безіменними розмірами, 

ескізами й елементами, необхідно в міру створення давати їм відповідні імена. Для 

цього необхідно виконати наступні дії. 

16. Наведіть курсор на зовнішній розмір шайби. Форма курсору зміниться і 

поруч з ним з'явиться підказка у виді D1@Sketsh1. Тут D1 ім'я поточного 

розміру, a Sketch1 – ім'я поточного ескізу. У Диспетчері властивостей 

Dimension (Розмір) виберіть More Properties... (Інші властивості...) чи 

клацніть правою кнопкою миші і виберіть Properties…(Властивості) з 

контекстного меню. З'явиться діалогове вікно Dimension Properties 

(Властивості розміру) (Рис. 2.12). 

17. У поле Name: (Ім'я:) діалогового вікна Dimension Properties (Властивості 

розміру) введіть ім'я «Зовнішній діаметр», і натисніть Apply (Застосувати), а 

потім ОК. 

18. Повторіть ці дії для розміру зсуву. У поле Name: (Ім'я:) введіть ім'я 

«Ширина шайби».  
 

Ви можете замінити розмір ширини шайби на внутрішній діаметр. Для цього 

виділіть діаметр зсуву і натисніть клавішу Del (Видалити). На екрані з'явиться 

повідомлення, що попереджає вас про те, що видалення розміру приведе до видалення 

з ескізу зв'язаних зі зсувом взаємозв'язків. Натисніть Yes (Так). Розмір зсуву зникне, 

а колір внутрішньої окружності зміниться з чорного на синій. Натисніть кнопку 

Smart Dimension (Розмір) панелі інструментів Dimensions/Relations 

(Розміри/Взаємозв'язку) і клацніть по внутрішній окружності. З'явиться розмір 4.20 

мм, рівний різниці розмірів діаметра шайби і її ширини. Змініть в діалоговому вікні 

Dimension Properties (Властивості розміру) ім'я розміру «Ширина шайби» на 

«Внутрішній діаметр». 
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19. Клацніть по імені Sketch1 (Ескіз1) у дереві проекту FeatureManager 

(Диспетчера конструктивних елементів) і натисніть клавішу F2. 

20. Введіть ім'я ескізу «Ескіз шайби» і натисніть ESC. Тепер при наведенні на 

зовнішній розмір шайби підказка буде мати вигляд [Зовнішній діаметр Ескіз 

шайби]. 

21. Натисніть клавішу F, кнопку Zoom to Fit (Змінити в розмір екрана) панелі 

інструментів View (Вид) чи виберіть View, Modify, Zoom to Fit (Вид, Змінити, 

У розмір екрана) з головного меню (Рис. 10.13). 

Рис. 10.12 Діалогове вікно Dimension Properties (Властивості 
розміру) 
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Ви можете змінити шрифт окремого розміру. Для цього клацніть по розмірі, 

відкрийте діалогове вікно Dimension Properties (Властивості розміру), і в групі Font 

(Шрифт) скасуйте параметр Use document's font (Використовувати шрифт 

документа). Натисніть Font... (Шрифт...) і в діалоговому вікні Choose Font (Вибір 

шрифту) встановіть параметри шрифту даного розміру. 

22. Натисніть кнопку  Sketch (Ескіз) панелі інструментів Sketch (Ескіз) чи 

виберіть Insert, Sketch (Вставка, Ескіз) з головного меню, щоб закрити ескіз. 

Також ескіз можна закрити за допомогою Confirmation corner (Кута 

підтверждения), що розташований у правому верхньому куті графічної області. 

Видимість куточка підтвердження задається параметром Tools, Options..., System 

Options, General, Enable Confirmation Corner (Інструменти, Параметри..., 

Настроювання користувача, Загальні, Включити Кут підтвердження). 

Створення тривимірної моделі шайби 
Перетворимо проекцію шайби на площину в тривимірну модель. Для цього 

виконаємо такі дії. 

23. Натисніть кнопку Isometric  (Ізометрія) панелі інструментів Standard View 

 (Стандартні види) чи натисніть клавішу Backspace (Пробіл) і виберіть 

Isometric (Ізометрія) з контекстного меню. 

Рис. 10.13 Цілком визначений ескіз шайби 
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24. Клацніть по значку ( розташованому лівіше напису «Ескіз шайби» у дереві 

проекту FeatureManager (Диспетчера конструктивних елементів). 

25. Натисніть кнопку Extruded Boss/Base (Витягнутий виступ/основа) панелі 

інструментів Features (Елементи) чи виберіть Insert, Boss/Base, Extrude... 

(Вставка, Виступ/Основа, Витягнути...) з головного меню. 

Панель інструментів Features (Елементи) має інструменти для створення 

конструктивних елементів моделі. Панель включає сорок чотири інструменти. 

26.  У Диспетчері властивостей Extrude (Витягнути) задайте: 

 Direction (Напрямок) – Blind (На задану відстань); 

 Depth (Глибина) – 0.80 мм, і натисніть  ОК. 

У графічній області буде показаний попередній вид елемента і напрямок 

витягування (Рис. 10.14). 

 
27. Натисніть клавішу F чи виберіть View, Modify, Zoom to Fit (Вид, Замінити, У 

розмір екрана) з головного меню. 

28. Клацніть по назві Extrude1, натисніть F2 і введіть ім'я «Шайба». 

29. Натисніть кнопку  Save (Зберегти), чи виберіть File, Save (Файл, Зберегти), 

чи натисніть Ctrl+S. У діалоговому вікні Save As (Зберегти як) виберіть папку 

для збереження файлів документів (наприклад, SolidWorks 2005), у поле File 

name: (Ім'я файла.) уведіть текст «Шайба», а в поле Description: (Опис:) текст 

«Шайба М4х0.8», і натисніть Save (Зберегти) (Рис. 10.15) 

Рис. 10.14 Формування шайби з ескізу 



 97 

 
30. Ми створили модель шайби і зберегли її під ім'ям «Шайбa.sldprt» (Рис. 10.16). 

 
  

Рис. 10.15 Діалогове вікно збереження документа 

Рис. 10.16 Тривимірна модель шайби. 
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Практичне заняття №11 

 

Тема: створення моделі гровера 

Мета роботи: Набути навиків у створенні моделей деталей типу гровер 

 

Хід роботи 

Гровер являє собою розрізну шайбу, що призначена для запобігання 

мимовільного розкручування гайки. 

Створимо модель гровера під гвинт М4 з такими розмірами: 

■ діаметр гровера - 5.20 мм; 

■ діаметр отвору - 4.20 мм; 

■ товщина гровера - 1.00 мм; 

■ зсув між торцевими поверхнями гровера – 1.00 мм. 

Для роботи нам знадобляться такі панелі інструментів: 

Curves (Криві); 

Dimensions/Relations (Розміри/Взаємозв'язку); 

Features (Елементи); 

Sketch (Ескіз); 

Standard View (Стандартні види); 

View  (Вид). 

У процесі роботи ми познайомимося з тим, як: 

■ Використати об'єкт ескізу  Polygon (Багатокутник); 

■ Використати інструмент  Неliх and Spiral (Спіраль); 

■ Використати елемент  Swept Boss/Base (Виступ/основа по траєкторії); 

■ Додавати в ескіз взаємозв'язки. 

У процесі створення моделі гровера ми намалюємо ескіз проекції осьової лінії 

гровера на площину, потім перетин гровера, задамо зсув між початковою й кінцевою 

точками спіралі й, у підсумку, створимо модель гровера. 

 

Ескіз траєкторії гровера 
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1. Створіть новий документ деталі. 

2. Натисніть Ctrl+S і збережете модель під ім'ям Гровер.sldprt. 

3. Виберіть площину Top Plane (Зверху). 

4. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз) або 

виберіть Insert, Sketch (Вставка, Ескіз) з головного меню, щоб відкрити ескіз. 

5. Натисніть кнопку  Circle (Коло) панелі інструментів  Sketch . (Ескіз) або 

виберіть Tools, Sketch Entities, Circle (Інструменти, Об’єкти ескізу, Коло) з 

головного меню. 

6. Намалюйте коло довільного діаметра із прив'язкою центра кола до вихідної 

точки. 

Прив'язати центр окружності до вихідної точки можна за допомогою 

введення відповідного взаємозв'язку. При натиснутій клавіші Ctrl виберіть центр 

окружності й вихідну точку. У групі Add Relations (Додати взаємозв'язку) 

Диспетчера властивостей Properties (Властивості) виберіть параметр  

Coincident (Збіг). 

7. Натисніть кнопку  Smart Dimension (Розмір) панелі інструментів  

Dimensions/Relations (Розміри/Взаємозв'язку) або виберіть Tools, Dimensions, 

Smart (Інструменти, Розміри, Авто) з головного меню. 

8. Задайте розмір окружності в 4.70 мм. 

9. Натисніть клавішу F, щоб змінити вид окружності в розмір екрана (Рис. 101.1). 

10. Привласніть розміру й ескізу імена «Діаметр» і «Траєкторія», відповідно. 

11. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз) або 

виберіть Insert, Sketch (Вставка, Ескіз) з головного меню, щоб закрити ескіз. 
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Ескіз перетину гровера 

12. Натисніть кнопку  Isometric (Ізометрія) панелі інструментів  Standard 

Views (Стандартні види). 

13. Виберіть площину Right Plane (Праворуч). 

14. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз) або 

виберіть Insert, Sketch (Вставка, Ескіз) з головного меню, щоб відкрити ескіз. 

15. Натисніть кнопку  Polygon (Багатокутник) панелі інструментів  Sketch 

(Ескіз) або виберіть Tools, Sketch Entity, Polygon (Інструменти, Об'єкти 

ескізу, Багатокутник) з головного меню. 

16. У Диспетчері властивостей Polygon (Багатокутник), у групі Parameters 

(Параметри) виберіть параметр Inscribed circle (Уписана коло), задайте: 

Number of Sides (Кількість сторін) – 4. 

17. Наведіть курсор на край лінії й розтягніть багатокутник (Рис. 101.2). 

18. У Диспетчері властивостей Polygon (Багатокутник), у групі Paramete 

(Параметри), задайте: 

 Center X Coordinate (Абсциса центра) – 2.35; 

 Center Y Coordinate (Ордината центра) – 0.00; 

 Circle Diameter (Діаметр окружності) – 1.00 мм; 

 Angle (Кут) – 45.00 градусів, і натисніть  ОК. 

Рис. 11.1 Ескіз траєкторії гровера 
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19. Натисніть кнопку  Add Relation (Додати взаємозв'язок) панелі інструментів 

 Dimensions/Relations (Розміри/Взаємозв'язку) або виберіть Tools, 

Relations, Add... (Інструменти, Взаємозв'язки, Додати...) з головного меню. 

20. Виберіть центр кола й проекцію кола. Вони з'являться у вікні Select Entities 

(Вибрати об'єкти) Диспетчера властивостей Add Relations (Додати 

взаємозв'язку). 

21. У групі Add Relations (Додати взаємозв'язку) виберіть Pierce (Точка 

проникання) і натисніть  ОК. Центр квадрата буде прив'язаний до кола. 

22. Натисніть кнопку  Smart Dimension (Розмір) панелі інструментів  

Dimensions/Relations (Розміри/Взаємозв'язку) або виберіть Tools, Dimensions, 

Smart (Інструменти, Розміри, Авто) з головного меню. 

23. Задайте діаметр уписаного кола в 1.00 мм і привласніть йому ім'я «Перетин 

гровера». 

24. Привласніть ескізу ім'я «Перетин». 

25. Натисніть кнопку Sketch (Ескіз) панелі інструментів  Sketch (Ескіз) або 

виберіть Insert, Sketch (Вставка, Ескіз) з головного меню, щоб закрити ескіз. 

26. Натисніть клавішу F, щоб змінити вид окружності в розмір екрана. 

 

Перетворення окружності в спіраль 

27. Виберіть коло і натисніть кнопку Helix and Spiral (Спіраль) 

панелі інструментів  Curves (Криві), або виберіть Insert, Curve, 

Helix/Spiral... (Вставка, Крива, Спіраль/Плоска спіраль...) з головного меню. 

Панель інструментів  Curves (Криві) має інструменти для створення й 

використання кривих. Панель включає шість інструментів. 

Рис. 11.2 Створення ескізу перетину гровера 
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28. У діалоговому вікні Helix/Spiral (Спіраль/Плоска спіраль) виберіть параметр 

напрямку Clockwise (По годинній стрілці), задайте (Рис. 101.3): 

• Defined by: Height and Revolution (Визначити по: Висоті й повороту); 

• Height: (Висота:) – 1.00 мм; 

• Revolution: (Поворот:) – 0.95; 

• Started Angle: (Початковий кут:) – 180.00 градусів, і натисніть  ОК. 

 
29. Змініть ім'я елемента з Helix 1 на «Спіраль». 

Створення тривимірної моделі гровера 

30. Натисніть кнопку  Swept Boss/Base (Виступ/основа по траєкторії) панелі 

інструментів  Features (Елементи) або виберіть Insert, Boss/Base, Sweep... 

(Вставка, Виступ/Основа, По траєкторії...) з головного меню. 

31. У Диспетчері властивостей Sweep (По траєкторії) задайте (Рис. 101.4): 

Profile (Профіль) – ескіз «Перетин»; 

Path  (Траєкторія) – елемент «Спіраль», і натисніть – OK. 

Рис. 11.3. Трансформація окружності в спіраль 
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32. Натисніть клавішу F, щоб змінити вид окружності в розмір екрана. 

33. Змініть ім'я елемента з Sweep на «Гровер». 

34. Наведіть курсор на позначення вихідної точки в дереві проекту 

FeatureManager (Диспетчера конструктивних елементів). 

35. Натисніть праву кнопку миші й виберіть із контекстного меню Hide (Сховати). 

36. Натисніть кнопку  Shaded (Зафарбувати) панелі інструментів  View (Вид) 

або виберіть View, Display, Shaded (Вид, Відобразити, Зафарбувати) з 

головного меню. 

Панель інструментів  View (Вид) управляє видом подання моделі. Панель 

включає двадцять один інструмент. 

37. Натисніть кнопку  Shadows in Shaded Mode (Тіні в режимі Зафарбувати) 

панелі інструментів  View (Вид) або виберіть View, Display, Shadows in 

Shaded Mode (Вид, Відобразити, Тіні в режимі Зафарбувати) із головного 

меню.  

38. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

Рис. 11.4 Формування гровера 
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(Стандартна ) або Ctrl+S. 

Модель гровера створена (Рис. 101.5). 

 
 

Рис. 11.5 Тривимірна модель гровера 
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Практичне заняття №12 

 

Тема: створення моделі гайки 

Мета роботи: Набути навиків у створенні моделей деталей типу гайка 

 

Хід роботи 

У цій роботі ми створимо модель гайки М4 з такими розмірами: 

■ діаметр внутрішнього отвору – 3.30 мм; 

■ різь метрична, М4х0.70; 

■ діагональ шестигранника – 7.70 мм; 

■ ширина шестигранника – 6.90 мм; 

■ фаска шириною 0.30 мм і кутом 60.00 градусів; 

■ товщина гайки – 3.00 мм. 

Для роботи нам знадобляться наступні панелі інструментів: 

Annotations (Примітки); 

Dimensions/Relations (Розміри/Взаємозв'язки); 

Features (Елементи); 

Sketch (Ескіз);  

Standard View (Стандартні види); 

View (Вид). 

У процесі роботи ми познайомимося з тим, як: 

■ Використовувати елементи  Extruded Cut (Витягнутий виріз),  Hole 

Wizard(Отвір під кріплення),  Chamfer (Фаска); 

■ Нанести на деталь Cosmetic Thread (Умовне позначення різі). 

У процесі роботи ми намалюємо циліндричне тіло гайки, знімемо фаску, 

перетворимо стрижень у шестигранник, а потім сформуємо отвір, на чому і 

закінчиться створення моделі гайки. 
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Створення циліндричної заготовки гайки 

1. Створіть новий документ деталі. 

2. Натисніть Ctrl+S і збережіть модель під ім'ям Гайка.sldprt. 

3. Виберіть площину Top Plane (Зверху). 

4. Натисніть кнопку Sketch (Ескіз) панелі інструментів  Sketch (Ескіз) 

чи виберіть Insert, Sketch (Вставка, Ескіз) з головного меню, щоб відкрити ескіз. 

5. Натисніть кнопку  Circle (Коло) панелі інструментів  Sketch (Ескіз) 

чи виберіть Tools, Sketch Entities, Circle (Інструменти, Об'єкти ескізу, Коло) з 

головного меню. 

6. Намалюйте коло довільного діаметра з прив'язкою центра кола до вихідної 

точки. 

7. Натисніть кнопку  Smart Dimension (Розмір) панелі інструментів 

Dimensions/Relations(Розміри/Взаємозв'язку) чи виберіть Tools, Dimensions, Smart 

(Інструменти, Розміри, Авто) з головного меню. 

8. Задайте розмір кола в 7.70 мм. 

9. Присвойте розміру й ескізу імена «Діагональ гайки» і «Основа циліндра», 

відповідно. 

10.Натисніть кнопку  Isometric (Ізометрія) панелі інструментів  Standard 

Views (Стандартні види). 

11.Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз), 

або виберіть Insert, Sketch (Вставка, Ескіз) з головного меню, щоб закрити ескіз. 

12.Натисніть кнопку  Extruded Boss/Base (Витиснута основа) панелі 

інструментів  Features (Елементи) чи виберіть Insert, Boss/Base, Extrude... 

(Вставка, основа, Витягнути...) з головного меню. 

13.У Диспетчері властивостей Extrude (Витиснути) задайте (Рис. 102.1): 

 Direction (Напрямок) – Blind (На задану відстань); 

 Depth (Глибина) – 3.00 мм, і натисніть ОК. 
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14.Натисніть клавішу F, щоб змінити вид окружності в розмір екрана. 

15.Привласніть елементу ім'я «Циліндр». 

 

Зняття фаски з ребер циліндра 

16. Натисніть кнопку  Wireframe (Каркасне представлення) панелі 

інструментів View (Вид) чи виберіть View, Display, Wireframe (Вид, 

Відображення, Каркасне представлення) з головного меню. 

17. Натисніть кнопку  Chamfer (Фаска) панелі інструментів  Features 

(Елементи), або виберіть Insert, Features, Chamfer... (Вставка, Елементи, Фаска...) з 

головного меню. 

18. У Диспетчері властивостей Chamfer (Фаска) виберіть параметр Angle 

Distance (Кут Відстань), задайте (Рис. 102.2): 

 Distance (Відстань) – 0.30 мм; 

 Angle (Кут) – 60.00 градусів; 

 Edges and Faces or Vertex (Кромки і чи поверхні вершини) – укажіть бічну 

грань циліндра, і натисніть  ОК. 

Рис. 12.1 Створення заготовки гайки 
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19. Привласніть елементу ім'я «Фаска». 

20. Натисніть кнопку  Shaded (Зафарбувати) панелі інструментів View (Вид) 
чи виберіть View, Display, Shaded (Вид, Відображення, Зафарбувати) з головного 
меню. 

21. Натисніть кнопку  Isometric (Ізометрія) панелі інструментів Standard 

Views (Стандартні види) (Рис. 102.3). 

 
Перетворення циліндра в шестигранник 

Рис. 12.2 Зняття фаски з крайок циліндра 

Рис. 12.3 Циліндр зі знятими фасками 
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22. Виберіть верхню грань циліндра. 

23. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз) 

чи виберіть Insert, Sketch (Вставка, Ескіз) з головного меню, щоб відкрити ескіз. 

24. Натисніть кнопку  Polygon (Багатокутник) панелі інструментів  Sketch 

(Ескіз) чи виберіть Tools, Sketch Entity, Polygon (Інструменти, Об'єкти ескізу, 

Багатокутник) з головного меню. 

25. У Диспетчері властивостей Polygon (Багатокутник), у групі Parameters 

(Параметри) виберіть параметр Inscribed circle (Уписана Коло), задайте: 

 Number of Sides (Кількість сторін) – 6. 

26. Намалюйте багатокутник, центр якого прив'язаний до вихідної точки. 

27. У Диспетчері властивостей Polygon (Багатокутник), у групі Parameters 

(Параметри), задайте (Рис. 102.4): 

 
 Center X Coordinate (Абсциса центра) – 0.00; 

 Center Y Coordinate (Ордината центра) – 0.00; 

 Circle Diameter (Діаметр окружності) – 6.90 мм; 

 Angle (Кут) – 90.00 градусів, і натисніть  ОК. 

Рис. 12.4 Ескіз шестикутника 
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28. Натисніть кнопку  Sketch (Ескіз), або виберіть Insert, Sketch (Вставка, 

Ескіз) з головного меню, щоб закрити ескіз. 

29. Привласніть ескізу ім'я «Шестикутник». 

30. Натисніть кнопку  Extruded Cut (Витягнутий виріз) панелі інструментів 

Features (Елементи) чи виберіть Insert, Cut, Extrude (Вставка, Виріз, Витягнути...) з 

головного меню. 

31. У Диспетчері властивостей Cut-Extrude (Виріз – Витягнути) виберіть 

параметр Flip side to cut (Інвертувати виріз), задайте (Рис. 102.5): 

 Reverse Direction (Змінити напрямок) – Trough All (Через все), і натисніть  

ОК. 

 
32. Присвойте елементу ім'я «Шестикутник». 

Рис. 12.5 Формування шестигранника 
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Створення різьового отвору 

33. Виберіть елемент «Шестигранник» у дереві проекту Feature Manager 

(Диспетчера конструктивних елементів). 

34. Натисніть кнопку  Hole Wizard (Отвір під кріплення) панелі 

інструментів Features (Елементи), або виберіть Insert, Features, Hole, Wizard... 

(Вставка, Елементи, Отвір, Під кріплення...) з головного меню. 

35. З'явиться діалогове вікно Hole Definition (Визначення отвору), у якому 

виберіть вкладку Hole (Отвір), задайте (Рис. 102.6): 

• Standard (Креслярський стандарт) – ISO; 

• Screw type (Тип гвинта) – Тар Drills (Свердління під мітчик); 

• Size (Розмір) – М4х0.7; 

• Hole type & Depth (Тип і глибина отвору) – Trough All (Через все), а потім 

натисніть кнопку Next> (Далі>). 

 

36. З'явиться діалогове вікно Hole Placement (Розміщення отвору), що 

попросить вас увести розміри для визначення центра чи отвору вибрати точки для 

створення декількох отворів (Рис. 102.7). Форма курсору в графічній області в цей 

момент буде мати такий вид. 

Рис. 12.6 Завдання параметрів різьбового отвору 
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37. Виберіть ескіз «Шестикутник» у дереві проекту Feature Manager  

(Диспетчера конструктивних елементів). 

38. Наведіть курсор на центр окружності і клацніть лівою кнопкою миші (Рис. 

102.8). 

 
39. Натисніть кнопку  Add Relation (Додати взаємозв'язок) панелі 

інструментів  Dimensions/Relations (Розміри/Взаємозв'язки), або виберіть Tools, 

Relations, Add... (Інструменти, Взаємозв'язки, Додати...) головного меню. 

40. Натисніть кнопку  Select (Вибрати) панелі інструментів Sketch (Ескіз) 

чи Tools, Select (Інструменти, Вибрати) з головного меню. 

41. Виберіть центр отвору і  вихідну точку. Вони з'являться у вікні Select 

Entities (Вибрати об'єкти) Диспетчера властивостей Add Relations (Додати 

взаємозв'язки). 

42. У групі Add Relations (Додати взаємозв'язки) виберіть  Vertical 

(Вертикально) і натисніть  ОК (Рис. 102.9). 

Рис. 12.7 Діалогове вікно розміщення отворів 

Рис. 12.8 Вибір центра кола 
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43. Натисніть кнопку Finish (Кінець). З'явиться наскрізний отвір діаметром 3.30 

мм. 

44. Натисніть кнопку Cosmetic Thread (Умовна позначка різьблення) панелі 

інструментів Annotations (Примітки) чи виберіть Insert, Annotations, Cosmetic 

Thread... (Вставка, Примітки, Умовна позначка різьблення...) з головного меню. 

45. У діалоговому вікні Cosmetic Thread (Умовна позначка різі) виберіть 

параметр Through (Наскрізь), задайте: 

Major diameter (Основний діаметр) – 4.00 мм; 

Circular Edges (Круглі кромки) – виберіть кромку отвору, і натисніть ОК. 

46. Навколо отвору з'явиться умовне позначення різі у вигляді концентричного 

кола (Рис. 102.10). При наведенні на неї форма курсора міняється. Умовна позначка 

різі автоматично переноситься на креслення. 

47. Натисніть клавішу F, щоб змінити вид у розмір екрана. 

48. Натисніть кнопку  Shadows in Shaded Mode (Тіні в режимі Зафарбувати) 

панелі інструментів View (Вид) чи виберіть View, Display, Shadows in Shaded Mode 

(Вид, Відобразити, Тіні в режимі Зафарбувати) з головного меню. 

49. Натисніть кнопку Save (Зберегти) панелі інструментів у Standard 

(Стандартна) чи Ctrl+S. 

 

Рис. 12.9 Прив'язка центра отвору до осі циліндра 



 114 

 

50. Створення моделі гайки М4 завершено (Рис. 102.11). 

 

 

Рис. 12.10 Завдання умовної позначки різьблення 

Рис. 12.11 Тривимірна модель гайки 
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Практичне заняття №13 

 

Тема: Створення моделі вертушки 

Мета роботи: набути навиків у використанні об'єкта ескізу Centerpoint Arc 

(Центр дуги), інструмента ескізу Entities (Відітнути елементи), елемента Simple Hole 

(Простий отвір), елемента Circular Pattern (Круговий масив) елементів Reference 

Geometry (Довідкова геометрія). 

 

Хід роботи 

Вертушка є циліндричним тілом з лопастями сферичної форми. Існує безліч 

способів створення подібних форм, тут ми розглянемо тільки один з можливих 

варіантів. 

Габаритні розміри вертушки такі: 

•  Зовнішній діаметр – 70.00 мм; 

•  Діаметр циліндричної серцевини – 32.00 мм; 

•  Висота циліндра – 14.00 мм; 

•  Товщина циліндра – 1.00 мм; 

•  Діаметр осьового отвору – 2.00 мм; 

•  Зовнішній радіус кривизни лапасті в основі – 22.00 мм; 

•  Внутрішній радіус кривизни лапасті в основі – 40.00 мм; 

•  Зовнішній радіус кривизни лапасті  по краю – 32.00 мм; 

•  Внутрішній радіус кривизни лапасті  по краю – 40.00 мм; 

•  Зсув краю лапасті від осі вертушки – 5.00 мм, 

•  Розмах лопасті в основі – 10.00 мм. 

Для роботи нам знадобляться наступні панелі інструментів: 

 Dimensions/Relations (Розміри/Взаємозв'язку); 

 Features (Елементи); 

 Reference Geometry (Довідкова геометрія); 

 Sketch (Ескіз); 

 Standard Views (Стандартні види); 
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 View (Вид). 

У процесі роботи ми познайомимося з тим, як використовувати: 

■  Об'єкт ескізу  Centerpoint Arc (Центр дуги); 

■  Інструмент ескізу  Entities (Відітнути елементи); 

■  Елемент  Simple Hole (Простий отвір); 

■  Елемент  Circular Pattern (Круговий масив). 

Процес створення вертушки буде складатися з наступних етапів. Спочатку ми 

сформуємо циліндричну підставку, потім намалюємо профілі лопасті на границі 

підставки і на його периферії. Потім сформуємо одну лопасть створимо масив із семи 

лопастей. і, нарешті, додамо трохи додаткових елементів (отворів, фасок і т.д.). 

Створення циліндричної основи 

1. Створіть новий документ деталі. 

2. Натисніть Ctrl+S і збережіть модель під ім'ям Вертушка.sldprt. 

3. Виберіть площину Front Plane (Спереду). 

4. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз), щоб 

відкрити ескіз. 

5. Натисніть кнопку  Circle (Коло) панелі інструментів  Sketch (Ескіз) чи 

виберіть Tools, Sketch Entities, Circle (Інструменти, Об’єкти ескізу, Коло) з 

головного меню. 

6. Намалюйте коло довільного діаметра з прив'язкою центра кола до вихідної 

точки. 

7. Натисніть кнопку  Smart Dimension (Розмір) панелі інструментів  

Dimensions/Relations (Розміри/Взаємозв'язку) чи виберіть Tools, Dimensions, 

Auto (Інструменти, Розміри, Авто) з головного меню. 

8.  Встановіть діаметр окружності 32.00 мм. 

9. Натисніть клавішу F, щоб змінити вид окружності в розмір екрана. 

10. Привласніть розміру й ескізу імена «Діаметр» і «Діаметр основи», відповідно. 

11. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз), 

щоб закрити ескіз. 
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12. Натисніть кнопку  Isometric (Ізометрія) панелі інструментів  Standard 

Views (Стандартні види). 

13.  Клацніть по ескізі «Діаметр основи» у дереві проекту Feature Manager 

(Диспетчера конструктивних елементів). 

14. Натисніть кнопку  Extruded Boss/Base (Витягнутий Виступ/Основа) панелі 

інструментів  Features (Елементи) чи виберіть Insert, Boss/Base, Extrude... 

(Вставка, Виступ/Основа, Витягнути...) з головного меню. 

15. У Диспетчері властивостей Extrude (Витягнути) виберіть параметр Merge 

result (Об'єднати результат), задайте (Рис. 103.1); 

 Reverse Direction (Змінити напрямок) Blind «На задану відстань»; 

 Depth (Глибина) – 14.00 мм, і натисніть  ОК. 

 
16. Привласніть елементу ім'я «Циліндр». 

17. Натисніть клавішу F, щоб змінити вид у розмір екрана. 

18. Натисніть кнопку  Fillet (Округлення) панелі інструментів  Features 

(Елементи) чи виберіть Insert, Features, Fillet/Round... (Вставка, Елементи, 

Скругление...) з головного меню. 

Рис. 13.1 Створення циліндра 
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19. У Диспетчері властивостей Fillet (Округлення), у групі Items to Fillet 

(Округлити елементи), виберіть параметр Tangent Propagation (Поширити 

уздовж ліній переходу), задайте (Рис. 103.2): 

 Radius (Радіус) – 1.00 мм; 

 Edges, Faces, Features and Loops (Елементи округлення) – виберіть 

передню крайку циліндра, 

і натисніть  ОК. 

 
20. Привласніть елементу ім'я «Округлення». 

Рис. 13.2 Округлення передньої кромки. 
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Додавання елементів довідкової геометрії 

Для подальшої роботи нам знадобиться вісь і площини, що відносяться до 

елементів довідкової геометрії. Почнемо зі створення осі вертушки. 

21. Натисніть кнопку  Axis (Вісь) панелі інструментів  Reference Geometry 

(Довідкова геометрія) чи виберіть Insert, Reference Geometry, Axis... 

(Вставка, Довідкова геометрія, Вісь...) з головного меню. 

22. У Диспетчері властивостей Axis (Довідкова вісь) виберіть параметр  

Cylindrical/Conical Face (Циліндрична/конічна поверхня), у поле  

Reference Entities (Обрані елементи) укажіть бічну поверхню циліндра, і 

натисніть  ОК (Рис. 103.3). 

23. Привласніть елементу ім'я «Вісь вертушки». 

 

24. Натисніть кнопку  Isometric (Ізометрія) панелі інструментів  Standard 

Views (Стандартні види) (Рис. 103.4). 

Рис. 13.3 Установка довідкової осі 
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Тепер створимо дві площини, на яких будемо малювати перетини лопасті і вертушки 

в районі циліндра і на периферії. 

25. Виберіть площину Right Plane (Праворуч). 

26. Натисніть кнопку  Plane (Площина) панелі інструментів  Reference 

Geometry (Довідкова геометрія) чи виберіть Insert, Reference Geometry, 

Plane... (Вставка, Довідкова геометрія, Площина...) з головного меню. 

27. У Диспетчері властивостей Plane (Площина) задайте (Рис. 103.5): 

 Offset Distance (Відстань зсуву) – 15.00 мм, і натисніть  ОК.  

28. Привласніть елементу ім'я «Підстава лопасті». 

29. Повторіть описані дії ще раз. Задайте  Offset Distance (Відстань зсуву) 

рівним 35.00 мм і привласніть елементу ім'я «Край лопасті». 

30. Натисніть кнопку Right (Праворуч) панелі інструментів  Standard Views 

(Стандартні види) чи виберіть параметр Right (Праворуч) з контекстного 

меню Orientation (Орієнтація), що з'являється при натисканні клавіші 

Backspace (Пробіл).  

31. Виберіть площину «Підстава лопати» і за допомогою ручок, що розташовані у 

вершинах площини і посередині її сторін, погодьте її розмах з розміром 

циліндра. 

Рис. 13.4 Довідкова вісь додана до циліндра 
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32. Змініть в такий же спосіб і площина «Край лопасті». 

33. Натисніть кнопку  Isometric (Ізометрія) панелі інструментів  Standard 

Views (Стандартні види)  

34. Клацніть правою кнопкою миші по площині в графічному чи вікні його імені 

в дереві проекту Feature Manager (Диспетчера конструктивних елементів) і 

виберіть Hide (Сховати) з контекстного меню. При цьому обрана площина не 

буде відображатися в графічній області. 

Ескіз перетину підстави лопасті 

35. Виберіть площину «Підстава лопасті». 

36. Натисніть кнопку  Normal To (Перпендикулярно обраної площини) панелі 

інструментів  Standard Views (Стандартні види). 

37.  Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз), 

щоб відкрити ескіз. 

38. Натисніть кнопку  Centerpoint Arc (Центр дуги) панелі інструментів  

Sketch (Ескіз) чи виберіть Tools, Sketch Entities, Centerpoint Arc 

(Інструменти, Об'єкти ескізу, Центр дуги) з головного меню. 

Рис. 13.5 Установка довідкової площини 
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39. Наведіть курсор у довільну точку правіше і вище циліндра і клацніть лівою 

кнопкою миші (Рис. 103.6). 

40. Наведіть курсор на край циліндра і знову клацніть лівою кнопкою миші. 

41. Проведіть курсор уліво нагору. При цьому відображається попередній вид 

дуги. Клацніть лівою кнопкою миші ще раз, щоб завершити дугу. 

42. Натисніть клавішу Esc чи кнопку  Centerpoint Arc (Центр дуги) чи панелі 

інструментів  Sketch (Ескіз), щоб вийти з режиму малювання. 

 
43. Натисніть клавішу F, щоб змінити вид у розмір екрана. 

44. Натисніть кнопку  Smart Dimension (Розмір) панелі інструментів  

Dimensions/Relations (Розміри/Взаємозв'язку) чи виберіть Tools, Dimensions, 

Auto (Інструменти, Розміри, Авто) з головного меню. 

45. Задайте такі розміри: 

• Відстань від вихідної точки до верхнього краю дуги – 5.00 мм; 

• Висота дуги – 10.00 мм; 

• Радіус окружності – 40.00 мм. 

46. Привласніть розмірам імена «Внутрішній радіус», «Зсув», «Розмах», 

відповідно. 

47. При натиснутій клавіші Ctrl виберіть верхній край дуги й коло скругления. У 

Диспетчері властивостей Properties (Властивості) виберіть параметр  

Coincident (Збіг) у групі Add Relations (Додати взаємозв’язки). 

Рис. 13.6 Створення дуги 
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48. Додайте параметр  Coincident (Збіг) для нижнього краю дуги і кромки 

циліндра. Дуга набуде чорного кольору і буде цілком визначеною (Рис. 103.7). 

 

49. Натисніть кнопку  Centerpoint Arc (Центр дуги) панелі инструментов  

Sketch (Ескіз) чи виберіть Tools, Sketch Entities, Centerpoint Arc 

(Інструменти, Об'єкти ескізу, Центр дуги) з головного меню. 

50. Намалюйте ще одну довільну дугу радіусом 22.00 мм. 

51. Привласніть розміру ім'я «Зовнішній радіус». 

52. Натисніть кнопку  Add Relation (Додати взаємозв'язок) панелі інструментів 

 Dimensions/Relations (Розміри/Взаємозв'язку) чи виберіть Tools, 

Relations, Add... (Інструменти, Взаємозв'язки, Додати...) з головного меню. 

53. Виберіть верхні краї зовнішньої і внутрішньої дуг і натисніть кнопку  Merge 

(Злити крапки) у групі Add Relations (Додати взаємозв'язку) Диспетчера 

властивостей Add Relations (Додати взаємозв'язку) і натисніть  ОК. 

54. Повторіть ці ж дії для нижніх країв зовнішньої і внутрішньої дуг. Зовнішня 

дуга також набуде чорного кольору і буде цілком визначеною (Рис. 103.8). 

Рис. 13.7 Нанесення розмірів на дугу 
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55. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз), 

щоб закрити ескіз. 

56. Привласніть ескізу ім'я «Перетин основи». 

 

Ескіз перетину краю лопасті 

57. Виберіть площину «Край лопасті». 

58. Натисніть кнопку  Normal To (Перпендикулярно обраної площини) панелі 

інструментів  Standard Views (Стандартні види). 

59. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз), 

щоб відкрити ескіз. 

60. Натисніть кнопку  Centerpoint Arc (Центр дуги) панелі інструментів  

Sketch (Ескіз) чи виберіть Tools, Sketch Entities, Centerpoint Arc 

(Інструменти, Об'єкти ескізу, Центр дуги) з головного меню. 

61. Намалюйте дугу довільного розміру з центром правіше і вище вихідної точки. 

62. Натисніть клавішу Esc чи кнопку  Centerpoint Arc (Центр дуги) чи пані 

інструментів Sketch (Ескіз), щоб вийти з режиму малювання. 

Рис. 13.8 Січення основи лопасті 
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63. Натисніть кнопку  Add Relation (Додати взаємозв'язок) панелі інструментів 

 Dimensions/Relations (Розміри/Взаємозв'язку) чи виберіть Tools, 

Relations, Add... (Інструменти, Взаємозв'язки, Додати...) з головного меню. 

64. У Диспетчері властивостей Add Relations (Додавання взаємозв'язків) задайте 

такі взаємозв'язки: 

• Центр дуги і верхній край перетину підстави лопати – Horizontal 

(Горизонтально); 

• Верхній край дуги і верхній край перетину підстави лопати – Coincident (Збіг); 

• Нижній край дуги і нижній край перетину підстави лопати – Vertical 

(Вертикально). 

65. Натисніть кнопку  Smart Dimension (Розмір) панелі інструментів  

Dimensions/Relations (Розміри/Взаємозв'язку) чи виберіть Tools, Dimensions, 

Auto (Інструменти, Розміри, Авто) з головного меню. 

66. Установіть радіус дуги в 40.00 мм. Дуга набуде чорного кольору і буде цілком 

визначена. 

67. Натисніть кнопку  Centerpoint Arc (Центр дуги) панелі інструментів  

Sketch (Ескіз) чи виберіть Tools, Sketch Entities, Centerpoint Arc 

(Інструменти, Об'єкти ескізу, Центр дуги) з головного меню. 

68. Намалюйте дугу довільного розміру, розташовану лівіше щойно визначеної 

дуги. 

69. Натисніть клавішу Esc чи кнопку  Centerpoint Arc (Центр дуги) панелі 

інструментів  Sketch (Ескіз), щоб вийти з режиму малювання. 

70. Установіть радіус дуги – 32.00 мм. 

71. При натиснутій клавіші Ctrl виберіть верхні краї зовнішньої і внутренїй дуг і 

натисніть кнопку  Merge (Злити точки) у групі Add Relations (Додати 

взаємозв'язку) Диспетчера властивостей Add Relations (Додати взаємозв'язки) 

і натисніть  OK. 

72.  Повторіть ці ж дії для нижніх країв зовнішньої і внутрішньої дуг. Зовнішня 

дуга також набуде чорного кольору і буде цілком визначеною (Рис. 103.9). 
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73. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз), 

щоб закрити ескіз. 

74. Привласніть ескізу ім'я «Перетин краю». 

Формування лопасті 

Після створення перетинів основи і краю ми можемо приступити до створення 

лопасті. 

75. Натисніть кнопку  Isometric (Ізометрія) панелі інструментів  Standard 

Views (Стандартні види). 

76. Натисніть кнопку  Lofted Boss/Base (Виступ/основа по перетинах) панелі 

інструментів  Features (Елементи) чи виберіть Insert, Boss/Base, Loft... 

(Вставка, Виступ/Основа, По перетинах...) з головного меню. 

77. Клацніть покажчиком миші по крайці лопати в підстави, а потім у краю. У 

графічній області відобразиться форма лопасті після застосування 

конструктивного елемента (Рис. 103.10). 

Рис. 13.9 Перетин краю лопасті 
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78. У Диспетчері властивостей Loft (По перетинах), у групі Profiles (Профілі) 

з'являться зазначені профілі. Натисніть кнопку  ОК, щоб закрити Диспетчер 

властивостей Loft (По перетинах). 

79. Привласніть елементу ім'я «Лопасті». 

80. Формування однієї лопасті довершено. 

Створення лопастей вертушки 

Створивши одну лопату, нам не складе труднощів створити масив лопат, 

використовуючи вісь вертушки як вісь обертання кругового масиву. 

81. Натисніть кнопку  Circular Pattern (Круговий масив) панелі інструментів 

 Features (Елементи) чи виберіть Insert, Pattern/Mirror, Circular Pattern... 

(Вставка, Масив/Дзеркало, Круговий масив) із головного меню. 

82. У Диспетчері властивостей Circular Pattern (Круговий масив) у групі 

Parameters (Параметри) виберіть параметр Equal Spacing (Рівна відстань) і 

задайте: 

Direction (Напрямок) – ескіз «Вісь вертушки»; 

Total Angle (Загальний кут) – 360.00 градусів; 

Рис. 13.10 Формування лопасті 
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Number Of Instances (Кількість елементів) – 7.00. 

83. У групі Features To Pattern (Копіювати елементи) з дерева проекту Feature 

Manager (Диспетчера конструктивних елементів) виберіть «Лопасть», і 

натисніть  ОК. 

У графічному вікні з'явиться попереднє зображення моделі після застосування 

конструктивного елемента (Рис. 103.11).  

84. Натисніть кнопку  Front (Спереду) панелі інструментів  Standard Views 

(Стандартні види) чи натисніть клавішу Backspace (Пробіл) і виберіть Front 

(Попереду) з контекстного меню Orientation (Орієнтація). 

85. Натисніть кнопку  Shaded With Edges (Зафарбувати з кромками) панелі 

інструментів  View (Вид). Форма лопастей сформована і має наступний вид 

(Рис. 103.12). 

 

Рис. 13.11 Формування кругового масиву лопастей 
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Формування контуру лопат 

Вертушка встановлюється усередині циліндричного корпуса. Сформуємо контур 

лопастей для того, щоб вони вмістилися в корпусі з внутрішнім діаметром 76.00 мм. 

86. Виберіть площину Front Plane (Спереду). 

87. Натисніть кнопку  Normal To (Перпендикулярно обраної площини) панелі 

інструментів  Standard Views (Стандартні види). 

88. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Ескіз), щоб 

відкрити ескіз. 

89. Натисніть кнопку  Circle (Коло) панелі інструментів  Sketch (Ескіз) чи 

виберіть Tools, Sketch Entities, Circle (Інструменти, Об’єкти ескізу, Коло) з 

головного меню. 

90. Намалюйте коло довільного діаметра з прив'язкою центра кола до вихідної 

точки. 

Рис. 13.12 Заготовка вертушки 
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91. Натисніть кнопку  Smart Dimension (Розмір) панелі інструментів  

Dimensions/Relations (Розміри/Взаємозв'язку) чи виберіть Tools, Dimensions, 

Auto (Інструменти, Розміри, Авто) з головного меню. 

92.  Установіть діаметр окружності – 70.00 мм. 

93. Привласніть розміру ім'я «Діаметр вертушки». 

94. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch (Эскиз), 

щоб закрити ескіз. 

95. Натисніть кнопку  Isometric (Ізометрія) панелі інструментів  Standard 

Views (Стандартні види). 

96. Натисніть кнопку  Extruded Cut (Витягнутий виріз) панелі інструментів  

Features (Елементи) чи виберіть Insert, Cut, Extrude (Вставка, Виріз, 

Витягнути...) з головного меню. 

97. У Диспетчері властивостей Cut-Extrude (Виріз – Витягнути) виберіть параметр 

Flip side to cut (Інвертувати виріз) і задайте (Рис. 103.13): 

Direction (Напрямок) – Trough All (Через все), і натисніть  ОК. 

 
98. Привласніть елементу ім'я «Розмах лопастей». 

Формування тонкостінного циліндра 

Усередині циліндричної основи вертушки повинний знаходитися 

електродвигун. Тому видалимо внутрішнє заповнення циліндра. 

Рис. 13.13 Задання розмаху лопастей 
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99. Натисніть кнопку  Rotate View (Обертати вид) панелі інструментів View 

(Вид) чи виберіть View, Modify, Rotate (Вид, Змінити, Обертати) з головного 

меню. 

100. Поверніть зображення деталі так, щоб стала доступною задня поверхня 

циліндра, і натисніть Esc. 

101. Виберіть торцеву поверхню циліндра. 

102. Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch 

(Ескіз), щоб відкрити ескіз. 

103.  Натисніть кнопку  Offset Entities (Зсув об'єктів) панелі інструментів 

 Sketch (Ескіз) чи виберіть Tools, Sketch Tools, Offset Entities... 

(Інструменти, Інструменти ескізу, Зсув об'єктів...) з головного меню. 

104.  У Диспетчері властивостей Offset Entities (Зсув об'єктів) виберіть 

параметр Reverse (Реверс), задайте: 

 Offset Distance (Відстань зсуву) – 1.00 мм, і натисніть  ОК. 

105.  Привласніть розміру й ескізу імена «Товщина» і «Товщина циліндра», 

відповідно. 

106.  Натисніть кнопку  Sketch (Ескіз) панелі інструментів  Sketch 

(Ескіз), щоб закрити ескіз. 

107.  Натисніть кнопку  Extruded Boss/Base (Витягнутий виступ/основа) 

панелі інструментів  Features (Елементи) чи виберіть Insert, Boss/Base, 

Extrude... (Вставка, Виступ/Основа, Витягнути...) з головного меню. 

108.  У Диспетчері властивостей Cut-Extrude (Виріз-Витягнути) задайте (Рис. 

103.14): 

 Direction (Напрямок) – Offset from Surface (Зсув від поверхні); 

 Face/Plane (Поверхня/Площина) – Front Plane (Попереду); 

 Offset Distance (Зсув) – 1.00 мм і натисніть  OK. 
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109. Привласніть елементу ім'я «Порожнина корпуса». 

Формування осьового отвору 

На закінчення сформуємо осьовий отвір вертушки діаметром 2.00 мм. 

110. Натисніть кнопку  Front (Попереду) панелі інструментів  Standard 

Views (Стандартні види). 

111. Виберіть лицьову поверхню циліндра. 

112. Натисніть кнопку  Simple Hole (Простий отвір) панелі інструментів 

 Features (Елементи) чи виберіть Insert, Features, Hole, Simple... (Вставка, 

Елементи, Отвір, Простий...) з головного меню. 

113.  У Диспетчері властивостей Hole (Отвір) виберіть параметр Trough All 

(Через все), задайте (Рис. 103.15): 

 Diameter (Діаметр) – 2.00 мм, і натисніть  ОК. 

Рис. 13.14 Формування порожнини в корпусі вертушки 
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Привласніть елементу ім'я «Отвір». 

114. Клацніть правою кнопкою миші по імені «Отвір» у дереві проекту 

Feature Manager (Диспетчера конструктивних елементів) і виберіть Edit 

Sketch (Редагування ескізу) з контекстного меню. 

115. Натисніть кнопку  Add Relation (Додати взаємозв'язок) панелі 

інструментів  Dimensions/Relations (Розміри/Взаємозв'язку) чи виберіть 

Tools, Relations, Add... (Інструменти, Взаємозв'язки, Додати...) з головного 

меню. 

116. У Диспетчері властивостей Add Relations (Додавання взаємозв'язків) 

задайте взаємозв'язок (Рис. 103.16): 

вихідна точка і центр отвору –  Coincident (Збіг), і натисніть  ОК. 

Рис. 13.15 Формування отвору в корпусі вертушки 
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117. У дереві проекту Feature Manager (Диспетчера конструктивних 

элементов) клацніть правою кнопкою по вихідній точці  і виберіть Hide 

(Сховати) з контекстного меню. 

118.  Натисніть кнопку  Isometric (Ізометрія) панелі інструментів  

Standard Views (Стандартні види). 

119. Натисніть кнопку  Shaded (Зафарбувати) панелі інструментів  View 

(Вид). 

120. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

(Стандартна) чи Ctrl+S. 

121. Створення моделі вертушки довершено (Рис. 103.17). 

Рис. 13.16 Прив’язування отвору до осі корпусу вертушки 
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Рис. 13.17 Трьохмірна модель вертушки 
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Практичне заняття № 14 

Тема: створення збірок 
Мета роботи: набути навиків у створенні збірок 

 
Хід роботи 

Початок створення збірки 
Збірка складається з декількох деталей, які розміщені одна відносно іншої в 

певному порядку. Процес збірки починається з розміщення в графічній області однієї 
(базової) деталі, з наступним додаванням інших. Між деталями встановлюються певні 
взаємозв'язки сполучення), які дозволяють зберігати єдність збірки при її 
переміщенні або повороті. У нашому випадку базовою деталлю є корпус вентилятора, 
який ми розмістимо в графічній області в першу чергу. Потім додамо вертушку й, 
нарешті, захисні ґрати. 
 

Створення документа нової збірки 
Процес збірки деталей починається зі створення документа нової збірки. 

1. Створіть новий документ збірки, виконавши одну з наступних дій: 
• натисніть кнопку  New (Створити) панелі інструментів Standard 

(Стандартна); 
• виберіть команду File, New (Файл, Створити) з головного меню; 
• натисніть Ctrl+N. 

2. Виберіть значок  Assembly (Збірка) вкладки Templates (Шаблони) 
діалогового вікна New SolidWorks Document (Новий документ Solid-Works), і 
натисніть ОК (Рис. 104.1). 

 
3. З'явиться вікно нової збірки (Рис. 104.2). 

Рис. 14.1 Діалогове вікно створення нової збірки 
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Нова збірка може бути створена безпосередньо з документа деталі (збірки). 

В активному вікні документа деталі (збірки) натисніть кнопку  Маke Assembly 

from Part/Assembly (Створити Збірку з деталі/Збірки), виберіть Make Assembly from 

Part (Assembly) (Створити Збірку з деталі (Збірки)) з головного меню або натисніть 

Ctrl+A. 

 

Додавання базової деталі 

Почнемо збірку з відкриття файлу «Корпус вентилятора.sldprt». 

4. Натисніть кнопку Browse (Відкрити в оглядачі). З'явиться діалогове вікно Open 

(Відкрити) з вікном попереднього перегляду й можливих конфігурацій 

документа (Рис. 104.3). 

Рис. 14.2 Вікно нової збірки 
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5. Виберіть файл «Корпус вентилятора.sldprt» у діалоговому вікні Open 

(Відкрити), і натисніть Open (Відкрити). У графічному вікні з'явиться 

напівпрозоре зображення деталі (Рис. 104.4). Курсор набуде вигляду . 

 

6. Наведіть курсор на вихідну точку . Як тільки курсор зміниться на , 

клацніть лівою кнопкою миші. Деталь набуде вихідного вигляду і буде 

прив'язана до вихідної точки  (Рис. 104.5). 

Зверніть увагу на букву (ф), розташовану між значком  і ім'ям деталі в 

дереві проекту Feature Manager (Диспетчера конструктивних елементів) вікна 

збірки. Так позначається фіксоване положення деталі, тобто блокування 

Рис. 14.3 Діалогове вікно відкриття документа 

Рис. 14.4 Розміщення базової деталі у вікні збірки 
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переміщення деталі в графічному вікні. Щоб зняти блокування, клацніть правою 

кнопкою миші по назві деталі й виберіть із контекстного меню Boat (Вільне 

переміщення). Значок зміниться на (-). Щоб знову заблокувати переміщення, 

виберіть Fix (Закріпити). 

 

Додавання інших деталей 

Тепер ми можемо додати дві деталі, що залишилися. 

7. Натисніть кнопку  Insert Components (Вставити компоненти) панелі 

інструментів  Assembly (Збірка) або виберіть Insert, Component, Existing 

Part/Assembly (Вставка, Компонент, З файла) з головного меню. В області 

диспетчерів знову з'явиться вікно Insert Component (Вставити компонент) 

(Рис. 104.2). 

8. Натисніть кнопку Browse (Відкрити в оглядачі). 

9. У вікні Open (Відкрити) виберіть документ «Вертушка.sldprt» і натисніть 

Open (Відкрити). 

10. Розташуєте вертушку у вікні збірки, лівіше корпуса вентилятора. 

11. Повторіть описані дії для документа «Захисні ґрати.sldprt». 

12. Натисніть клавішу F, щоб змінити зображення в розмір екрана (Рис. 104.6). 

Рис. 14.5 Базова деталь у вікні збірки прив'язана до вихідної точки 
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13. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

(Стандартна) або виберіть File, Save (Файл, Зберегти) з головного меню, або 

натисніть Ctrl+S. 

14. Збережіть документ збірки під ім'ям «Вентилятор.sldasm». 

 

Сполучення деталей 

Сполучення деталей дозволяє обмежити можливі переміщення деталей у 

просторі. Наприклад, сполучивши осі корпуса вентилятора й вертушки, в останньої 

залишиться тільки один ступінь волі - переміщення уздовж осі вентилятора. 

Сполучення скоб кріплення захисних ґрат з лицьовою поверхнею корпуса 

вентилятора обмежує переміщення ґрат тільки в одній площині. 

 

Установка вертушки 

15. Натисніть кнопку  Mate (Сполучення) панелі інструментів  Assembly 

(Збірка) або виберіть Insert, Mate (Вставка, Сполучення) з головного меню. 

Панель інструментів  Assembly (Збірка) управляє переміщенням і 

спряженням елементів. Панель включає двадцять інструментів. 

Рис.9.6 Деталі у вікні збірки 
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16. Розкрийте в дереві проекту деталь «Корпус вентилятора» і виберіть елемент 

«Вісь обертання». 

17. Розкрийте в дереві проекту деталь «Вертушка» і виберіть елемент «Вісь 

вертушки». 

18. У групі Mate Selections (Вибір сполучень) у поле  Entities to Mate 

(Сполучувані елементи) з'являться елементи «Вісь обертання @ Корпус 

вентилятора» і «Вісь вертушки @ Вертушка». 

19. У групі Standard Mates (Стандартні сполучення) виберіть параметр  

Coincident (Збіг). 

Якщо в групі Options (Параметри) включений параметр Show popup dialog 

(Показати спливаюче меню), у графічному вікні з'явиться плаваюче меню 

інструментів для виконання сполучень. Якщо включено параметр Show preview 

(Попередній перегляд), рекомендоване сполучення буде показано в графічному вікні 

(Рис. 104.7). 

 
Рис. 14. 7 Сполучення осей корпуса й вертушки 
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20. Якщо результат сполучення незадовільний – натисніть  Undo (Скасувати). 

Якщо результат сполучення відповідає вашим очікуванням - натисніть  ОК 

(Рис. 104.8). 

 
21. Виберіть торцеву поверхню циліндра вертушки й лицьову поверхню корпуса 

вентилятора. 

22. У групі Standard Mates (Стандартні сполучення) виберіть параметр  

Coincident (Збіг) (Рис. 104.9). 

23. Перевірте якість сполучення й натисніть  ОК. Вертушка встановлена в 

корпусі вентилятора (Рис. 104.10). Лінійне переміщення вертушки обмежене, 

однак її можна повертати щодо осі обертання. 

Зверніть увагу на дерево проекту Feature Manager (Диспетчера 

конструктивних елементів). Нижче списку деталей збірки перебуває група  Mates 

(Сполучення), у якій перераховані всі сполучення збірки. Щоб змінити параметри 

сполучення, клацніть правою кнопкою миші по необхідному сполученню й виберіть 

Edit Definition (Редагувати визначення) з контекстного меню. 

Рис. 14.8 Осі корпуса й вертушки сполучені 
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Рис. 14.9 Сполучення лицьових поверхонь корпуса й вертушки 

Рис. 14.10 Розміщення вертушки в корпусі 
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Переміщення деталей 
У зборці допускається переміщення й обертання деталей. Ми використаємо ці 

можливості при установці захисних ґрат. 
Установка захисних ґрат 
Захисні ґрати встановлюються у два етапи. Спочатку ми виконаємо сполучення 

осей обертання корпуса вентилятора й захисних ґрат. Потім помістимо ґрати на її 
місце шляхом переміщення й повороту. 
24. Розкрийте в дереві проекту деталь «Корпус вентилятора» і виберіть елемент 

«Вісь обертання». 
25. Розкрийте в дереві проекту деталь «Захисні ґрати» і виберіть елемент «Вісь 

обертання». 

26. У групі Mate Selections (Вибір сполучень) у поле  Entities to Mate 
(Сполучувані елементи) з'являться елементи «Вісь обертання @ Корпус 
вентилятора» і «Вісь обертання @ Захисні ґрати». 

27. У групі Standard Mates (Стандартні сполучення) виберіть параметр  
Coincident (Збіг). 

28. Натисніть кнопку  Flip Mate Alignment (Перевернути вирівнювання 
сполучення) у плаваючому меню (Рис. 104.11). 

 Рис. 14.11 Сполучення осей корпуса й захисних ґрат 
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29. Перевірте якість сполучення й натисніть  ОК. Вісь захисних ґрат сполучена 

з віссю обертання вертушки й корпуса вентилятора. 

30. Натисніть  OK ще раз, щоб закрити Диспетчер властивостей сполучень. 

31. Натисніть кнопку  Right (Вид праворуч) панелі інструментів  Standard 

Views (Стандартні види). 

32. Натисніть кнопку  Move Component (Перемістити компонент) панелі 

інструментів  Assembly (Збірка) або виберіть Tools, Component. Move 

(Інструменти, Компонент, Перемістити) з головного меню Форма курсора 

зміниться на . 

33. Наведіть курсор на ґрати, натисніть ліву кнопку миші й, не відпускаючи її, 

розташуєте ґрати перед лицьовою поверхнею корпуса вентилятора (Рис. 

104.12). 

 
34. Натисніть кнопку  Front (Вид попереду) панелі інструментів  Standard 

Views (Стандартні види). 

35. Натисніть кнопку  Rotate Component (Обертати компонент) панелі 

інструментів  Assembly (Збірка) або виберіть Tools, Component, Rotate 

Рис. 14.12. Розташування ґрат перед корпусом вентилятора 
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(Інструменти, Компонент, Обертати) з головного меню. Форма курсору 

зміниться на . 

Перехід між переміщенням і обертанням компонента можна також 

здійснити у вікні Диспетчера властивостей. Якщо ви перебуваєте в режимі 

переміщення, тобто в групі  Move (Перемістити), клацніть по групі  Rotate 

(Обертати). У цьому випадку заголовок Диспетчера властивостей з Move 

(Обертати) зміниться на Rotate (Обертати). 

36. Наведіть курсор на скобу кріплення захисних ґрат, натисніть ліву кнопку миші 

й, не відпускаючи її, сполучите скобу із кріпильним отвором корпуса 

вентилятора (Рис. 104.13). 

 
У випадку обмеження ступенів волі деталі (у нашому випадку, наприклад) 

переміщення й обертання можна виконувати як у режимі  Move (Перемістити), 

так і в режимі  Rotate (Обертати). Щоб контролювати положення деталі під час 

її переміщення, перейдіть у режим просторового подання (кнопка  Isometric 

(Ізометрія) панелі інструментів  Standard Views (Стандартні види). 

 

Рис. 14.13. Сполучення скоб захисних ґрат із кріпильними отворами корпуса 
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Редагування деталі в зборці 

Деталі, використовувані в зборці, пов'язані з документами самих деталей. Це 

значить, що будь-які зміни документів деталей будуть автоматично відбиті в зборці. 

І, навпаки, зміна деталей у зборці приведе до зміни документів деталей. Цей механізм 

дозволяє синхронізувати й автоматизувати процес редагування в процесі створення 

зборок. У нашому прикладі видно, що розрахунковий розмір дуги захисних ґрат 

небагато менше необхідного. Крім того, нам не вистачає деяких елементів, які 

дозволили б виконати точне сполучення захисних ґрат і корпуса вентилятора. 

Відредагуємо модель захисних ґрат. 

Довжина дуги задана рівнянням. Відредагуємо рівняння деталі в зборці. 

37. Виберіть у дереві проекту деталь «Захисні ґрати». 

38. Натисніть кнопку  Edit Component (Редагувати компонент) панелі 

інструментів  Assembly (Збірка) або виберіть Edit Part (Редагувати деталь) з 

контекстного меню, що з'являється при щиглику правої кнопки миші за назвою 

деталі. 

39. Натисніть кнопку  Equations (Рівняння) панелі інструментів  Tools 

(Інструменти) або виберіть Tools, Equations (Інструменти, Рівняння) з 

головного меню. 

40. Виділите перше рівняння й натисніть кнопку Edit (Редагувати). 

41. Зміните праву частину першого рівняння з (72-6)*sqr(2)/2 на (72-4)*sqr(2)/2, і 

натисніть ОК (Рис. 104.14). 

42. Переконаєтеся в тім, що в списку рівнянь вікна Equations (Рівняння), у стовпці 

Evaluates To (Обчислення) значення першого рівняння змінилося з 46.67 на 

48.08. Натисніть ОК. 

43. Натисніть кнопку  Rebuild (Перешикувати) панелі інструментів Standard 

(Стандартна), виберіть Edit, Rebuild (Редагувати, Перешикувати) або натисніть 

Ctrl+B. 
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44. Модель захисних ґрат зміниться відповідно до нового значення довжини дуги. 

Тепер скоби кріплення збігаються із кріпильними отворами (Рис. 104.15). 

 
Додамо елементи, необхідні для наступного сполучення захисних ґрат з 

корпусом вентилятора. 

45. Натисніть кнопку  Trimetric (Триметрія) панелі інструментів  Standard 

Views (Стандартні види). Наявність інших деталей утрудняє редагування деталі 

в зборці (Рис. 104.16). 

Сховаємо інші деталі збірки, щоб вони не заважали в процесі редагування. 

Рис. 14.14 Редагування першого рівняння захисних ґрат 

Рис. 14.15 Кріпильні скоби й кріпильні отвори сполучені 
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46. Виберіть деталь «Корпус вентилятора» і натисніть кнопку  Hide/Show 

Component (Сховати/показати компонент) панелі інструментів  Assembly 

(Збірка). 

Сховати деталь можна й іншим способом. Клацніть правою кнопкою миші за 

назвою деталі «Корпус вентилятора» і виберіть Hide Components (Сховати 

компоненти) з контекстного меню. Значок деталі, розташований лівіше її назви, 

змінитися з пофарбованого на прозорий. 

47. Сховайте в такий же спосіб деталь «Вертушка». 

48. Кнопками навігації клавіатури змініть розташування ґрат у графічному вікні 

(Рис. 104.17). 

Додамо допоміжну площину, дотичну до скоб кріплення ґрати. 

49. Натисніть кнопку  Plane (Площина) панелі інструментів  Reference 

Geometry (Допоміжна геометрія) або виберіть Insert, Reference Geometry, 

Plane (Вставка, Допоміжна геометрія, Площина) з головного меню. 

Рис. 14.16 Редагування деталі у вікні збірки 
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50. У Диспетчері властивостей Plane (Площину) виберіть Parallel Plane at Point 

(Паралельна площина, що проходить через точку), задайте (Рис. 104.18): 

 

Рис. 14.17 Компоненти збірки (вертушка й корпус) сховані 

Рис. 14.18 Створення допоміжної площини  
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 Reference Entities (Довідкові об'єкти) – площина Front Plane (Попереду) і 

точку сполучення дуги захисних ґрат із кріпильною скобою, і натисніть  ОК. 

51. Привласніть площини ім'я «Основа». 

52. Натисніть кнопку  Right (Вид праворуч) панелі інструментів  Standard 

Views (Стандартні види). Зверніть увагу на розташування площини «Основа» 

(Рис. 104.19). 

 
53. Клацніть правою кнопкою миші за назвою площини «Основа» і виберіть Hide 

(Сховати) з контекстного меню. 

54. Натисніть кнопку  Trimetric (Триметрія) панелі інструментів  Standard 

Views (Стандартні види). 

55. Виберіть деталь «Корпус вентилятора» і натисніть кнопку  Hide/Show 

Component (Сховати/показати компонент) панелі інструментів  Assembly 

(Збірка) або клацніть правою кнопкою миші за назвою деталі й виберіть Show 

Components (Показати компоненти) з контекстного меню. 

56. Включите в такий же спосіб відображення деталі «Вертушка». 

Рис. 14.19 Допоміжна площина «Основа» додана в деталь захисних ґрат 
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57. Натисніть кнопку  Edit Component (Редагування компонента) панелі 

інструментів  Assembly (Збірка), щоб вийти з режиму редагування деталі. 

58. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

(Стандартна), або виберіть File, Save (Файл, Зберегти) чи натисніть Ctrl+S щоб 

зберегти зміни. 

 

Завершення збірки вентилятора 

Після додавання допоміжної площини «Основа» деталь «Захисні ґрати» може 

бути коректно сполучена з корпусом вентилятора. 

59. Натисніть кнопку  Mate (Сполучення) панелі інструментів  Assembly 

(Збірка) або виберіть Insert, Mate (Вставка, Сполучення) з головного меню. 

60. Виберіть лицьову поверхню корпуса вентилятора. 

61. Розкрийте в дереві проекту деталь «Захисні ґрати» і виберіть елемент «Основа». 

62. У групі Mate Selections (Вибір сполучень) у поле  Entities to Mate 

(Сполучувані елементи) з'являться елементи «1 @ Корпус вентилятора» і 

«Основа @ Захисні ґрати». 

63. У групі Standard Mates (Стандартні сполучення) виберіть параметр  

Coincident (Збіг) (Рис. 104.20). 

64. Переконавшись у коректності сполучення, натисніть  ОК. 

65. Розкрийте в дереві проекту деталь «Корпус вентилятора» і виберіть елемент 

«Діагональна площина». 

66. Розкрийте в дереві проекту деталь «Захисні ґрати» і виберіть елемент «Front 

Plane». 

67. У групі Mate Selections (Вибір сполучень) у поле  Entities to Mate 

(Сполучувані елементи) з'являться елементи «Діагональна площина @ Корпус 

вентилятора» і «Front Plane @ Захисні ґрати». 
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68. У групі Standard Mates (Стандартні сполучення) виберіть параметр  

Coincident (Збіг) (Рис. 104.21). 

 

Рис. 14.20 Площина «Основа» захисних ґрат сполучена з лицьовою 

площиною корпуса вентилятора 

Рис. 14.21 Сполучення площини «Front Plane» захисних ґрат з 

діагональною площиною корпуса 
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69. Переконавшись у коректності сполучення, натисніть  ОК. 

70. Натисніть  OK ще раз, щоб вийти з режиму сполучення деталей. 

71. Клацніть правою кнопкою миші по вихідній точці  і виберіть Hide (Сховати) 

з контекстного меню. 

72. Збірка трьох деталей вентилятора завершений (Рис. 104.22). 

 
Створення нової деталі 

Перебуваючи у вікні Assembly (Збірка) ви можете створювати нові деталі, 

сполучені з існуючою зборкою. Щоб показати можливості Solid Works, створимо 

нову деталь - вісь вентилятора, торці якої погоджені із площинами корпуса 

вентилятора й вертушки, а діаметр - на 0.20 мм менше діаметра осьового отвору. 

73. Натисніть кнопку  New Part (Нова деталь) панелі інструментів  Assembly 

(Збірка) або виберіть Insert, Component, New Part (Вставка, Компонент, Нова 

деталь) з головного меню. 

74. У діалоговому вікні Save As (Зберегти як) укажіть ім'я нової деталі - «Вісь» і її 

місце розташування, після чого натисніть Save (Зберегти) (Рис. 104.23). 

Рис. 14.22 Модель збірки вентилятора 
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75. Курсор у графічному вікні змінить свою форму на . за допомогою клавіш 

навігації клавіатури розверніть корпус вентилятора й виберіть задню поверхню. 

Ми перейдемо в режим редагування деталі «Вісь» (Рис. 104.24). 

 
76. Натисніть кнопку  Zoom to Area (Збільшити область виду) панелі 

інструментів  View (Вид). 

Рис. 14.23 Діалогове вікно збереження нового 

документа 

Рис. 14.24 Збірка в режимі створення нової деталі 
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77. Зміните центральну частину корпуса вентилятора в розмір екрана. 

78. Натисніть кнопку  Offset Entities (Зсув об'єктів) панелі інструментів  

Sketch (Ескіз) або виберіть Tools, Sketch Tools, Offset Entities (Інструменти, 

Інструменти ескізу, Зсув об'єктів). 

79. Виберіть крайку осьового отвору корпуса вентилятора. 

80. У Диспетчері властивостей (Property Manager) Offset Entities (Зсув об'єктів) 

виберіть параметр Reverse (Реверс), установите (Рис. 104.25): 

 Offset Distance (Відстань зсуву) – 0.10 мм, і натисніть OK. 

 
81. Натисніть кнопку  Trimetric (Триметрія) панелі інструментів  Standard 

Views (Стандартні види). 

82. Натисніть кнопку  Extruded Boss/Base (Витягнутий Виступ/основа) панелі 

інструментів  Features (Елементи) або виберіть Insert, Boss/Base, Extrude 

(Вставка, Виступ/Основа, Витягнути) з головного меню. 

83. У Диспетчері властивостей Extrude (Витягнути) задайте (Рис. 104.26): 
 Reverse Direction (Змінити напрямок) - Up To Surface (До поверхні); 

Рис. 14.25 Створення ескізу осі вертушки 
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 Face/Plane (Поверхня/площину) – виберіть лицьову поверхню вертушки, і 

натисніть  OK. 

 
84. Натисніть кнопку  Edit Component (Редагування компонента) панелі 

інструментів  Assembly (Збірка), щоб вийти з режиму редагування. 

85. Клацніть правою кнопкою миші по вихідній точці  деталі «Вісь» і виберіть 

Hide (Сховати) з контекстного меню. 

86. Натисніть кнопку  Zoom to Area (Збільшити область виду) панелі 

інструментів  View (Вид). 

87. Змініть центральну частину вертушки в розмір екрана. 

88. Подивитеся на результат проробленої роботи (Рис. 104.27). 

89. Натисніть кнопку  Rebuild (Перешикувати) панелі інструментів Standard 

(Стандартна), виберіть Edit, Rebuild (Редагувати, Перешикувати) або натисніть 

Ctrl+B. 

90. Натисніть кнопку  Trimetric (Триметрія) панелі інструментів  Standard 

Views (Стандартні види). 

91. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

(Стандартна), виберіть File, Save (Файл, Зберегти) або натисніть Ctrl+S. 

Рис. 14.26 Формування осі вертушки 
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92. З'явиться вікно із запитом на збереження документа збірки й всіх пов'язаних з 

ним документів деталей (Рис. 104.28). Натисніть Yes (Так). 

 
93. Формування збірки вентилятора завершено. 

Рис. 14.27 Створення нової деталі «Вісь» завершене 

Рис. 14.28 Модальне вікно запиту на збереження збірки й вхідних у неї деталей  
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Рознесений вид подання збірки 

Іноді для розуміння взаємозв'язку окремих деталей у зборці корисним є 

створення рознесених видів, тобто подання збірки в розібраному виді. Для подання 

збірки вентилятора в рознесеному виді виконаємо наступні дії. 

Рознесення збірки на задану відстань 

1. Натисніть кнопку  Exploded View (Вид з рознесеними частинами) панелі 

інструментів  Assembly (Збірка) або Insert, Exploded View (Вставка, Вид з 

рознесеними частинами) з головного меню. 

2. У Диспетчері властивостей Explode (Рознести) у групі Settings (Настроювання) 

задайте (Рис. 104.29): 

 Components(s) of the explode step (Розношувані елементи) – «Захисні 

ґрати»; 

 Direction (Напрямок) – уздовж осі Z («Z @ Вентилятор .sldasm»); 

 Explode Distance (Відстань рознесення) – 100.00 мм, і натисніть Apply 

(Застосувати). 

 

3. Перевірте розташування захисних ґрат і натисніть Done (Виконати). 

Рис. 14.29 Винос захисних ґрат 
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4. У Диспетчері властивостей Explode (Рознести) у групі Settings (Настроювання) 

задайте (Рис. 104.30): 

 Components(s) of the explode step (Розношувані елементи) – «Вертушка»; 

 Direction (Напрямок) – уздовж осі Z («Z @ Вентилятор.sldasm»); 

 Explode Distance (Відстань рознесення) – 50.00 мм, 

і натисніть Apply (Застосувати). 

 
5. Перевірте розташування вертушки щодо захисних ґрат і корпуса вентилятора, і 

натисніть Done (Виконати). 

6. Якщо ви задоволені отриманим видом збірки з рознесеними деталями, 

натисніть  OK (Рис. 104.31). 

Розносити деталі збірки можна по різних напрямках і на різну відстань, 

домагаючись кращого подання рознесеного виду. Щоб повернутися до нормального 

виду збірки, натисніть  Exploded View (Вид з рознесеними частинами) панелі 

інструментів  Assembly (Збірка), а потім Delete (Видалити) у діалоговому вікні 

Assembly Exploder (Рознесення Збірки). 

Рис. 14.30 Винос вертушки 
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Рознесення збірки в ручному режимі 

Рознесення збірки можна здійснювати за допомогою технології Drag & Drop. 

Для рознесення збірки в ручному режимі виконаємо наступні дії. 

1. Натисніть кнопку  Exploded View (Вид з рознесеними частинами) панелі 

інструментів  Assembly (Збірка) або Insert, Exploded View (Вставка, Вид з 

рознесеними частинами) з головного меню. 

2. Виберіть деталь «Захисні ґрати» у дереві проекту або в графічному вікні. 

3. Наведіть курсор на стрілку маніпулятора, що вказує на напрямок виносу 

захисних ґрат (Рис. 104.32). 

4. Натисніть ліву кнопку миші, перемістите захисні ґрати й відпустите кнопку. 

5. Виберіть деталь «Вентилятор» і повторіть описані маніпуляції. 

6. Повторите такої ж дії з деталлю «Вісь». 

Рис. 14.31. Збірка з рознесеними деталями 
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7. Якщо ви задоволені отриманим результатом, натисніть  OK. Збірка з 

рознесеними деталями може мати такий вид (Рис. 104.33). 

 
Відредагуємо положення деталі «Вісь» у рознесеному виді. 

Рис. 14.32 Рознесення захисних ґрат у ручному режимі 

Рис. 14.33 Рознесення збірки в ручному режимі 
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8. Перейдіть на закладку Configuration Manager (Диспетчер конфігурацій). 

9. Розкрийте список ExplView (Рознесений вид) у дереві конфігурації 

вентилятора. 

10. Виберіть операцію рознесення, що відповідає переміщенню деталі «Вісь» (Рис. 

104.34). 

 

11. Натисніть кнопку  Exploded View (Вид з рознесеними частинами) панелі 

інструментів  Assembly (Збірка) або Insert, Exploded View (Вставка, Вид з 

рознесеними частинами) з головного меню. 

12. У Диспетчері властивостей Explode (Рознести) у групі Settings (Настроювання) 

задайте (Рис. 104.35): 

 Explode Distance (Відстань рознесення) – 15.00 мм, 

і натисніть Apply (Застосувати). 

13. Відредагуйте положення інших деталей і натисніть  ОК. 

14. Створення рознесеного виду збірки в ручному режимі завершено. 

Рис. 14.34 Вибір операції переміщення в Диспетчері конфігурацій 
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 Рис. 14.35 Редагування параметрів рознесення 



 165 
Практичне заняття №15 

 

Тема: створення креслень 

Мета роботи: набути навиків у створенні креслень з моделей та збірок 

 

Хід роботи 

Створення документа нового креслення 

Початок роботи зі зборкою починається зі створення документа нової збірки. 

1. Створіть новий документ креслення, виконавши одну з указаних дій: 

• натисніть кнопку  New (Створити) панелі інструментів Standard 

(Стандартна); 

• виберіть команду File, New (Файл, Створити); 

• натисніть Ctrl+N. 

2. 2. Виберіть значок  Drawing (Креслення) вкладки Templates (Шаблони) 

діалогового вікна New SolidWorks Document (Новий документ Solid-Works), і 

натисніть ОК (Рис. 105.1). 

 
Нове креслення може бути створене безпосередньо з документа деталі 

(збірки). В активному вікні документа деталі (збірки) натисніть кнопку  Маkе 

Drawing from Part/Assembly (Створити креслення з деталі/збірки), виберіть Make 

Рис. 15.1 Діалогове вікно створення нового 

креслення 
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Drawing from Part (Assembly) (Створити креслення з деталі (збірки)) з головного 

меню або натисніть Ctrl+D. 

3. Виберіть А4-Portrait (А4-книжкова) зі списку, що розкривається, Standard sheet 

size (Стандартний розмір основного напису) діалогового вікна Sheet Format/ 

Size (Формат/розмір основного напису) , і натисніть ОК (Рис. 105.2). 

 
4. З'явиться вікно нового креслення (Рис. 105.3). 

 

Рис. 15.2 Діалогове вікно створення нового креслення 

Рис. 15.3 Вікно нового креслення 
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Ви можете вибрати креслярський аркуш зі стандартною рамкою – Standard 

sheet size (Стандартний основний напис), зі своєю рамкою або чистий аркуш без 

основного напису – Custom sheet size (Користувальницький розмір основного напису). 

Розмір паперу, основний напис, ім'я креслення й масштаб можна змінити в 

діалоговому вікні Sheet Properties (Властивості аркуша) (Рис. 105.4). Щоб відкрити 

діалогове вікно, клацніть правою кнопкою миші по значку імені аркуша в дереві 

проекту Feature Manager (Диспетчера конструктивних елементів) і виберіть 

Properties... (Властивості...) з контекстного меню. 

 
Підготовка до роботи 

Створення основного напису 

Створення будь-якого креслення починається з основного напису. Програма 

SolidWorks пропонує шаблони основних написів, що відповідають вимогам 

стандарту креслення ISO. Тому, як приклад, ми створимо основний напис відповідно 

до вимог ДСТУ. 

1. Створіть новий документ креслення. 

Рис. 15.4 Діалогове вікно завдання параметрів аркуша й основного напису 
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2. Виберіть параметр A4-Portrait (А4-книжкова) у групі Standard sheet size 

(Стандартний розмір основного напису) діалогового вікна Sheet Format/Size 

(Формат/розмір основного напису) і натисніть ОК. 

3. Виберіть Edit, Sheet Format (Виправлення, Основний напис) з головного меню. 

Основний напис зафарбується в сині кольори й буде доступним для 

редагування. 

4. Намалюйте лінії рамки відповідно до вимог ДСТУ (Рис. 105.5). 

 Рис. 15.5 Основний напис за ДСТУ 
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Щоб змінити товщину ліній, виділіть необхідні лінії, натисніть кнопку  Line 

Thickness (Товщина лінії) панелі інструментів  Line Format (Формат лінії) і 

виберіть товщину лінії. 

 

Нанесення написів 

У рамці використаються два типи написів: постійні (наприклад, Розроб., 

Перевір., Затв. і так далі) і змінювані (Аркуш, Аркушів, Масштаб), які є 

властивостями документа. Почнемо з нанесення статичних написів. 

5. Натисніть кнопку  Note (Замітка) панелі інструментів  Annotation 

(Примітки) або виберіть Insert, Annotations, Note... (Вставка, Примітки, 

Замітка...) з головного меню. 

6. У Диспетчері властивостей Note (Замітка), у групі Text Format (Формат 

тексту), скасуєте параметр Use document's font (Використати шрифт 

документа) і натисніть кнопку Font... (Шрифт). 

7. У діалоговому вікні Choose Font (Вибрати шрифт) задайте (Рис. 105.6): 

• Font (Шрифт) – ISOCPEUR; 

• Font Style (Стиль шрифту) – Italic( Курсив); 

• Units (Одиниць) – 2.50 мм; 

• Space (Інтервал) – 0.70 мм, і натисніть OК. 

 
Рис. 15.6 Діалогове вікно завдання шрифту приміток 
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8. Розмістіть в рамці незмінні написи. Вони будуть пофарбовані в чорні кольори. 

Щоб нанести вертикальний текст, у Диспетчері властивостей Note (Замітка) 

задайте 90.00 градусів для параметра  Angle (Кут) групи Text Format (Формат 

тексту). 

Тепер відредагуємо змінювані написи. Змінювані написи відображають 

властивості документа. При редагуванні властивостей документа змінюються й 

написи. Насамперед, додамо необхідні властивості документа, а потім зв'яжемо 

напису з відповідними властивостями. 

9. Виберіть File, Properties... (Файл, Властивості...) з головного меню. 

10. З'явиться діалогове вікно Summary Information (Підсумкова інформація), що 

складається із двох вкладок: Summary (Резюме) і Custom (Користувач). 

11. У вкладці Summary Information (Підсумкова інформація) заповніть текстові 

поля, наприклад (Рис. 105.7): 

• Author (Автор) – ЛДТУ; 

• Title (Заголовок) – Гайка; ' 

• Subject (Тема) - 0123.00.001. 

 
12. Перейдіть у вкладку Custom (Користувач). 

Рис. 15.7 Діалогове вікно завдання підсумкової 

інформації про креслення 
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13. Уведіть у текстових полях стовпця Property Name (Ім'я) послідовно: Матеріал, 

Розробив, Перевірив, Затвердив. 

14. Виберіть у полях стовпця Type (Тип) значення Text (Текст) зі списку, що 

розкривається. 

15. Уведіть у текстових полях стовпця Value/Text Expression (Значення/Текстове 

вираження) послідовно: Латунь, Вернидуб, Писаренко, Гетьман (Рис. 105.8). 

 
16. Після уведення всіх властивостей документа натисніть ОК. 

17. Натисніть кнопку  Note (Замітка) панелі інструментів  Annotation 

(Примітки) або виберіть Insert, Annotations, Note... (Вставка, Примітки, 

Замітка...) з головного меню. 

18. Скасуйте параметр Use document's font (Використати шрифт документа) і 

встановите висоту шрифту в 2.50 мм. 

19. Наведіть курсор на поле правіше напису «Розробив» і клацніть лівою кнопкою 

миші. 

Рис. 15.8 Діалогове вікно завдання користувальницької 

інформації про креслення 
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20. У Диспетчері властивостей Note (Замітка) натисніть кнопку  Link to Property 

(Зв'язати із властивістю). 

21. У діалоговому вікні Link to Property (Зв'язати із властивістю) виберіть зі 

списку, що розкривається, параметр «Розробив» і натисніть ОК (Рис. 105.9). 

 
22. У графічному вікні з'явиться посилання на властивість «Розробив» (Рис. 

105.10). 

23. У діалоговому вікні Formatting (Форматування) задайте: 

• Font (Шрифт) – ISOCPEUR; 

• Font Style (Стиль шрифту) – Italic( Курсив); 
• Units (Одиниць) – 2.50 мм. 

24. Клацніть лівою кнопкою по полях, розташованих правіше написів «Перевірив.» 

і «Затв.». Посилання на властивість «Розробили» повториться ще два рази. 

Рис. 15.9 Діалогове вікно завдання зв'язку 

між заміткою й властивість документа 
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25. Натисніть клавішу Esc, щоб вийти з режиму посилання. 

26. Подвійним натисканням на ліву кнопку миші виділіть посилання, що 

знаходиться напроти напису «Перевірив». 

27. У Диспетчері властивостей Note (Замітка) натисніть кнопку  Link to Property 

(Зв'язати із властивістю). 

28. У діалоговому вікні Link to Property (Зв'язати із властивістю) виберіть зі 

списку, що розкривається, параметр «Перевірив» і натисніть ОК. 

29. Подвійним щигликом виділите посилання, що коштує напроти напису «Затв.». 

30. У Диспетчері властивостей Note (Замітка) натисніть кнопку  Link to Property 

(Зв'язати із властивістю). 

31. У діалоговому вікні Link to Property (Зв'язати із властивістю) виберіть зі 

списку, що розкривається, параметр «Затвердив» і натисніть ОК. 

При копіюванні посилань зберігається шрифт, обраний для першого посилання 

із серії. 

32. У Диспетчері властивостей Note (Замітка) натисніть  OK (Рис. 105.11). 

Рис. 9.10 Розміщення посилання на властивість у вікні документа 
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Перейдемо до написів у правій частині рамки. 

33. Установіть зв'язки із властивостями «Матеріал», Author (Автор), Subject 

(Тема). 

34. Задайте висоту шрифту 5.00 мм. 

35. Встановите зв'язок із властивістю Title (Заголовок). 

36. Задайте висоту шрифту 10.00 мм. 

37. Натисніть  ОК у Диспетчері властивостей Note (Замітка) (Рис. 105.12). 

 

Рис. 15.11 Написи, розташовані в лівій частині рамки 

Рис. 15.12 Написи, розташовані в правій частині рамки 
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Якщо після редагування зв'язків виникають здвоєні написи, натисніть кнопку 

 Redraw (Перемалювати) панелі інструментів  View (Вид), виберіть View, 

Redraw (Вид, Перемалювати) з головного меню, або натисніть Ctrl+R. 

38. Виберіть Edit, Edit Sheet (Виправлення, Редагувати аркуш) з головного меню. 

Тепер основний напис недоступний для редагування. 

Команди Edit Sheet (Редагувати аркуш) і Edit Sheet Format (Редагувати 

основний напис) доступні з контекстного меню при натисненні на праву кнопку миші 

за назвою Sheet 1 (Аркуш1) у дереві проекту FeatureManager (Диспетчера 

конструктивних елементів) або по графічному вікну. 

39. Натисніть кнопку  Zoom to Fit (Змінити в розмір екрана) панелі інструментів 

 View (Вид) або виберіть View, Modify, Zoom to Fit (Вид, Змінити, У розмір 

екрана) з головного меню. 

40. Виберіть File, Save Sheet Format... (Файл, Зберегти основний напис...) з 

головного меню. 

41. У діалоговому вікні Save Sheet Format (Зберегти основний напис) уведіть назву 

A4v_GOST.sldprt, і натисніть Save (Зберегти) (Рис. 105.13). 

 
42. Шаблон створеного основного напису доданий у директорію Solid-

Works2005/Data/. При створенні нового креслення тепер досить вибрати в 

діалоговому вікні Sheet Properties (Властивості аркуша) шаблон 

A4v_GOST.sldprt. 

Настроювання параметрів документа 

Рис. 15.13 Діалогове вікно збереження основного напису 
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У кресленні втримується безліч елементів, які можуть бути настроєні перед 

початком роботи з документом. Для настроювання виберіть Tools, Options.... 

Document Properties (Інструменти, Параметри..., Властивості документа) і настройте 

необхідні параметри оформлення (розміри, замітки, примітки, винесення, стрілки й 

так далі) (Рис. 105.14). 

 
Тому що кількість параметрів настроювання документів більше ста тридцяти, 

на початку роботи досить вибрати Dimensioning standard (Креслярський стандарт) – 

ISO або GOST. У цьому випадку будуть використовуватися настроювання інших 

параметрів, прийнятих для даного стандарту за замовчуванням. Надалі ви можете 

змінювати ті або інші параметри за своїм розсудом. 

Креслення в трьох проекціях 

Рис. 15.14 Діалогове вікно настроювання параметрів документа 
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Намалюємо креслення гайки, модель якої була створена в лабораторній роботі 

№3, у трьох стандартних проекціях. 

Для роботи нам знадобляться такі панелі інструментів: 

 Annotation (Примітка); 

 Dimensions/Relations (Розміри/Взаємозв'язку); 

 Drawing (Креслення). 

У процесі роботи ми навчимося використати: 

– інструмент  Model Items (Елементи моделі); 

– інструмент  Model View (Вид моделі); 

– інструмент  Standard 3 View (Три стандартних види). 

Спочатку ми розмістимо на креслярському аркуші три стандартних проекції, 

потім вид деталі в ізометрії й, у завершення, нанесемо необхідні розміри. 

1. Натисніть кнопку  New (Створити) панелі інструментів Standard 

(Стандартна), або виберіть File, New (Файл, Створити) з головного меню, або 

натисніть Ctrl+N. 

2. У діалоговому вікні New SolidWorks Document (Новий документ Solid-Works) 

виберіть значок  Drawing (Креслення) і натисніть ОК. 

3. У діалоговому вікні Sheet Format/Size (Розмір / формат основного напису) 

натисніть Browse... (Огляд...), виберіть A4v_GOST.sldprt зі списку, що 

розкривається, і натисніть ОК. 

4. Виберіть File, Properties... (Файл, Властивості...) з головного меню. 

5. Заповніть такі текстові поля: 

• Author (Автор) - ЛДТУ; 

• Title (Заголовок) - Гайка; 

• Subject (Тема) - 012.00.001, і натисніть ОК. 

Настроювання вкладки Custom (Користувач) діалогового вікна Summary 

Information (Підсумкова інформація) зберігаються в шаблоні креслярського аркуша. 

Настроювання вкладки Summary (Резюме) вносяться заново для кожного нового 

документа. 
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6. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

(Стандартна), або виберіть File, Save (Файл, Зберегти) з головного меню, або 

натисніть Ctrl+S. 

7. У діалоговому вікні Save As (Зберегти як) задайте: 

• Save in: (Зберегти в:) - укажіть місце зберігання файлу; 

• File name: (Ім'я файлу:) - Гайка; 

• Save as type: (Зберегти у вигляді:) - Drawing (*.drw, *.slddrw); 

• Description: (Опис:) - уведіть короткий опис креслення, і натисніть Save 

(Зберегти). 

8. Новий документ креслення створений і збережений під ім'ям Гайка.slddrw. 

Створення трьох стандартних видів 

Тепер ми можемо розмістити на креслярському аркуші три стандартних види. 

Для цього виконаємо такі дії. 

9. Натисніть кнопку  Standard 3 View (Три стандартних види) панелі 

інструментів  Drawing (Креслення) або виберіть Insert, Drawing View, 

Standard 3 View (Вставка, Креслярське вид, Три стандартних види) з головного 

меню. Форма курсору набуде вигляду . 

Панель інструментів  Drawing (Креслення) надає інструменти для 

вирівнювання розмірів і створення креслярських видів. 

У програмі SolidWorks передбачене створення трьох стандартних видів двох 

типів: First angle (По першому куті) і Third angle (По третьому куті). Параметр 

First angle (По першому куті) означає розміщення виду попереду у верхньому лівому 

куті, під ним – вид зверху, і праворуч від нього – вид ліворуч. Параметр Third angle 

(По третьому куті) означає розміщення виду зверху в нижньому лівому куті, над ним 

– вид попереду й, праворуч від нього – вид праворуч. Вибір подання трьох 

стандартних видів (по першому або по третьому куті) можна зробити в 

діалоговому вікні Sheet Setup (Параметри аркуша), у групі Type of projection (Тип 

проекції). Для виклику діалогового вікна клацніть правою кнопкою миші в поле 

креслярського аркуша або дерева проекту й виберіть Properties... (Властивості...) з 

контекстного меню. Вибір типу проекції повинен передувати створенню трьох 

стандартних видів. 
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10. У диспетчері властивостей Standard 3 View (Три стандартних види) натисніть 

Browse... (Огляд...). 

11. У діалоговому вікні Open (Відкрити) укажіть файл «Гайка.sldprt» і натисніть 

Open (Відкрити) (Рис. 105.15). 

 

12. У графічній області з'являться три стандартних проекції гайки (Рис. 105.16). 

Зверніть увагу на те, що масштаб гайки вибирається автоматично, з метою 

розміщення в розмір креслярського аркуша, і не враховує розташування замки. 

Скорегуємо місце розташування проекцій з розміром рамки. 

13. Наведіть курсор на правий верхній вид деталі. Форма курсору зміниться з  

на . 

14. Натисніть ліву кнопку миші й перетягніть проекцію вправо. 

15. Наведіть курсор на верхній лівий вид деталі й перетягніть його вправо. 

16. Наведіть курсор на нижній лівий вид деталі й перетягніть її вправо. 

17. Виберіть у дереві проекту Sheet l (Аркуш 1). 

Рис. 15.15 Вибір деталі для вставки в креслення 
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18. Виберіть Edit, Properties... (Виправлення, Властивості...) з головного меню. 

Переміщення видів можна здійснювати за допомогою клавіш навігації 

клавіатури. Для цього виберіть необхідний вид у дереві проекту FeatureManager 

(Диспетчера конструктивних елементів) і клавішами нагору/униз/уліво/вправо 

перемістите вид у необхідне місце. 

19. У діалоговому вікні Sheet Properties (Властивості аркуша) задайте Scale: 

(Масштаб) як 8:1, і натисніть ОК. 

20. Тепер три стандартних види розміщені оптимально (Рис. 105.17). 

 

Додавання виду моделі 

21. Натисніть кнопку  Model View (Вид моделі) панелі інструментів  Drawing 

(Креслення) або виберіть Insert, Drawing View, Model... (Вставка, 

Креслярський вид, Модель...) з головного меню. 

Рис. 15.16 Три стандартних види 
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22. У Диспетчері властивостей Model View (Вид моделі) задайте (Рис. 105.18): 

• У групі Part/Assembly to Insert (Вставити деталь/зборку) – «Гайка», і 

натисніть кнопку  Next (Далі). 

 

Рис. 15.17 Оптимальне розміщення трьох стандартних видів 

Рис. 15.18 Вибір об'єкта для виду моделі 
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23. Форма курсору  зміниться на . 

24. У Диспетчері властивостей Model View (Вид моделі) задайте (Рис. 105.19): 

• У групі Orientation (Орієнтація) – Isometric (Ізометрія); 

• У групі Display Style (Відображення) – Hidden Lines Removed (Сховати 

невидимі лінії); 

• У групі Scale (Масштаб) – включіть Use sheet scale (Використати масштаб 

аркуша), і натисніть  OK. 

 

25. Наведіть курсор на порожнє місце в правому нижньому куті креслярського 

аркуша й клацніть лівою кнопкою миші. 

26. Вид моделі з'явиться на креслярському аркуші (Рис. 105.20). 

Масштаб кожного виду можна задавати окремо. Виберіть відповідний вид, у 

Диспетчері властивостей Drawing View (Креслярський вид), у групі Scale (Масштаб), 

параметр Use custom scale (Використати масштаб користувача) і задайте 

необхідний масштабний коефіцієнт. 

Рис. 15.19 Завдання форми подання виду моделі 



 183 

 

Нанесення на креслення розмірів 

У програмі SolidWorks передбачено два типи розмірів: основні й довідкові. 

Основними вважаються розміри, задані під час створення моделі деталі. Довідкові 

розміри наносяться безпосередньо на креслення. Якщо модель деталі під час 

створення була повністю визначена, нанесення розмірів на кресленні не представляє 

ніякої праці. 

27. Натисніть кнопку  Model Items (Елементи моделі) панелі інструментів  

Annotation (Примітка) або виберіть Insert, Model Items... (Вставка, Елементи 

моделі...) з головного меню. 

Панель інструментів  Annotation (Примітка) надає інструменти для 

додавання заміток і позначень у документи деталей, зборок або креслень. Панель 

включає двадцять два інструменти. 

Рис. 15.20 Вид моделі на креслярському аркуші 
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28. У Диспетчері властивостей Model Items (Елементи моделі), у групі Dimensions 

(Розміри) виберіть параметр Select all (Вибрати все) і натисніть  OK (Рис. 

105.21). 

 

29. У модальному вікні потрібно змінити параметр «Import From» (Імпортувати з) 

на параметр «entire model» (вся модель). Натисніть Yes (Так). 

30. Розміри, використовувані в процесі створення моделі, нанесені на креслення. 

Відредагуйте місце розташування розмірів (Рис. 105.22). 

Розмір можна перенести з одного креслярського виду на іншій. Для цього 

видаліть розмір, виберіть необхідний креслярський вид, і повторите процедуру 

нанесення розмірів. 

Рис. 15.21 Вибір типів розмірів, які наносяться на креслення 
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Нанесення довідкових розмірів 

Нанесемо кілька довідкових розмірів. 

31. Натисніть кнопку  Horizontal Dimension (Горизонтальний розмір) панелі 

інструментів  Dimensions/Relations (Розміри/Взаємозв'язку) або виберіть 

Tools, Dimensions, Horizontal (Інструменти, Розміри, Горизонтальний) з 

головного меню. 

32. Нанесіть габаритні розміри гайки на виді спереду й ліворуч. 

33. Виберіть розмір позначення різьблення М4. 

34. У Диспетчері властивостей Dimension (Розмір), у групі Dimension Text (Текст 

розміру) заміните текст <MOD-DIAM><DIM> на «М4 х 0.7» і натисніть  

ОК. 

35. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

(Стандартна), або виберіть File, Save (Файл, Зберегти) з головного меню, або 

натисніть Ctrl+S. 

Рис. 15.22 Креслення гайки з основними розмірами 
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36. Креслення гайки закінчене й має такий вид (Рис. 105.23). 

 
Довільні проекції 

Рис. 15.23 Креслення гайки з основними й допоміжними розмірами 
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Крім трьох основних проекцій може з'явитися необхідність використання інших 

проекцій (наприклад, вид знизу, позаду, паралельно якої-небудь площини, і так далі). 

Розглянемо деякі з довільних проекцій на прикладі деталі «Корпус вентилятора». 

Для роботи нам знадобляться такі панелі інструментів: 

 Drawing (Креслення). 

У процесі роботи ми навчимося використати: 

– інструмент  Auxiliary View (Допоміжний вид); 

– інструмент  Predefined View (Попередньо визначений вид); 

– інструмент  Projected View (Проекційний вид). 

Спочатку ми розмістимо на креслярському аркуші вид моделі, а потім 

виконаємо кілька різних проекцій. 

1. Натисніть кнопку  New (Створити) панелі інструментів Standard 

(Стандартна), або виберіть File, New (Файл, Створити) з головного меню, або 

натисніть Ctrl+N. 

2. У діалоговому вікні New SoIidWorks Document (Новий документ Solid-Works) 

виберіть значок  Drawing (Креслення) і натисніть ОК. 

3. У діалоговому вікні Sheet Format / Size (Розмір / формат основного напису) 

натисніть Browse... (Огляд...), виберіть A4v_GOST.sldprt зі списку, що 

розкривається, і натисніть ОК. 

4. Виберіть File, Properties... (Файл, Властивості...) з головного меню. 

5. Заповніть такі текстові поля: 

• Author (Автор) – ЛДТУ; 

• Title (Заголовок) – Корпус; 

• Subject (Тема) - 0123.00.002; 

• Матеріал – Латунь. 

Якщо напису вийшли за межі рамки, клацніть правою кнопкою миші по 

креслярському аркуші й виберіть Edit Sheet Format (Редагувати основний напис) з 

контекстного меню. Після коректування написів рамки, виберіть із контекстного 

меню Edit Sheet (Редагувати аркуш). 
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6. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

(Стандартна), або виберіть File, Save (Файл, Зберегти) з головного меню, або 

натисніть Ctrl+S. 

7. У діалоговому вікні Save As (Зберегти як) задайте: 

• Save in: (Зберегти в:) – укажіть місце зберігання файлу; 

• File name: (Ім'я файлу:) – Корпус вентилятора; 

• Save as type: (Зберегти у вигляді:) – Drawing (*.drw, *.slddrw); 

• Description: (Опис:) – уведіть короткий опис креслення, і натисніть Save 

(Зберегти). 

8. Новий документ креслення створений і збережений під ім'ям Корпус 

вентилятора.slddrw. 

9. Натисніть кнопку  Model View (Вид моделі) панелі інструментів  Drawing 

(Креслення) або виберіть Insert, Drawing View, Model... (Вставка, 

Креслярський вид, Модель...) з головного меню. Форма курсору набуде вигляду 

 
10. У Диспетчері властивостей Model View (Вид моделі) у групі Part/Assembly to 

Insert (Вставити деталь/зборку) натисніть Browse... (Огляд...). 

11. У діалоговому вікні Open (Відкрити) виберіть файл «Корпус 

вентилятоpa.sldprt» і натисніть Open (Відкрити). Ви автоматично повернетеся 

у вікно креслення. Форма курсору набуде вигляду . 

12. У Диспетчері властивостей Model View (Вид моделі) задайте: 

• У групі Orientation (Орієнтація) – Front (Вид попереду); 

• У групі Display Style (Відображення) – Hidden Lines Removed (Сховати 

невидимі лінії); 

• У групі Scale (Масштаб) – включіть Use custom scale (Використати масштаб 

користувача) і встановите масштаб 1:1, і натисніть  ОК. 

13. Помістіть вид у лівому верхньому куті й клацніть лівою кнопкою миші (Рис. 

105.24). 
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Створення проекційного виду 

14. Натисніть кнопку  Projected View (Проекційний вид) панелі інструментів  

Drawing (Креслення) або виберіть Insert, Drawing View, Projected (Вставка, 

Креслярський вид, Проекція) з головного меню. Форма курсору набуде вигляду 

. 

15. Виберіть вид моделі й помістите проекційний вид правіше існуючого виду (Рис. 

105.25). 

16. У Диспетчері властивостей Projected View (Проекційний вид) виберіть 

параметр Arrow (Стрілка), уведіть у текстовому вікні літеру А та натисніть  

ОК. 

Рис. 15.24 Вид моделі корпуса вентилятора 
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Створення допоміжного виду 

17. Натисніть кнопку  Auxiliary View (Допоміжний вид) панелі інструментів  

Drawing (Креслення) або виберіть Insert, Drawing View, Auxiliary (Вставка, 

Креслярський вид, Допоміжний) з головного меню. Форма курсору набуде 

вигляду . 

18. Виберіть пряму лінію хрестовини. Допоміжний вид буде розташований 

паралельно обраної лінії. 

19. У Диспетчері властивостей Auxiliary View (Допоміжний вид) виберіть 

параметр Arrow (Стрілка), уведіть у текстовому вікні літеру Б (Рис. 105.26) і 

натисніть  OK. 

20. Креслярський аркуш містить вид моделі, проекційний вид і допоміжний вид 

(Рис. 105.27). 

Рис. 15.25. Додавання в креслення проекційного виду 
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Рис. 15.26 Додавання в креслення допоміжного виду 

Рис. 15.27 Вид моделі, проекційний і 

допоміжний види на креслярському аркуші 
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Створення попередньо визначеного виду 

Попередньо певний вид створимо на другому креслярському аркуші. Для цього 

виконаємо наступні дії. 

21. Виберіть Insert, Sheet... (Вставка, Аркуш...) з головного меню, або наведіть 

курсор на назву вкладки Sheet 1, клацніть правою кнопкою миші й виберіть 

Add Sheet (Додати аркуш) з контекстного меню. 

22. У діалоговому вікні Sheet Properties (Властивості аркуша) натисніть кнопку 

ОК. 

Параметри аркуша, що додається, приймають параметри першого аркуша за 

замовчуванням. 

23. Натисніть кнопку  Predefined View (Попередньо визначений вид) панелі 

інструментів  Drawing (Креслення) або виберіть Insert, Drawing View, 

Predefined (Вставка, Креслярський вид, Попередньо певний) з головного меню. 

Форма курсору набуде вигляду . 

24. Помістіть вид посередині креслярського аркуша. 

25. У Диспетчері властивостей Drawing View (Креслярський вид) задайте (Рис. 

105.28): 

• У групі Orientation (Орієнтація) – Isometric (Ізометрія); 

• У групі Insert Model (Вставити модель) – Корпус вентилятора.sldprt; 

• У групі Display Style (Відображення) - Hidden Lines Removed 

(Сховати невидимі лінії); 

• У групі Scale (Масштаб) - включіть Use sheet scale (Використати масштаб 

аркуша) і встановіть масштаб 1:1, 

і натисніть  OK. 

26. Попередньо визначений вид вставлений (Рис. 105.29).  

27. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

(Стандартна), виберіть File, Save (Файл, Зберегти) або натисніть Ctrl+S. 



 193 

 

 

Рис. 15.28 Завдання параметрів попередньо визначеного виду 

Рис. 15.29 Креслярський аркуш із 

попередньо визначеним видом 
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Розрізи 

У програмі SolidWorks 2005 передбачені інструменти для створення різних 

типів розрізів. Розглянемо деякі з можливостей програми на прикладі корпуса 

вентилятора, створеного в попередньому розділі. 

Для роботи нам знадобляться такі панелі інструментів: 

 Annotation (Примітка); 

 Drawing (Креслення). 

У процесі роботи ми навчимося використовувати такі інструменти: 

 Area Hatch/Fill (Штрихування/заповнення); 

 Broken-out Section (Вийнятий розріз); 

 Detail View (Місцевий вид); 

 Section View (Розріз). 

Спочатку ми виконаємо довільний розріз корпуса вентилятора, потім вийнятий 

виріз, покажемо частину вирізу в збільшеному масштабі й, на закінчення, 

відредагуємо штрихування розрізу. 

1. Виберіть корпус вентилятора, розташований на другому аркуші креслення. 

2. У Диспетчері властивостей Drawing View (Креслярський вид), у групі 

Orientation (Орієнтація), виберіть Front (Вид попереду) і натисніть  ОК. 

3. Перемістіть вид ближче до лівого краю рамки. 

Виконання розрізу 

4. Натисніть кнопку  Section View (Розріз) панелі інструментів  Drawing 

(Креслення) або виберіть Insert, Drawing View, Section (Вставка, Креслярський 

вид, Розріз) з головного меню. Курсор набуде вигляду . 

5. Проведіть довільну лінію розрізу, що перетинає корпус вентилятора. 

6. У Диспетчері властивостей Section View (Розріз), у групі Section line (Лінія 

розрізу) уведіть у текстовому полі мітку В, і натисніть  ОК (Рис. 105.30). 



 195 

 
Створення вийнятого вирізу 

7. Натисніть кнопку  Broken-out Section (Вийнятий розріз) панелі інструментів 

 Drawing (Креслення) або виберіть Insert, Drawing View, Broken-out Section 

(Вставка, Креслярський вид, Вийнятий розріз) з головного меню. Курсор 

набуде вигляду  

8. Обведіть замкнутою лінією сплайна правий верхній кут корпуса вентилятора. 

9. У Диспетчері властивостей Broken-out Section (Вийнятий розріз) виберіть 

параметр Preview (Попередній перегляд), задайте (Рис. 105.31):  Depth 

(Глибина) - 10.00 мм, і натисніть  ОК. 

Вийнятий виріз можна зробити або на задану відстань, або вказавши крайку, 

до якої буде зроблений виріз. 

Рис. 15.30 Розріз по довільній лінії 
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Створення місцевого виду 

10. Натисніть кнопку  Detail View (Місцевий вид) панелі інструментів  Drawing 

(Креслення) або виберіть Insert, Drawing View, Detail (Вставка, Креслярський вид, 

Місцевий) з головного меню. Курсор набуде вигляду . 

11. Наведіть курсор на вийнятий виріз і задайте окружністю охват місцевого виду. 

12. Винесіть місцевий вид у правий верхній кут креслення. 

13. У Диспетчері властивостей Detail View (Місцевий вид) задайте (Рис. 105.32): 

• У групі Detail Circle (Параметри окружності) – уведіть у текстовому полі 

мітку Д; 

• У групі Display Style (Відображення) – Hidden Lines Removed (Сховати 

невидимі лінії); 

• У групі Scale (Масштаб) – Use custom scale (Використати масштаб 

користувача) виберіть зі списку 2:1, і натисніть  ОК. 

Рис. 15.31 Завдання параметрів вийнятого вирізу 
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Редагування штрихування 

14. Виділіть штрихування на місцевому виді. 

15. Натисніть кнопку Area Hatch/Fill (Штрихування/Заповнити) панелі 

інструментів  Annotation (Примітка) або виберіть Insert, Area Hatch/Fill 

(Вставка, Штрихування/заповнення) з головного меню. 

16. У Диспетчері властивостей Broken-out Section (Вийнятий розріз) у групі 

Properties (Властивості) відключите параметр Material crosspatch 

(Штрихування матеріалу), задайте (Рис. 105.33): 

• Pattern (Зразок) – ISO (Бронза Латунь) зі списку, що розкривається; 

 Hatch Pattern Scale (Масштаб штрихування) – 2.00; 

 Hatch Pattern Angle (Кут штрихування) – 0.00 градусів, 

і натисніть  ОК.  

17. Результат проробленої роботи показаний на Рис. 105.34. 

Рис. 15.32 Задання параметрів місцевого виду 
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Рис. 15.33 Завдання параметрів штрихування 

Рис. 15.34 Приклади виконання розрізу, 

вийнятого вирізу й місцевого виду 



 199 
18. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

(Стандартна), виберіть File, Save (Файл, Зберегти), або натисніть Ctrl+S, щоб 

зберегти результати роботи. 

8.6. Креслення збірок 

Крім креслень окремих деталей, програма SolidWorks 2005 дозволяє 

створювати складальні креслення. Як приклад виконаємо складальне креслення 

вентилятора з рознесеними деталями, модель якого була створена в Главі 6. 

Для роботи нам знадобляться такі панелі інструментів: 

 Annotation (Примітка); 

 Drawing (Креслення). 

У процесі роботи ми навчимося використати: 

: Інструмент  Balloon (Позиція). 

У процесі роботи створимо новий документ, відобразимо на ньому складальне 

креслення, а потім відзначимо позиції складових його елементів. 

1. Натисніть кнопку  Open (Відкрити) панелі інструментів Standard 

(Стандартна), або виберіть File, Open (Файл, Відкрити) з головного меню, або 

натисніть Ctrl+O. 

2. У діалоговому вікні Open (Відкрити) виберіть файл «Вентилятор.sldasm» і 

натисніть Open (Відкрити). 

3. Представте зборку вентилятора в рознесеному виді. 

4. Натисніть кнопку  Make Drawing from Part/Assembly (Створити креслення 

з деталі/збірки), виберіть Make Drawing from Assembly (Створити креслення 

зі збірки) з головного меню або натисніть Ctrl+D. 

5. У діалоговому вікні New SolidWorks Document (Новий документ Solid-Works) 

натисніть ОК. 

6. У діалоговому вікні Sheet Format / Size (Розмір / формат основного напису) 

натисніть Browse... (Огляд...), виберіть A4v_GOST.sldprt зі списку, що 

розкривається, і натисніть ОК (Рис. 105.35). 
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7. У Диспетчері властивостей Model View (Вид моделі) задайте: 

• У групі Orientation (Орієнтація) – Isometric (Ізометрія); 

• У групі Display Style (Відображення) – Hidden Lanes Removed (Сховати 

невидимі лінії); 

• У групі Scale (Масштаб) – включите Use custom scale (Використати масштаб 

користувача) і встановіть масштаб 1:1, 

і натисніть  ОК. 

8. Помістіть вид по центру креслярського аркуша. 

9. Виберіть File, Properties... (Файл, Властивості...) з головного меню. 

10. Заповніть такі текстові поля: 

• Author (Автор) – ЛДТУ; 

• Title (Заголовок) – Вентилятор; 

• Subject (Тема) - 0123.00.000 СБ; 

• Матеріал - Пластик АБС. 

11. У графічному вікні з'явиться складальне креслення вентилятора з рознесеними 

деталями (Рис. 105.36). 

12. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

(Стандартна), або виберіть File, Save (Файл, Зберегти) з головного меню, або 

натисніть Ctrl+S. 

13. У діалоговому вікні Save As (Зберегти як) задайте: 

• Save in: (Зберегти в:) – укажіть місце зберігання файлу; 

Рис. 15.35 Вибір основного напису 
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• File name: (Ім'я файла:) – Вентилятор; 

• Save as type: (Зберегти у вигляді:) – Drawing (*.drw, *.slddrw); 

• Description: (Опис:) – уведіть короткий опис креслення, і натисніть Save 

(Зберегти).  

 

14. Новий документ креслення збірки створений і збережений під ім'ям 

Вентилятор.sIddrw. 

 

Розміщення на кресленні позицій 

Розмістимо на креслярському аркуші кілька позицій. 

15. Натисніть кнопку  Balloon (Позиція) панелі інструментів  Annotation 

(Примітка) або виберіть Insert, Annotation, Balloon... (Вставка, Примітка, 

Позиція...) з головного меню. 

16. У Диспетчері властивостей Balloon (Позиція), у групі Balloon Settings 

(Параметри позиції) задайте: 

• Style (Стиль) – None (Немає); 

Рис. 15.36 Завдання параметрів креслення збірки з рознесеними деталями 
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• Balloon Text (Текст позиції) – Custom (Користувальницький). 

17. Уведіть у текстовому полі під написом Custom (Користувальницький) текст 

«Захисні ґрати» і вкажіть курсором миші захисні ґрати на креслярському 

аркуші. 

18. Повторіть ці дії для позицій «Вертушка», «Вісь» і «Корпус» (Рис. 105.37). 

 

19. Після нанесення всіх позицій натисніть  ОК. 

20. Відредагуйте місце розташування позицій. Складальне креслення набуде 

вигляду, як показано на Рис. 105.38. 

21. Натисніть кнопку  Save (Зберегти) панелі інструментів Standard 

(Стандартна), виберіть File, Save (Файл, Зберегти), або натисніть Ctrl+S, щоб 

зберегти результати роботи. 

Рис. 15.37 Позиції розміщені на кресленні 
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Рис. 15.38 Складальне креслення з рознесеними деталями 
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